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Operation and Programming
You are reading DX8000 Series digital video recorder (DVR) documentation. The information in this documentation describes how to configure 
and use the DX8000 system in your security application. 

For a brief description of the DX8000 server and client applications, refer to Welcome to the DX8000 Series DVR on page 13.

WELCOME TO THE DX8000 SERIES DVR
Welcome to the DX8000 Series digital video recorder. The DX8000 Series digital video recorder is a high-performance, PC-based digital video 
recorder. It is an easy-to-operate digital video recorder (DVR) client application system. The DX8000 features multi-event recording, supporting 
continuous, motion detection, alarm, ATM/POS, and scheduled recording simultaneously. Models range from an eight-channel, single 80 GB hard 
disk drive (HDD) unit to a sixteen-channel unit with up to 1 TB of storage.

DX8000 software runs on two platforms:

• The DX8000 DVR server software runs on the DX8000 Series DVR. 

• The DX8000 Client Application software runs on a personal computer (PC) and allows you to log in to and operate the DX8000 DVR server 
system from your local PC. 

Fully implemented networking capabilities allow remote administration, playback, and export using the accompanying client application. Live 
viewing is supported on a variety of client platforms, including Internet browsers and pocket PC-compatible hand-held devices. Versatile high-
speed search operations include time and date, event list, thumbnail, and intelligent pixel searching. Extensive scheduling features allow 
customizing of weekday, weekend, and special event recording.

The DX8000 provides a graphical user interface (GUI), allowing you quick and efficient access to all setup and operations functions. Scheduled or 
manual backup can be performed using a number of optical, external, and mapped network drive options.

An online Help system allows you quick access to information about how to configure and operate the DX8000 server and DX8000 client 
application. 

The DX8000 also supports the following PC-based applications:

• DX8000 Client Emergency Agent on page 13

• DX8000 Viewer on page 13

• DX8000 Mobile Client on page 13

• DX8000 Web Client on page 13

DX8000 CLIENT EMERGENCY AGENT
The DX8000 Client Emergency Agent works with networked DX8000 Series digital video recorders to alert users when one or more particular 
channels detect a motion and/or alarm event. The Emergency Agent runs on a networked client PC. 

DX8000 VIEWER
The DX8000 Viewer is capable of playing back a variety of video, still image, and audio media formats. It is designed to recognize and verify the 
digital watermark that is embedded in DX8000 Series digital video recorder native video. Watermarking is used to authenticate the originality of 
a video file and to alert users of possible image tampering. The viewer application runs automatically each time a CD or DVD created by the 
DX8000’s export feature is inserted into a Windows-based PC. The software can also be installed on a PC and opened independently when 
necessary.

DX8000 MOBILE CLIENT
The DX8000 Mobile Client allow you to view live video remotely from multiple cameras and sites. Networking capabilities include local 
connection using wire-bound or wireless LAN technologies or remote connection using the Internet. The DX8000 Mobile Client software runs on 
a standard pocket PC-based Personal Digital Assistant (PDA) and can display a single channel of real-time video from any camera attached to any 
DX8000 DVR on the network. Features include hierarchical organization of multiple sites, built-in security through password protection, and an 
adjustable viewing area, including full-screen view.

DX8000 WEB CLIENT
The DX8000 Web Client allows you to view live video and operate pan, tilt, and zoom (PTZ) features of cameras attached to DX8000 DVRs. Using 
a standard web browser, you can remotely monitor up to 16 cameras from up to five DX8000 DVR servers simultaneously. Each DX8000 DVR can 
support up to 100 web clients either internally within an organization or externally through the Internet.
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Getting Started with DX8000 DVR Software
This section provides information to help you get started with using the DX8000 DVR server software. You must install your DX8000 Series DVR 
before using this guide. In order for your system to operate properly, you must also perform the following tasks:

• Read the Important Security Information for System Administrators manual and configure the DX8000 to ensure maximum DX8000 server 
operation security. 

• Change the default language (if other than English). For more information, refer to Selecting the Language on page 187.

• Set the system clock. For more information, refer to Setting the System Time on page 187.

• Identify network parameters. For more information, refer to Setting Up Network Properties on page 143.

• Add a printer (if you want to print still video images). For more information, refer to Printing Images on page 101.

If the above steps have not been done, refer to the installation manual supplied with the unit for instructions on installing and configuring your 
DX8000. 

NOTE: System administrators are recommended to read the Important Security Information for System Administrators manual and configure the 
DX8000 to ensure maximum DX8000 server operation security. 

This section includes the following topics:

• Upgrade Policy on page 14

• Starting and Shutting Down the DX8000 on page 15 

UPGRADE POLICY
Pelco’s representations regarding product features and performance are limited to those made in the specification sheet and installation/
operation manual in effect at the time the product was manufactured. Pelco does not represent or warrant that any upgrades to product 
hardware or software will be made available in the future. When possible, Pelco will offer product upgrades to purchasers of its products. 

The upgrade policy is described in the following sections:

• Software Upgrades on page 14

• Hardware Upgrades on page 14

SOFTWARE UPGRADES
1. All upgrades for Pelco software shall be free to the customer for the duration of the warranty period. This offer does not apply to software 

that may be installed in a Pelco product that is licensed from another supplier. All other software, such as operating systems, drivers for 
accessory devices, and so forth, shall be governed by the software manufacturer’s upgrade policy, even when said upgrades are necessary 
to implement an upgraded version of Pelco software.

2. Whenever possible, software upgrades with detailed instructions shall be provided to the customer via Web site download. Pelco will not 
be responsible for loss of data, losses due to down time, or damage to product as a result of a customer attempting to perform an upgrade.

3. Hard copies on appropriate medium (CD/ZIP/floppy) shall be sent to the customer at no charge upon request.

4. It shall be the customer’s responsibility to procure necessary hardware to perform upgrades if required (necessary drives, such as CD-ROM 
or ZIP).

5. Pelco cannot guarantee that all future software versions will be backward compatible with earlier hardware platforms.

HARDWARE UPGRADES
Pelco does not provide hardware upgrades other than for hard disk storage. Hard disk upgrades are available as follows:

1. Not all products are capable of being upgraded for additional hard drive space. For information on whether a particular model can be 
upgraded, consult the relevant installation/operation manual or technical support department at Pelco.

2. If a hard disk upgrade is possible, it is available through Pelco at established prices and is subject to the usual 24-hour turnaround for service.

When a larger hard drive is being substituted for a smaller one, the smaller drive will be returned to the customer along with the upgraded unit.

While Pelco will perform all upgrades with the utmost consideration and care, Pelco cannot guarantee that any of the data and/or video stored 
on the existing hard drives will not be lost or damaged. Pelco also is not responsible for damage or loss of data.
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STARTING AND SHUTTING DOWN THE DX8000
This section describes how to start and shut down the DX8000 and includes the following topics:

• Starting the DX8000 on page 15

• Shutting Down the DX8000 on page 15

For information on logging in to the DX8000, refer to Logging In to the DX8000 Application on page 16.

STARTING THE DX8000

To start the DX8000: 

1. Once the system is installed, open the front panel of the DVR and press the power switch.

Figure 1.  Front Panel and Power Switch

2. Wait while the unit starts (this may take several minutes). 

SHUTTING DOWN THE DX8000

You must have Power User or Administrator access to shut down. For information on users’ security levels, refer to Definition of User Access 
Levels on page 173. You must also have a Windows password to shut down. For information on the Windows default password, refer to the 
Important Security Information for System Administrators guide.

To shut down:

1. From the DX8000 menu bar, choose File > Exit. The Shut Down dialog box opens.

2. Select Shut down.

3. Click OK.

DX8000 DOCUMENTATION
You can print selected technical documentation free, directly from the Internet. 

To access technical documentation:

1. Go to http://www.pelco.com/products/. The Pelco Products Web page is displayed.

2. Scroll to the Control Site Equipment section and click Video Recorders. The Control Site Equipment - Digital Video Recorders Web page is 
displayed.

3. Scroll to the DX8000 and locate the specific document you want to view or print. Use Adobe® Acrobat Reader® to open the document, 
search for the sections you need, and print them on most standard printers. (Go to www.adobe.com to download a free copy of Acrobat 
Reader.)

POWER HDD

USB

�
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Logging In to the DX8000 Application
To access the features of the DX8000 Series DVR, you must log in with a valid user name and password. The DX8000 comes equipped with a 
built-in user account named “Guest.” Each time the unit is turned on, the Guest account is automatically activated. In addition to the Guest 
account, there are four other user access levels, or groups, that can be configured on the DX8000. The Guest user is granted only limited access 
to the system. The other four access levels range from the Administrator group, with the most rights and privileges, to the Restricted group, with 
the least rights and privileges. 

To operate and configure all but the most basic features of the DX8000, you must be assigned a user account other than Guest. If you have not 
been assigned a user account, contact your system administrator before proceeding.

For information on the rights and permissions of the user groups, refer to Definition of User Access Levels on page 173. 

NOTE: The Guest user account does not have access to the setup features of the DX8000. Only users with Administrator and Power User 
accounts are allowed access to setup functions.

This section includes the following topics:

• Local DX8000 Login on page 16

• Remote DX8000 Login on page 17

LOCAL DX8000 LOGIN
If you are logging into the DX8000 for the first time, the login procedure is different from the method described below. For information on first- 
time login instructions, refer to the DX8000 Installation manual. 

This section includes the following topics:

• Logging in to a Local DX8000 on page 16 

• Logging Out of the Local DX8000 on page 16 

• Exiting to the Windows Operating System on page 17

LOGGING IN TO A LOCAL DX8000

You must have a valid user name and password to log in to the DX8000. The user name and password are case sensitive.

To log in with a user name other than Guest: 

1. From the DX8000 main menu, go to File > User Log-in. The User Log-in dialog box opens.

2. Enter a valid user name in the User Name field and a valid password in the Password field.

3. Click OK.

LOGGING OUT OF THE LOCAL DX8000

Logging out of the local or a remote DVR does not disconnect you from that system. Logging out will return you to the Guest account. 
To disconnect from a remote server, refer to Disconnecting from a Remote Site on page 17  

To log the current user out of the system and return to the Guest account: 

Click File > User Log-out.

You can also log out of a local or remote DVR by right-clicking its site name from the Site tree and then selecting User Log-Out from the 
quick-menu.
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EXITING TO THE WINDOWS OPERATING SYSTEM

You must have Administrator user access to exit to Windows. Refer to Definition of User Access Levels on page 173 for information on users’ 
security levels. You must have a Windows password to exit to the Windows operating system. For information on the Windows default 
password, refer to the Important Security Information for System Administrators guide.

To exit the DX8000 application and log into the Windows operating system:

1. From the DX8000 menu bar, choose File > Exit. The Shut down dialog box opens.

2. Click Exit to Windows. The Shut down dialog box opens.

3. Click OK.

The Log On to Windows dialog box opens.

4. Enter the Windows password and then click OK. The system logs you into the Windows operating system.

REMOTE DX8000 LOGIN
You can view live and playback video from up to five DX8000 Series DVRs simultaneously. To access the features of a remote DX8000, a link must 
be established between the local and remote DVRs. Refer to Adding a Remote Site on page 177 for instructions on establishing a network 
connection with a remote DVR. After establishing an active connection, refer to Logging in to a Remote Site on page 17 for login instructions.

This section includes the following topics:

• Connecting to a Remote Site on page 17 

• Disconnecting from a Remote Site on page 17 

• Logging in to a Remote Site on page 17 

• Logging Out of a Remote Site on page 18 

CONNECTING TO A REMOTE SITE

To connect to an active DX8000 server on the network:

1. In the DX8000 main window, right-click the remote site name from the Site tree. The shortcut menu is displayed.

2. Select Connect from the shortcut menu.

DISCONNECTING FROM A REMOTE SITE

To terminate a connection with a remote DX8000 server: 

1. In the DX8000 main window, right-click the remote site name from the Site tree. The shortcut menu is displayed.

2. Select Disconnect from the shortcut menu.

LOGGING IN TO A REMOTE SITE

After a connection to a remote site has been established, log in with a valid user name and password for that site. 

To log in to a remote site:

1. In the DX8000 main window, select a remote DX8000 Series DVR site from the Site tree.

2. From the DX8000 menu bar, choose File > User Log-in.

You can also log in to a remote site by right-clicking its site name and then selecting User Log-In from the shortcut menu.

3. Enter a user name and password for the remote site.
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LOGGING OUT OF A REMOTE SITE

Logging out of the local or a remote DVR does not disconnect you from that system. Logging out will return you to the Guest account. 
To disconnect from a remote server, refer to Disconnecting from a Remote Site on page 17. You can only log out of one server at a time. If you are 
logged into multiple servers, you must log out of each server individually. You can also log out of a local or remote DVR by right-clicking its site 
name from the Site tree and selecting User Log-out from the quick-menu.

To log out of a local or remote DVR site: 

From the DX8000 menu bar, choose File > User Log-out.
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Understanding the DX8000 Application Window
This section describes the DX8000 application window and its operation. The application window is the central control center from where you 
have access to the DX8000 features and functions.

• View both live and recorded video

• Exit to the Windows environment

• Access DX8000 setup features

• Control camera pan, tilt, and zoom functions

• Select cameras for viewing and recording

• Specify playback date and time

• Access playback controls

This section includes the following topics:

• Description of the DX8000 Main Window on page 19

• Understanding View Panes and Panels on page 26

• Working with the Site tree on page 31

DESCRIPTION OF THE DX8000 MAIN WINDOW
The application window is displayed after the DX8000 starts. The main window provides access to both live and recorded video.

This section describes the DX8000 main window and includes the following topics:

• DX8000 Menu Bar on page 22 

• DX8000 Toolbar on page 25

• Displaying the DX8000 Window from a Page on page 26

• Description of Operating Modes on page 26 

• Switching Between Standard and Extended Panel Views on page 26
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The following figure shows the parts of the DX8000 main window.

Figure 2.  DX8000 DVR Main Window

The following table describes the parts of the DX8000 application window.

Table A.  Parts of the DX8000 Application Window 

Item Part Description

Title Bar Displays the DX8000 application title.

Menu Bar Provides access to drop-down menus.

Toolbar Provides access to display, setup, export, and search tools.

Site tree Displays top-down, hierarchical management of DX8000 resources, such as servers, cameras, alarms, and 
relays.

View Panels Display live and playback video from attached cameras. A view panel consists of view panes.

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera 
channel. Up to 36 view panes can fit in a single view panel.

• View panel: A view panel is made up of the entire DX8000 viewing area. View panels are divided into 
multiple panes. A panel can display from one to 36 individual cameras.

For additional information about view panels and panes, refer to Understanding View Panes and Panels on 
page 26.
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PTZ Control Panel Allows users with access rights to operate camera lens control features and to program PTZ presets, 
patterns, auxiliary outputs, and tours. This panel is hidden in the extended view mode. In this case, select the 
standard view mode to display the PTZ control panel. For information on how to select view modes, refer to 
Switching Between Standard and Extended Panel Views on page 26.

Index View Panel Allows users with access rights to search motion and alarm events within a 24-hour period specified in the 
playback timeline. This panel is hidden in the extended view mode. In this case, select the standard view 
mode to display the index view panel. For information on how to select view modes, refer to Switching 
Between Standard and Extended Panel Views on page 26.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows users with Standard User access 
rights to select a date and time for playback. This panel is hidden in the extended view mode. In this case, 
select the standard view mode to display the playback timeline. For information on how to select view modes, 
refer to Switching Between Standard and Extended Panel Views on page 26.

Playback Control 
Panel 

Provides buttons for users with access rights to control video playback. Includes forward and reverse playback 
and still image. It also provides controls for playback speed and volume. This panel is hidden in the extended 
view mode. In this case, select the standard view mode to display the playback timeline control panel. For 
information on how to select view modes, refer to Switching Between Standard and Extended Panel Views on 
page 26.

PTZ OSD Menu or

Digital Zoom  
Control 

This control provides two functions depending on which mode the DX8000 is operating: live view or playback:

• Live View Mode: In the Live View mode, provides users with access rights to operate PTZ OSD 
features. For information on using the PTZ OSD menu controls, refer to Using the PTZ OSD Menu Control 
on page 51.This panel is hidden in the extended view mode. In this case, select the standard view mode 
to display the playback zoom control. For information on how to select view modes, refer to Switching 
Between Standard and Extended Panel Views on page 26.

• Playback Mode: In the Playback mode, provides users with access rights to operate digital zoom 
features. This panel is hidden in the extended view mode. In this case, select the standard view mode to 
display the playback zoom control. For information on how to select view modes, refer to Switching 
Between Standard and Extended Panel Views on page 26.

Status Bar Displays current date and time, recorder processing status, disk status indicator, user name of currently 
logged-in user, and total amount of recorded video. The status bar is hidden in the extended view mode. 
In this case, select the standard view mode to display the status bar. For information on how to select view 
modes, refer to Switching Between Standard and Extended Panel Views on page 26.

NOTE: As the storage array of the DX8000 fills beyond its capacity, video is deleted in a first-in, first-out 
(FIFO) fashion. The disk status indicator on the status bar shows the amount of disk space used by recorded 
video. The red indicator marks the current recording position of the disk array, blue indicators mark parts of 
the array that are storing previously recorded video, and clear indicates that no video has been recorded in 
that area of the array.

Table A.  Parts of the DX8000 Application Window (Continued)

Item Part Description
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DX8000 MENU BAR

This section describes the DX8000 menu bar commands and includes the following topics:

• File Menu on page 22

• Edit Menu on page 22

• View Menu on page 23

• Export Menu on page 24 

• Favorite Menu on page 24

• Help Menu on page 24

File Menu

The following table describes the DX8000 File menu commands.

Edit Menu

The following table describes the DX8000 Edit menu commands.

Table B.  File Menu Commands

Command Description

User Log-in Opens the User Log-In dialog box for entering the user name and password to log in to the DX8000.

User Log-out Immediately logs the current user out of the DX8000. The system returns to the default mode.

Software Upgrade Opens the Select Upgrade Package dialog box for selecting the source from which to access files to upgrade 
the DX8000 software. This command is available only when you log in to the DX80000 as Administrator. 

Password Recovery Opens the Password Recovery dialog box for entering the password provided by Pelco Product Support. For 
more information, refer to Recovering a Password on page 215. For information on recovering a password, 
contact Pelco Product Support.

Unplug/Eject Hardware Opens the Unplug or Eject Hardware dialog box for selecting the device you want to unplug or eject.

Exit Opens the Shut down dialog box for selecting one of the following actions (requires a certain level of user 
permission):

• Shut down: Shuts down the DX8000 machine. You must have Power User or Administrator access to 
shut down the DX8000 machine. For more information, refer to Shutting Down the DX8000 on page 15.

• Restart: Restarts the DX8000 application. You must have Administrator user access to restart the 
DX8000 application. For more information, refer to User Setup on page 171.

• Exit to Windows mode: You must have Administrator user access to exit the DX8000 application to 
the Windows operating system. For more information, refer to Exiting to the Windows Operating 
System on page 17.

Table C.  Edit Menu Commands

Command Description

Export Setup Opens the DX8000 Setup File Export dialog box for exporting the DX8000 system configuration settings to a 
specific file name and location. The Export feature also allows you to export the DX8000 settings to specified 
location for later retrieval. For more information, refer to Using the Edit Menu to Perform an Export on 
page 183. 

Import Setup Opens the DX8000 Setup File Import dialog box for importing a DX8000 system configuration file. For more 
information, refer to Using the Edit Menu to Perform an Export on page 183.
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View Menu

The following table describes the DX8000 View menu commands.

Table D.  View Menu Commands 

Command Description

OSD Opens a submenu with the following choices:

• Site Name: A global setting that, when selected, displays a site’s name in the respective view pane.

• Camera Name: A global setting that, when selected, displays a camera’s name in the respective view 
pane.

• Video Recording: A global setting that, when selected, displays an icon in the upper right corner of 
the pane and enables video recording for the cameras assigned to a view pane. 

• Audio Recording: A global setting that, when selected, enables audio recording for the cameras 
assigned to a view pane. The DX8000 compresses audio data to save space. In this case, recorded 
audio may not be of the same quality as live audio. 

• PTZ: A global setting that, when selected, enables PTZ capability for the cameras assigned to a view 
pane.

• Instant Recording: A global setting that, when selected, enables instant recording capability for the 
cameras assigned to a view pane.

• POS: A global setting that, when selected, enables POS video recording for the cameras assigned to a 
view pane.

• Select All: Selects all of the OSD options.

• Background Color: Opens a submenu with the following choices:

– Set Color: Opens the Colors palette for selecting or creating a background color.
– Disable Background: Disables a background color from being shown.

Log Opens a submenu with the following choices: 

• System On/Off

• System Failure

• Export

• Backup

• Network Connection 

• Login ID list with Time

• Video Loss

Resolution Opens a submenu with the following choices:

• 1024x768

• 1280x1024

Cycle Views Setup Opens a submenu with the following choices:

• Dwell time change: Opens a submenu with the following choices for assigning permission to a user 
group, allowing the selected user group to change the dwell time:

– Restricted User Group
– Standard User Group
– Power User Group

• Dwell time: Opens a submenu of dwell times with the following choices:

– 2 Sec.
– 5 Sec.
– 10 Sec.
– 30 Sec.
– 60 Sec.

Extended View Enlarges the video image displayed in the view pane.

Index View Opens the Event Index pane.

Display Deinterlaced Image Selects the deinterlace mode for enhancing the display of video images. 
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Export Menu

The following table describes the DX8000 Export menu commands.

Favorite Menu

The following table describes the DX8000 Favorite menu commands.

Help Menu

The following table describes the DX8000 Help menu commands.

Table E.  Export Menu Commands

Command Description

Interrupt Export Immediately concludes an export process. If the Interrupt Export command is executed before the scheduled 
backup time, the system will save the backed-up data up until the time the Interrupt Export command is 
executed. 

Cancel Export Immediately cancels the export process and no backed data retained.

Table F.  Favorite Menu Commands

Command Description

Add to Favorites Opens the Add to Favorites dialog box, where you create a favorite and store the favorite to a specified 
folder.

Organize Favorites Opens the Organize Favorites dialog box, where you can do the following:

• Create a folders

• Rename folders

• Move favorites to a specific folder

• Delete a favorite or favorite folder

Table G.  DX8000 Help Menu Commands

Command Description

DX8000 Help Opens the DX8000 Help system.

About Provides model and version information for the DX8000 application.
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DX8000 TOOLBAR

This section describes the DX8000 toolbar. The following table describes the DX8000 toolbar buttons.

Table H.  DX8000 Toolbar Buttons 

Button Name Description

Live Enters the display mode and opens the DX8000 main window, where live and playback video is displayed:

• Live Mode: Allows all users to view live video.

• Playback Mode: Allows users with Standard User access and higher to play back recorded video.

Search Enters the Search mode and opens the search window, providing access to search features. Users with 
Standard User access and higher are allowed to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera page (default view), and allows access 
to the other pages. Users with Power User access and higher are allowed to set up the features and options 
for the DVR.

Export Enters the export mode, where you configure the export options and parameters.

Print Enters the print mode, where you print the selected video image.

Single Division Displays one camera.

4 Division Displays four cameras at a time (quad display).

9 Division Displays nine cameras at a time.

16 Division Displays 16 cameras at a time.

25 Division Displays 25 images. Each DVR accommodates up to 16 cameras. You can display images from the local and 
remote DX8000 DVRs.

36 Division Displays 36 images. Each DVR accommodates up to 16 cameras. You can display images from the local and 
remote DX8000 DVRs.

6, 10, 13 Division Displays images as follows: 

• 6 Division (1+5): One larger and five smaller images

• 10 Division (2+8): Two larger and eight smaller images

• 13 Division (1+12: One larger and 12 smaller images

Cycle Views Turns window cycling on and off. Automatically cycles through each view panel ensuring all cameras get 
displayed. Group permission to change the dwell time is assigned by the Administrator to the following 
groups: Restricted User Group, Standard User Group, and Power User Group. For information on cycle views 
setup, refer to Automatically Cycling Through View Windows on page 29.

Full Screen Selects a full-window view. The application window is expanded to occupy the entire monitor screen. Click 
the right mouse button to exit full-screen view.

External Monitor Opens the external monitor drop-down menu. For more information, refer to External Monitor Setup on 
page 191.
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DISPLAYING THE DX8000 WINDOW FROM A PAGE

To display the DX8000 main window from a Setup dialog page:

DESCRIPTION OF OPERATING MODES

The DX8000 Series DVR has four primary operating modes: Live, Playback, Search, and Setup. Each operating mode is accessed by clicking its 
corresponding button on the toolbar. 

The following table describes the DX8000 operating modes.
 

SWITCHING BETWEEN STANDARD AND EXTENDED PANEL VIEWS

The DX8000 features a viewing area that can be expanded to fill a larger portion of the main window. Extended view expands the viewable  
panel containing camera panes but hides the timeline, PTZ, digital zoom, and playback controls. To use the timeline, PTZ, digital zoom, and  
playback controls, you must take the DX8000 out of extended view.

To switch back and forth between standard and extended view: 

UNDERSTANDING VIEW PANES AND PANELS
This section describes the DX8000 viewing area. The viewing area is organized into panes and panels, much like a window contains panes. 
Video from each camera is displayed in its own viewing pane. 

This section includes the following topics:

• Working with View Pane and Panel on page 26 

• Configuring View Panels on page 27 

• Navigating View Panels on page 27 

WORKING WITH VIEW PANE AND PANEL

The DX8000 displays video from each camera in its own viewing pane. 

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera channel. Up to 36 view panes can fit 
in a single view panel.

• View panel: A view panel is made up of the entire DX8000 viewing area. View panels are divided into multiple panes. Each panel can 
display from one to 36 individual cameras.

On the DX8000 toolbar, click Live.

Table I.  Operating Modes

Icon Mode Description

Live Enters the display mode and opens the DX8000 main window, where live and playback video is displayed:

• Live Mode: Allows all users to view live video.

• Playback Mode: Allows users with Standard User access and higher are allowed to play back recorded 
video.

Search Enters the Search mode and opens the search window, providing access to search features. Users with 
Standard User access and higher are allowed to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera setup page (default view), and allows 
access to the other setup pages. Users with Power User access and higher are allowed to set up the features 
and options for the DVR.

From the DX8000 menu bar, choose View > Extended View.
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The following figure illustrates how the DX8000 viewing area is structured.

Figure 3.  View Panes and Panel for 4-Division Display

The following table describes the view pane and panel as shown in the figure above.

CONFIGURING VIEW PANELS

The DX8000 can display up to 36 cameras simultaneously in a single panel.

To select a view panel division:

1. On the DX8000 toolbar, click .

2. On the DX8000 toolbar, click a view panel division button. 

For information on the view division buttons, refer to DX8000 Toolbar on page 25.

NAVIGATING VIEW PANELS

This section describes how to move between the DX8000 view panes and panels. This section includes the following topics:

• Navigating Between View Panels on page 27 

• Expanding and Collapsing View Pane on page 29 

• Manually Cycling Through Hidden View Panels on page 29 

• Automatically Cycling Through View Windows on page 29

Navigating Between View Panels

The DX8000 allows you to monitor up to 36 channels: each channel is assigned to 1 pane within the view panel. If the 36-division display format 
is selected, all 36 panes occupy one panel. However, for single, 4-division, 9-division, 16-division, and 25-division display formats, the DX8000 
displays the panes in multiple panels. In this case, to view all of the panes, you must cycle through multiple panels to display hidden panels. 

• Channel: As pertains to video, one DX8000 camera port (input). The term channel is sometimes used interchangeably with camera.

• Camera: One external video device, such as a Spectra III™, that provides input video to the DX8000 DVR.

For example, if you select the single-division display format, 1 channel (video pane) fills the entire panel. 

Table J.  View Panes Panel

Item Description

Shows a view pane for a for division display.

Shows the view panel, which contains view panes.

�

�
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• The pane and panel represent the same amount of viewing area. 

• In this case, there will be an additional 31 hidden panels (1 pane = 1 panel) available to cycle through. 

Similarly, if you select the 4-division display format:

• Four panes (one camera/channel per pane) are displayed in the panel.

• In this case, 7 hidden panels (four cameras/channels per panel, which equals 4 x 7 = 28 panels), remain to be displayed. 

The following figure shows how the DX8000 cycles through view panels, depending on the display format.

Figure 4.  Example of Single, 4, 9, and 16 Division View Panels

The following table describes how the DX8000 view panes and panels are organized.

Pressing one of the view panel division buttons sets the number of visible channels displayed in the panel. The following figure illustrates the 
view panel identifier.

Table K.  How View Panels are Organized

Display Type Grouping Number of 
View Panes

Number of 
View Panels

Single 1/32 1 32

4 Division 1/8 4 8

9 Division 1/4 9 4

16 Division 1/2 16 2

25 Division 1/2 25 2

36 Division 1/1 36 1

6, 10, 13 Division:

• 1+5 Division 1/6 6 6

• 2+8 Division 1/4 10 4

• 1+12 Division 1/4 13 4

17 18 19 20
21 22 23 24
25 26 28
29

27
30 3231

1 2 3 4
5 6 7 8
9 10 12

13
11

14 1615
32

1

1
32    31    32

28    29    30

25    26    27

23    24     25

17    18     19

20    21     228      9     10

11    12    13

14    15    16

1      2      3

7      8      9

4      5      6

29 30

31 3225 26

27 2821 22

23 2417 18

19 20
13 14

15 16
9 10

11 12
5 6

7 8
1 2

3 4
1 - 4

5 - 8
9 - 12

13 - 16
17 - 20

21 - 24
26 - 28

29 - 32

1 - 9
8 - 16

17 - 25
25 - 32

1 - 16
17 - 32
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Figure 5.  View Panel Identifier

The following table describes how the DX8000 view panes and panels shown in Figure 4 are organized.

Expanding and Collapsing View Pane

To expand a view pane to fill the entire panel:

To collapse a view pane:

Manually Cycling Through Hidden View Panels

To manually cycle through hidden view panels:

For example for a 4 Division display format, if you click  repeatedly, the DX8000 cycles through each of the eight available view panels. 

Automatically Cycling Through View Windows

The DX8000 provides an automatic cycle feature that when selected, automatically cycles through each view panel ensuring all cameras get 
displayed. Group permission to change the dwell time is assigned by the Administrator to the following groups: Restricted User Group, Standard 
User Group, and Power User Group. 

This section describes how to configure the DX8000 to automatically cycle through camera views and includes the following sections:

• Starting an Automatic Cycle View Mode on page 30

• Stopping an Automatic Cycle View Sequence on page 30

• Selecting User Groups to Set the Cycle View Dwell Time on page 30

• Selecting the Cycle View Dwell Time on page 30

Table L.  View Panes and Panel

Item Description

Indicates the panel number being viewed. 

Indicates how many pane are displayed per panel.

Double-click a view pane.

The view fills the entire view panel. 

Double-click the expanded view pane.

The view pane returns to its default size.

On the DX8000 toolbar, click one of the panel division buttons repeatedly.

The view sequences through the view panels.

� �
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Starting an Automatic Cycle View Mode

To start the automatic cycle view mode:

For example, if you, click , the automatic cycle view process starts.

Stopping an Automatic Cycle View Sequence

To stop the automatic cycle view mode:

Selecting User Groups to Set the Cycle View Dwell Time

The DX8000 allows the Administrator to control which user group can change the cycle view dwell time. In this case, anyone that belongs to a 
selected user group can change the cycle view dwell time. 

To select a user group to have permission to change the cycle view dwell time:

1. On the DX8000 toolbar, click .

2. From the DX8000 menu bar, choose View > Cycle Views Setup > Dwell time change.

3. From the Dwell time change submenu, choose a user group.

Selecting the Cycle View Dwell Time

To configure the cycle period:

1. On the DX8000 toolbar, click .

2. From the DX8000 menu bar, choose View > Cycle Views Setup > Dwell time.

3. From the Dwell time submenu, choose a time period.

On the DX8000 toolbar, click Cycle Views. 

The Cycle Views icon turns blue, indicating that the DX8000 is in the automatic cycle view mode. The system will cycle through each 
panel, displaying each pane for the configured cycle view dwell time. 

On the DX8000 toolbar, click Cycle Views. 

The DX8000 stops the automatic cycle view mode.
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WORKING WITH THE SITE TREE
The Site tree provides access to DX8000 resources, such as cameras, alarm inputs, and relay outputs. Objects can be selected by clicking once 
with the left mouse button and linked by dragging and dropping the icon into the view pane with the mouse. The Site tree information reflects 
the current DX8000 server configuration.

The following figure shows the Site tree.

Figure 6.  Site tree Parts

The following table describes the Site tree parts.

Table M.  Site tree Parts 

Item Part Description

Name Site: Expands and collapses the DX8000 site. Right-clicking the site name opens a shortcut menu that provides the 
following commands:

• User Log-In: Clicking User Log-In opens the User Log-In dialog box, where you enter your user name and password 
to log into the DX8000 site.

• User Log-Out: Clicking logs you out of the DX8000 site.

• Connect

• Disconnect

Camera: Expands and collapses the Camera tree.

Channel information: Displays icons that represent the configuration for the camera:

• Recording mode

• Recording resolution

• Recording frame rate

• Recording Image quality

Alarm: Expands and collapses the Alarm tree.

ATM/POS: Expands and collapses the ATM/POS tree.

�
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This section describes how to work with the Site tree and includes the following topics:

• Assigning Cameras to View Panes on page 32

• Setting Up Links on page 32

• Removing Links on page 34

ASSIGNING CAMERAS TO VIEW PANES

The DX8000 provides view panes that are organized into view panels. The DX8000 includes 36 view panels that can display cameras from up to 
five connected DVR sites. For information on view panels, refer to Working with View Pane and Panel on page 26.

The DX8000 Series DVR supports triplex operation. Triplex operation means that the DX8000 will continuously record even while users view 
simultaneous live and playback video or modify the system setup.

To assign a single camera to a view pane:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to to expand the tree if necessary.

3. Do one of the following:

• To assign a single camera to a view pane, drag the camera from the Site tree onto a view pane. 

• To assign all cameras from a single site to the view panes at once, drag  onto a single view pane. (The default arrangement of 

cameras is Camera1, Camera2, Camera3 – from left to right, top to bottom.)

4. Repeat the process in step 3 for up to 36 cameras from up to five DVR sites.

SETTING UP LINKS

The DX8000 allows you to set up links in various configurations:

• You can link multiple alarms and relays to a single camera. 

• You can link a single alarm or relay to multiple cameras. 

• You can link alarms and relays to cameras by dragging them onto individual camera view panes.

• You can also manually turn a relay on and off from the Site tree.

This section describes how to set up links and includes the following sections:

• Manually Turning a Relay On and Off on page 33

• Linking Alarm Inputs to a Camera on page 33

• Linking a Relay Output to a Camera on page 33

• Linking Relay Outputs to Alarm Inputs on page 33

Relay: Expands and collapses the Relay tree. Right-clicking a relay opens a shortcut menu that provides the following 
commands:

• ON: Allows you to turn the relay on.

• OFF: Allows you to turn the relay off.

Remote site: Expands and collapses the remote DX8000 site. Right-clicking the remote site name opens a shortcut 
menu that provides the following commands: 

• User Log-In: Clicking User Log-In opens the User Log-In dialog box, where you enter your user name and password 
to log into the remote DX8000 site.

• User Log-Out: Clicking logs you out of the remote DX8000 site.

• Connect: Allows you to connect to the remote site.

• Disconnect: Allows you to disconnect from the remote site.

Table M.  Site tree Parts (Continued)

Item Part Description
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Manually Turning a Relay On and Off

To manually turn a relay on and off:

1. Right click a relay. The shortcut menu opens.

2. Click ON or OFF to turn the relay OFF if it is on or ON if it is off.

Linking Alarm Inputs to a Camera

The DX8000 allows you link alarm inputs to a camera.

• You can link multiple alarm inputs to a single camera. 

• You can also link a single alarm input to multiple cameras. 

The DX8000 allows you link alarms to cameras by dragging them onto individual camera view panes.

To link an alarm input to a camera:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera to which you want to link alarms.

3. Click the plus sign (+) next to the  to see the list of alarm inputs.

4. Drag an alarm input onto a camera.

Linking a Relay Output to a Camera

The DX8000 allows you link relays to a camera.

• You can link multiple relays a single camera. 

• You can also link a single relay to multiple cameras. 

The DX8000 allows you link relays to cameras by dragging them onto individual camera view panes.

To link a relay output to a camera:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera to which you want to link relays.

3. Click the plus sign (+) next to  to see the list of relay outputs.

4. Drag a relay onto a camera. 

Linking Relay Outputs to Alarm Inputs
To link a relay output to an alarm input: 

1. On the DX8000 toolbar, click . 

2. In the Site tree, click the plus sign (+) next to  to expand the Alarm tree if needed.

Relays can also be linked to cameras and alarms on the Link settings page. For more information, refer to Configuring Basic Relay and 
Alarm Settings on page 111.

3. Click the plus sign (+) next to  to expand the Relay tree if needed.

4. Drag a relay output onto an alarm input.
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REMOVING LINKS

This section describes how to remove links and includes the following sections:

• Removing a Linked Alarm Input from a Camera on page 34

• Removing a Linked Relay Output from a Camera on page 34

• Removing a Linked Relay Output from an Alarm Input on page 34

Removing a Linked Alarm Input from a Camera
To unlink an alarm from a camera:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera from which you want to remove an alarm input.

3. Drag the alarm outside the Site tree panel, and then release the mouse button. 

4. Repeat the above process for each alarm you want to remove.

Removing a Linked Relay Output from a Camera
To unlink a relay from a camera:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera from which you want to remove the relay output.

3. Drag the relay outside the Site tree panel to the DX8000 toolbar or panel (above or below the Site tree panel), and then release the mouse 
button. 

4. Repeat the above process for each relay you want to remove.

Removing a Linked Relay Output from an Alarm Input
To unlink a relay from an alarm:

1. On the DX8000 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the alarm input from which you want to remove the relay output.

3. Drag the relay outside the Site tree panel, and then release the mouse button.

4. Repeat the above process for each relay you want to remove.
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Working in Live View Mode
This section describes how to use the DX8000 to view and record live video. All users can view live video from the main window. Users with 
Standard User access and higher can operate the on-screen PTZ controls.

To view live video in the DX8000 main window:

This section includes the following topics:

• Assigning Cameras to View Panes on page 35

• Live View On-Screen Display (OSD) on page 38 

• Customizing the On-Screen Display (OSD) on page 39 

ASSIGNING CAMERAS TO VIEW PANES
To assign a camera to the view pane:

1. Drag a camera from the Site tree onto a view pane. 

2. Repeat the process in step 1 for up to 36 cameras from up to five different DX8000 sites.

For information about the DX8000 view pane and panels, refer to the following topics:

• Working with View Pane and Panel on page 26 

• Configuring View Panels on page 27 

• Navigating View Panels on page 27

SETTING UP FAVORITES
The DX8000 Favorites menu allows you to organize and save camera views. For example, you might want to display camera views that show the 
delivery gate entrance for buildings 1, 4, 7, and 12 during the hours of 06:00 to 07:30 and another camera view that displays the front lobby of 
building 1–16 at 08:00. 

This section describes the following topics:

• Adding a Camera View to Favorites on page 35 

• Organizing Favorites in Folders on page 36 

ADDING A CAMERA VIEW TO FAVORITES

You can create multiple camera views to monitor various site locations. For example, you could create a folder named Day Shift for displaying 
camera views during normal working hours and Night Shift for displaying various camera views after work and during the night hours. For 
information about organizing favorites into folders, refer to Organizing Favorites in Folders on page 36.

To add a camera view to favorites:

1. From the DX8000 menu bar, click Add to Favorites. 

The Add to Favorites dialog box opens.

Figure 7.  Add to Favorites Dialog Box

On the DX8000 toolbar, click Live.
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2. Enter the camera view name in the Name text box.

3. Click OK. The camera view is added to the favorites, and the Add to Favorites dialog box closes.

4. To view the new entry, from the DX8000 menu bar, click Favorites. The new entry appears in the Favorites list.

Figure 8.  Favorites Menu List

ORGANIZING FAVORITES IN FOLDERS

As your list of favorites grows, you can keep them organized by creating folders. You can organize your camera views by site name, user name, 
and so forth. For example, you could create a folder named Day Shift for displaying camera views for the day shift.

Creating a Favorites Folder

To create a favorites folder:

1. From the DX8000 menu bar, click Organize Favorites. 

The Organize Favorites dialog box opens.

Figure 9.  Organize Favorites Dialog Box

2. Click Create Folder. A new folder is added to the favorites area.

3. To name the folder, do one of the following:

a. If the new folder name is already selected, type the name of the folder.

or

b. If the new folder name is not selected:

(1) Click the new folder.

(2) Type the name of the folder.

The new folder is listed in the Favorites area of the Organize Favorites dialog box and in the Favorites menu.
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Organizing Favorites in Folders

To organize existing favorites into folders:

1. Create a favorites folder. 

For information about creating a favorites folder, refer to Creating a Favorites Folder on page 36.

2. From the DX8000 menu bar, click Organize Favorites. 

The Organize Favorites dialog box opens. A list of the current favorites and folders is displayed in the favorites area.

Figure 10.  Organize Favorites Dialog Box and List of Favorites and Folders

3. In the favorites area, click a favorite.

4. Click Move to Folder.

The Move to Folder dialog box opens.

Figure 11.  Move to Folders Dialog Box

5. Select a destination folder.

6. Click OK.

The favorite is moved under the destination folder.
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LIVE VIEW ON-SCREEN DISPLAY (OSD)
The DX8000’s OSD consists of camera and site information that is superimposed on each view pane. Each display item in the OSD can be 
customized for both live and playback viewing.

The following figure shows the Live View OSD pane.

Figure 12.  Live View OSD Pane

The following table describes the parts of the Live View OSD pane.

Table N.  Parts of the Live View OSD Pane

Item Part Description

PTZ Indicates that the PTZ control is enabled.

Indicates that audio recording is enabled. The DX8000 compresses audio data to save space. In this case, 
recorded audio may not be of the same quality as live audio.

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates event recording.

• Purple indicates video loss recording. 

Site Designator Lists the number and name of the current site.

Camera Designator Lists the number and name of the current camera.

On-Screen PTZ  
Control 

Facilitates mouse control of PTZ functions. Refer to Operating the On-Screen Pan, Tilt, and Zoom (PTZ) 
Controls on page 41. 

Instant Recording Starts/stops instant recording if enabled.

�
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CUSTOMIZING THE ON-SCREEN DISPLAY (OSD)
Users with Guest and Power User access and higher can add and delete on-screen display items. 

To customize the on-screen display:

1. From the DX8000 menu bar, choose View > OSD and then select the items you want to add to or delete from the OSD. Items include

• Site Name
• Camera Name
• Video Recording
• Audio Recording
• PTZ
• Instant Recording
• POS
• Select All (displays all items in each pane)
• Background Color

 

Figure 13.  DX8000 DVR OSD Menu Options

2. Do one of the following:

• From the DX8000 menu bar, choose View > OSD > Background Color > Set Color to add a contrasting background field behind each 
OSD display item.

• From the DX8000 menu bar, choose View > OSD > Background Color > Disable Background to remove background field.

INSTANT RECORDING
This section describes the instant recording mode. Users with Power User access and higher can configure the DX8000 for recording video both 
instantly and in accordance with a preset schedule. The Instant Recording mode is enabled from the Schedule page. Instant recording is 
activated from the main window by double-clicking the Instant Recording icon. 

If the DVR is not in the normal recording mode, you can use the instant recording mode to manually start and stop a video recording session 
instantly. For information about adding the Instant Recording icon to the OSD, refer to Adding Instant Recording to OSD on page 40.

This section includes the following topics:

• Enabling and Disabling Instant Recording on page 39 

• Adding Instant Recording to OSD on page 40 

• Starting and Stopping Instant Recording on page 40

ENABLING AND DISABLING INSTANT RECORDING

This section describes how to enable and disable the instant recording mode and includes the following topics:

• Enabling Instant Recording on page 40 

• Disabling Instant Recording on page 40

For more information on instant recording, refer to Instant Recording on page 39.
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Enabling Instant Recording

To enable the Instant Recording mode: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Enable.

Disabling Instant Recording

To disable the Instant Recording mode: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Disable.

ADDING INSTANT RECORDING TO OSD

To add the Instant Recording icon to the OSD:

STARTING AND STOPPING INSTANT RECORDING

The Instant Recording mode must first be enabled from the Schedule page and the Instant Recording icon must be visible in the lower-right 
corner of the view pane. For more information on DX8000 instant recording, refer to Instant Recording on page 39. For information on OSD, refer 
to Live View On-Screen Display (OSD) on page 38.

The following figure shows the Record and Instant Record icons.

Figure 14.  Activating Instant Recording

From the DX8000 menu bar, choose View > OSD > Instant Recording.

The Instant Record icon is displayed in the lower-right corner of the view pane.

�

�
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The following table describes the instant recording indicators.

This section describes how to start and stop instant recording and includes the following topics:

• Starting Instant Recording on page 41

• Stopping Instant Recording on page 41

Starting Instant Recording

To start instant recording:

Stopping Instant Recording

To deactivate instant recording:

OPERATING THE ON-SCREEN PAN, TILT, AND ZOOM (PTZ) CONTROLS
Users with Standard User access and higher may operate pan, tilt, and zoom lens functions of cameras that support such features. PTZ functions 
can be controlled on-screen in Live mode using the mouse. 

PTZ control is available only for cameras that support PTZ functions using Pelco’s P, D, or Coaxitron® protocols. For more information about 
configuring PTZ ports, refer to Setting Up COM1 and COM2 Port Properties on page 149. In addition, the PTZ option must be enabled and a 
protocol must be assigned to the camera channel. For more information, refer to Camera Setup on page 105.

This section describes how to use the PTZ controls and includes the following topics:

• Operating the PTZ Controls on page 41 

• Adjusting the Camera Lens on page 43 

• Adjusting the Camera Zoom on page 44 

• Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions on page 45

OPERATING THE PTZ CONTROLS

To operate the on-screen PTZ controls:

1. On the DX8000 toolbar, click .

2. Select a PTZ-enabled camera from the Site tree.

Table O.  Instant Recording Indicators

Item Icon Description

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates ATM/POS recording.

Instant Recording Starts/stops instant recording if enabled. Changes from silver to blue to indicate that instant 
recording is activated.

Double-click the Instant Recording icon located in the lower-right corner of the view pane.

• The Instant Recording icon changes from silver to blue, indicating that instant recording is activated.

• If video recording is enabled, verify that REC is highlighted white. If video recording is not enabled, REC is not displayed. 

In the view pane, double-click the Instant Recording icon.
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3. Place the mouse pointer in the middle of the camera’s view pane. The mouse pointer will change to a black cross when on-screen PTZ 
control is available.

Figure 15.  On-Screen PTZ Control

4. Click and hold the left mouse button, and then drag the mouse pointer in the direction you want to move the camera. The display changes 
to an arrow, indicating the direction of the mouse.

Figure 16.  On-Screen PTZ Movement

5. Release the mouse button when you have repositioned the camera to the desired location.

�
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ADJUSTING THE CAMERA LENS

The keypad is hidden in the extended view mode. In this case, select the standard view mode to display the keypad. 

To switch between the standard and extended view mode:

For information on changing view modes, refer to Switching Between Standard and Extended Panel Views on page 26.

To adjust camera lens features:

Figure 17.  PTZ Keypad with Camera Lens Controls

From the DX8000 menu bar, choose View > Extended View.

Click the plus (+) or minus (-) button next to the zoom, focus, and iris function on the keypad.
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ADJUSTING THE CAMERA ZOOM

To adjust camera zoom using the mouse:

The following figure shows how to operate the mouse to zoom in and out. You can also use keyboard shortcuts to operate the lens features of 
cameras such as Pelco’s Spectra III. For more information about using keyboard shortcuts, refer to Using PC Keyboard Shortcuts to Operate PTZ 
and Lens Functions on page 45.

Figure 18.  Mouse Wheel Zoom

Rotate the mouse wheel forward to zoom in and backward to zoom out.
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USING PC KEYBOARD SHORTCUTS TO OPERATE PTZ AND LENS FUNCTIONS

Users with Standard User access and higher may use a PC keyboard to operate PTZ and lens functions of cameras that support such features. PTZ 
and lens functions can be controlled in Live mode using the keyboard. 

The following table describes the keyboard buttons that you use to control PTZ and lens functions. 

To use the keyboard (+) and (-) keys to control camera pan and tilt speed:

1. On the DX8000 toolbar, click .

2. Select a PTZ-enabled camera from the Site tree.

3. Click the mouse pointer in the camera’s view panel.

4. Press and hold the up/down and left/right arrows to pan and tilt the camera.

5. Press the plus (+) key once or more to increase the pan and tilt speed. Press the minus (-) key once or more to decrease the pan and tilt 
speed. 

Table P.  Standard PC Keyboard Functions for Controlling PTZ and Lens Functions

Key Description

Insert and Delete These keys provide the following functionality:

• On-screen display, preset and pattern modes: Insert increases and Delete decreases focus, 
performing the same actions as the focus control on the PTZ keypad. 

• Remote camera programming mode: Insert and Delete perform the same actions as the PTZ keypad 
focus (+) and (-) buttons, navigating up and down the camera menu choices.

Home and End These keys provide the following functionality:

• On-screen display, preset and pattern modes: The Home key opens and the End key closes the iris, 
performing the same actions as the PTZ keypad iris (+) and (-) buttons. 

• Remote camera programming mode: The Home key selects an option from the camera’s on-screen 
menu. The End key cancels an option or exit a menu. These keys perform the same actions as the PTZ 
keypad iris (+) and (-) buttons.

Page Up and Page Down These keys perform the same functionality in the on-screen display and the preset and pattern modes as the 
PTZ keypad zoom (+) and (-) buttons. Page Up zooms in; Page Down zooms out.

Up and Down Arrows These keys provide the following functionality:

• On-screen display, preset and pattern modes: The up arrow key raises the camera and the down 
arrow key lowers the camera. The keys perform the same actions as the mouse to move the camera. 

• Remote camera programming mode: The arrow keys navigate up and down the camera menu 
choices. The keys perform the same actions as the PTZ keypad focus (+) and (-) buttons.

Left and Right Arrows These keys provide the same actions as using the mouse to move the camera. The left arrow key pans the 
camera to the left and the right arrow key pans the camera to the right.

+ and - These keys perform similar actions as using the mouse to change the speed of camera movement. The plus 
(+) key, pressed once increases the camera’s pan and tilt speed. The minus (-) key pressed once decreases the 
camera’s pan and tilt speed. Each time the plus (+) key is pressed the pan and tilt speed is increased toward 
the maximum speed. Each time the minus (-) key is pressed, the pan and tilt speed is decreased toward the 
minimum speed. 
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PTZ PRESETS
A preset is a user-defined camera position using pan and tilt, zoom, and focus commands (camera’s auto focus option must be off). Only cameras 
that support positioning and programming using D, P, or Coaxitron protocols can use this feature. The DX8000 Series DVR can address up to 32 
PTZ presets (1-32). Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

For information on changing view modes, refer to Switching Between Standard and Extended Panel Views on page 26.

The following PTZ operating guidelines must be observed:

• To program or clear presets, preset tours, and patterns, the  icon must be engaged.

• To activate presets, tours, and patterns, the  icon must be disengaged.

This section describes how to program, activate, and clear presets and includes the following topics:

• Programming a Preset on page 46 

• Activating a Preset on page 47 

• Clearing a Preset on page 48 

PROGRAMMING A PRESET

This section describes how to program a preset. The following PTZ operating guidelines apply:

• Clicking the  icon places DX8000 in PTZ programming mode. 

• While in PTZ programming mode, multiple presets can be programmed until the  icon is pressed again.

To program a PTZ preset:

1. On the DX8000 toolbar, click .

2. Drag a camera from the Site tree onto a view panel.

3. Click .

4. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust the zoom setting.

Figure 19.  Creating a Preset

From the DX8000 menu bar, choose View > Extended View.

EXIT
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5. Using the PTZ keypad, select a number for the new preset (for example, 1).

6. Click  to store the preset in the selected memory location.

7. Repeat steps 4-6 for each preset you want to program.

8. Click  again to exit programming mode.

Figure 20.  Programming a Preset

ACTIVATING A PRESET

Double-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 can be 
selected by clicking the number 2 and then the number 0 on the PTZ keypad.

To activate a preset:

1. On the DX8000 keypad, click a preset number (1-32) on the keypad.

2. Click  to activate preset. The camera repositions to the new preset.

Figure 21.  Activating a Preset
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CLEARING A PRESET

To clear a preset:

1. On the DX8000 keypad, click  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click  to exit programming mode.

Figure 22.  Clearing a Preset

PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan, tilt 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra® dome, that is connected to the DX8000. 
Depending on the type and configuration of the PTZ device, the DX8000 can address up to four unique PTZ patterns. Once defined, a pattern can 
be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated. 

Only PTZ-enabled cameras that support pattern programming through D, P, or Coaxitron protocols can use this feature.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

This section describes how to program, activate, and clear patterns, and access the programming features of remote cameras. This section 
includes the following topics:

• Programming a Pattern on page 49 

• Activating a Pattern on page 50

• Clearing a Pattern on page 50 

• Accessing Programming Features of Remote Cameras on page 51

From the DX8000 menu bar, choose View > Extended View.

�
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�
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PROGRAMMING A PATTERN

This section describes how to program a pattern. Certain PTZ devices, such as Pelco’s Spectra series domes, will display an on-screen message 
stating the amount of remaining memory available for pattern programming.

Start Programming a Pattern

To program a pattern:

1. On the DX8000 toolbar, click .

2. Drag a camera from the Site tree onto a view panel.

3. On the DX8000 keypad, click  to enter programming mode.

4. Using the PTZ keypad, select a number for the pattern (1 to 4).

5. Click .

6. Move the camera through a series of movements using the on-screen pan and tilt, zoom, and focus controls.

Figure 23.  Programming a Pattern

Stop Programming a Pattern

To stop programming a pattern:

1. On the DX8000 keypad, click .

2. Click .

�
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ACTIVATING A PATTERN

When activated, a pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

To activate a pattern:

1. On the DX8000 keypad, click a pattern number (1 to 4) on the keypad.

2. Click .

Figure 24.  Activating a Pattern

CLEARING A PATTERN

To clear a pattern:

1. On the DX8000 keypad, click  to enter programming mode.

2. Select a pattern number (1 to 4) on the keypad.

3. Click .

4. Click .

5. Click  again.

6. Click  again to exit programming mode.

Figure 25.  Clearing a Pattern
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ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS

You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra or Esprit®. Only cameras that support remote 
programming through D, P, or Coaxitron protocols can use this feature. 

The DX8000 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information on using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control on page 51.

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu on page 52.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 45.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

This section describes how to access the programming features of remote cameras and includes the following topics:

• Using the PTZ OSD Menu Control on page 51 

• Accessing a Remote Camera Programming Menu on page 52 

Using the PTZ OSD Menu Control

The DX8000 allows you to navigate the menu system of remote cameras using the PTZ OSD Menu control. The PTZ OSD Menu control is 
available when the DX8000 is in Live View mode. The PTZ controls are hidden in the extended view mode. In this case, select the standard view 
mode to display the PTZ controls. 

To switch between the standard and extended view mode:

Alternative methods to navigate the remote camera menu system are as follows:

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu on page 52.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 45.

The following figure shows the PTZ OSD Menu control.

Figure 26.  PTZ OSD Menu

From the DX8000 menu bar, choose View > Extended View.

From the DX8000 menu bar, choose View > Extended View.
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The following table describes the parts of the PTZ OSD Menu control.

Accessing a Remote Camera Programming Menu

The DX8000 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information on using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control on page 51.

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu on page 52.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 45.

The following procedure instructs you to use the PTZ OSD Menu control to navigate the remote camera programming menu.

To access a programming menu for a remote camera:

1. On the DX8000 toolbar, click . 

2. Drag a remote camera from the Site tree onto a view panel.

For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode.

3. To access remote camera setup mode, do one of the following:

• On the DX8000 keypad, click  from the keypad.

• Click , 9, 5, and  from the PTZ keypad.

Figure 27.  PTZ Control Panel

Table Q.  Parts of the PTZ OSD Menu Control

Item Part Description

Enter Provides the following actions:

• Accepts the selected remote camera OSD menu choice.

• Accesses menu option parameters. For example, if the cursor points to the Language option, clicking 
Enter accesses the list of available languages. 

Exit N/A

Up and Down  
Buttons

Navigate up and down the remote camera OSD menu or cycle through a list of options are parameters.

Left and Right  
Buttons

Perform no activity.
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4. To navigate up and down camera menu choices, do one of the following:

• Use the PTZ OSD Menu controls. 
• Use the on-screen PTZ controls or the focus (+) and focus (-) buttons. 

5. To select an option from the camera’s on-screen menu, do one of the following:

• On the PTZ OSD Menu, click Enter.
• On the keypad, click the iris (+) button.

6. Click the iris (-) button to cancel an option or select the Exit command.

You can also use the on-screen PTZ controls with your mouse to navigate camera menus. Click and drag the mouse up or down to move 
between menu options.

7. Click the iris (+) button to select the option or exit a menu when the cursor is at the Exit command.

Figure 28.  Camera Setup Menu
C624M-C (5/06) 53



SENDING AUXILIARY COMMANDS TO A DEVICE
The DX8000 auxiliary feature allows you to control external equipment connected to the auxiliary outputs of Spectra domes or Esprit positioning 
systems. The auxiliary function is implemented through the D protocol and P protocol. In this case, the attached camera and DX8000 must be 
configured to communicate using one of these protocols. 

The Aux key selects the auxiliary mode. Buttons 1–4 select which of the camera’s auxiliary outputs to operate. Buttons 1–4 operate as a toggle 
(on/off) each time they are clicked. 

For example, an Esprit equipped with a wiper uses Aux 1 to control the wiper. In this case, pressing Aux and then 1 sends a command to the 
Esprit to operate the wiper. You must configure the camera to establish how the camera responds to an auxiliary command. For detailed 
information about how a specific Spectra or Esprit camera system interprets auxiliary commands, refer to the documentation that accompanies 
your Spectra or Esprit camera system. 

To send an auxiliary command:

1. On the DX8000 keypad, click  to enter the programming mode. 

2. Select the camera in the DX8000 view panel to which you want to send the auxiliary command.

3. Click the Aux button. Keypad buttons 1–4 are available.

Figure 29.  Auxiliary (Aux) Button

The following figure shows that keypad buttons 1–4 are available.

Figure 30.  Keypad Buttons 1–4 are Available

4. Click a keypad button (1–4). The auxiliary function assigned by camera for the selected button is executed.

�

�
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CONFIGURING PRESET TOURS
A preset tour allows a camera to move through a programmed sequence of PTZ presets. The DX8000 Series DVR can store up to four preset 
tours. While four tours can be programmed, only one tour can be activated at a time. A preset tour will operate continuously until another PTZ 
control action is performed. At least one PTZ preset must be set in order to create a preset tour.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

This section describes how to configure preset tours and includes the following topics:

• Programming a Preset Tour on page 55 

• Activating a Preset Tour on page 58 

• Deactivating a Preset Tour on page 58

PROGRAMMING A PRESET TOUR

This section describes how to program a preset tour and includes the following topics:

• Accessing a Preset Tour Group on page 55

• Adding Presets to a Tour on page 56

• Deleting Presets from a Tour on page 57 

Accessing a Preset Tour Group

To access the “Preset tour group” dialog box:

1. On the DX8000 toolbar, click . 

2. On the DX8000 keypad, click  and then  on the PTZ keypad. The Preset tour group dialog box opens.

3. Select the preset tour (1-4) that you want to program from the drop-down box.

4. Do one of the following:

• To add presets to a tour, refer to Adding Presets to a Tour on page 56.
• To delete presets from a tour, refer to Deleting Presets from a Tour on page 57.

Figure 31.  Preset Tour Dialog Box

From the DX8000 menu bar, choose View > Extended View.

�
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Adding Presets to a Tour

To add presets to a tour:

1. Access the Preset tour group dialog box. For information on accessing the Preset tour group dialog box, refer to Accessing a Preset Tour 
Group on page 55.

2. Click the check box next to one of the presets you want to add to the tour.

3. Double-click within the Dwell Time field of the preset and increase or decrease the time in seconds the camera will remain on the preset 
during that sequence of the tour. 

4. Repeat steps 1 and 2 for each additional preset you want to add to the tour.

5. Click Add to Group.

6. Click Save.

7. Click Exit to return to the main screen.

Figure 32.  Adding Preset to Tour
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Deleting Presets from a Tour

To delete presets from a tour:

1. Access the Preset tour group dialog box. For information on accessing the Preset tour group dialog box, refer to Accessing a Preset Tour 
Group on page 55.

2. Click the check box next to one or more presets you want to delete from the preset tour group.

3. Click Delete.

4. Click Save.

5. Click Exit to return to the main screen.

Figure 33.  Deleting Preset from Tour
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ACTIVATING A PRESET TOUR

This section describes how to activate a preset tour. You can save a preset tour for later use without engaging the tour by not performing step 5 
and continuing on to step 6 without clicking Apply.

To activate a preset tour: 

1. On the DX8000 toolbar, click . 

2. Click  and then  to bring up the preset tour dialog box.

3. From the drop-down box, select the preset tour (1-4) you want to activate.

4. Click Save. 

5. Click Apply. 

6. Click Exit to return to the main screen.

7. Click  on the PTZ keypad to exit programming mode.

8. Click  on the PTZ keypad to activate the tour.

Figure 34.  Activating a Preset Tour

To reactivate the last preset tour you configured:

DEACTIVATING A PRESET TOUR

To deactivate a preset tour, do one of the following:

 On the keypad, click Preset.

• Use the mouse to move the on-screen PTZ control.

• Activate a PTZ preset.

�
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USING THE KBD300A KEYBOARD
The KBD300A allows you to operate certain DX8000 live view display functions and control camera PTZ operations from a keyboard rather than a 
mouse. 

When connected to the DX8000 server, the KBD300A supports two modes: the Standard mode and the Shift mode. The Shift mode is entered by 
pressing the Shift button and is indicated by the lighting of the shift button LED. For information about how to operate the KBD300A, refer to the 
KBD300A Universal Keyboard Installation/Operation manual.

This section describes the KBD300A operational features and is organized as follows:

• KBD300A Standard Mode Operational Features on page 59

• KBD300A Shift Mode Operational Features on page 60

For information about connecting the KBD300A to the DX8000, refer to the DX8000 Installation manual. For information about configuring 
DX8000 data communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 161. 

KBD300A STANDARD MODE OPERATIONAL FEATURES

The KBD300A Standard mode allows you to control certain DX8000 operation features in the view pane from the keyboard. 

This section describes the KBD300A Standard mode features/functions. The Standard mode is effective within the DX8000 view pane. You can 
program camera presets and patterns, operate the camera PTZ features, and assign cameras to panes. For detailed information about how to 
operate the KBD300A, refer to the KBD300A Universal Keyboard Installation/Operation manual. For information about configuring DX8000 data 
communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 161.

The following table describes the KBD300A Standard mode operational features specific for the DX8000 server. 

To place the KBD300A in the standard mode:

Table R.  KB300A Standard Operational Mode Features 

Keyboard Control Action

Joystick Controls the camera’s PTZ operation.

Number + PRESET (short) Moves camera to the programmed preset position.

Number + PRESET (long) Programs the current camera position to the desired preset number.

Number + PATTERN (long) Starts the pattern record mode.

ACK Stops the pattern record mode.

Number + PATTERN Runs the desired pattern.

Number + AUX ON/AUX OFF Turns the specified auxiliary output on or off.

Number + MON Assigns the selected camera to the desired view pane. The active view pane is highlighted.

On the KBD300A keyboard, press the SHIFT button.

The LED indicator should be off.
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KBD300A SHIFT MODE OPERATIONAL FEATURES

The KBD300A Shift mode allows you to control certain DX8000 operation features in the Site tree from the keyboard.

This section describes the KBD300A Shift mode features/functions. The Shift mode is effective within the DX8000 Site tree. You can move the 
cursor to select elements within the Site tree, expand/collapse elements, and select the display division. For detailed information about how to 
operate the KBD300A, refer to KBD300A Universal Keyboard Installation/Operation manual. For information about configuring DX8000 data 
communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 161.

The following table describes the KBD300A Shift mode operational features specific to the DX8000 server.

To place the KBD300A in the shift mode:

Table S.  KBD300A Shift Mode Operational Features

Keyboard Control Action

Joystick Activity within the DX8000 Site tree:

• Up/down direction: Moves the cursor vertically through each element in the Site tree. 

An element is a DX8000 site, camera within each DX8000 site, or Alarm, ATM/POS, and relay within each 
DX8000 site.

If an element is expanded, the joystick moves the cursor vertically through the objects of that element.

• Left/right direction: 

– Right: Expands an element to display objects contained under the element.
– Left: Collapses an element and hides its objects. Select a camera/unit at the tree.

Number + CAM Expands the Site tree and selects the first camera in each DX8000 site. For example, if there are two sites with one 
named DX8000 site 1 and the other named DX8000 site 2:

• Pressing 1 + CAM expands the Site tree for DX8000 site 1 and selects the first camera. But it does not assign 
the selected camera to a view pane or display video.

• Pressing 2 + CAM expands the Site tree for DX8000 site 2 and selects the first camera. But it does not assign 
the selected camera to a view pane or display video.

F2, F3, ON, OFF Cameras are assigned numerically 1–16 to the respectively number video. These controls display DX8000 video in 
the following divisions:

• F2/OFF: Single-division view

• F3/MOM: 4-division view

• AUX ON: 9-division view 

• AUX OFF: 16-division view

On the KBD300A keyboard, press the SHIFT button.

The LED indicator should be on.
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Working in Playback Mode
Recorded video can be played back one channel at a time on the DX8000. Like live video, recorded video is viewed from the camera view panels 
on the main screen. Refer to Understanding View Panes and Panels on page 26 for information on view panels. Only users with Standard User 
access and higher are allowed to view recorded video. 

This section describes how use the Playback mode and includes the following topics:

• Accessing Playback Mode on page 61 

• Assigning Cameras to View Panels on page 61 

• Playback On-Screen Display (OSD) on page 61 

• Playback Controls on page 62 

• Playback Timeline on page 64 

• Playing Back Video by Time on page 65

• Playing Back Video by Event on page 66

• Operating Playback Digital Zoom on page 67

• Viewing Video in the Deinterlaced Mode on page 90

• Viewing Live and Playback Video Simultaneously on page 90

ACCESSING PLAYBACK MODE
To access the Playback mode:

ASSIGNING CAMERAS TO VIEW PANELS
To assign a camera to a view panel:

1. Drag a camera from the Site tree onto a camera view pane.

2. Repeat this process for up to 36 cameras.

PLAYBACK ON-SCREEN DISPLAY (OSD)
The on-screen display for playback is identical to live view with the exception of a date/time field in place of the PTZ designator.

Figure 35.  Playback OSD

On the DX8000 toolbar, click Live.
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PLAYBACK CONTROLS
Use the playback controls to start playback, control direction, and adjust speed. Click  at any time to return to live view. 

The playback controls are hidden in the extended view mode. In this case, select the standard view mode to display the playback controls. 

To switch between the standard and extended view mode:

The following figure shows the DX8000 playback controls.

Figure 36.  Playback Controls

The following table describes the parts of the payback controls.

From the DX8000 menu bar, choose View > Extended View.

Table T.  Parts of the Playback Controls

Item Part Description

Frame-By-Frame 
Reverse

Each frame is displayed in reverse with each click of the Frame-by-Frame Reverse button.

Frame-By-Frame 
Forward

Each frame is displayed in the forward direction with each click of the Frame-by-Frame Forward button.

Fast Forward to 
End

Advances the bookmark to the end of the latest recorded video.

Play Forward Initiates normal playback of recorded video in the forward direction.

Stop Stops playback control activity and returns to the Live View mode.

Pause Pauses video playback in the forward or reverse direction.

Play Reverse Initiates normal playback of recorded video in the reverse direction.

Rewind to  
Beginning

Returns the bookmark to the start of the earliest recorded video.
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The following figure shows the DX8000 playback speed and volume controls.

Figure 37.  Playback Speed and Volume Controls

The following table describes the parts of the playback speed and volume controls.

Table U.  Parts of the Playback Speed and Volume Controls 

Item Part Description

Normal Playback speed is at normal rate.

Faster Playback speed is increased to a faster rate.

Slower Playback speed is reduced to a slower rate.

Louder Volume is increased to a higher level or decreased to a lower level.

Mute Volume is silenced.

�
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PLAYBACK TIMELINE
The playback timeline is used to select a day and time to begin playback. The timeline includes a horizontal slider that can be moved to select 
playback time over a 24-hour period. Time periods containing recorded video are represented as color-coded segments of the timeline. The 
following figure illustrates the timeline color-coding scheme.

 

Figure 38.  Playback Timeline

The following table describes the parts of the playback timeline control.

Table V.  Parts of the Playback Timeline Control 

Item Part Item Part

Currently displayed view panel Selected second

Total number of view windows Increase timeline detail

Site number Decrease timeline detail

Camera number Alarm recording

Camera name Normal recording

Selected date Motion detection recording

Selected hour Timeline slider

Selected minute Instant recording

00   01   02    03   04   05    06   07   08    09   10   11   12    13   14   15   16    17   18    19   20   21   22   23

Panel:      1/8 S03  C09 [Camera 9] 11-27-2003 05 00 56
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PLAYING BACK VIDEO BY TIME
This section describes how to play back video by time. The time is displayed in 24-hour clock format. You can select the time by moving the slider 
along the timeline.

This section includes the following topics:

• Starting Playback from a Specific Point in Time on page 65

• Understanding Instant Playback on page 65

STARTING PLAYBACK FROM A SPECIFIC POINT IN TIME

To start video playback from a particular point in time:

1. On the DX8000 toolbar, click . 

2. Select a camera by clicking it in the Site tree. You can also select the camera from a view pane if the camera appears in the panel.

3. In the Timeline section, do the following:

a. In the Date Selection drop-down box, select the day that you want playback to begin.

b. Use the spinner buttons to select the time.

4. Click  to begin viewing. 

Figure 39.  Date Selection Drop-down Box

UNDERSTANDING INSTANT PLAYBACK

The DX8000’s ability to perform instant playback of video is limited by a one-minute delay interval. The DX8000 has a built-in latency of 
approximately one minute between the time that video is captured and when it is written to the hard disk. This delay exists to ensure that video 
is accurately stored and that the DVR’s database is updated correctly.

The delay interval is not affected if the DX8000 is in the alarm or motion record mode. In this case, the pre-alarm or pre-motion time period does 
not become a factor in determining the delay interval.

To initiate an instant playback:

The user has the ability to view video that is just recorded. This video image resides in memory and has not yet been stored on the hard drive. 
The color of the timeline will be green. This is because the system cannot tell what the data characteristic is while the data resides in memory

For example, if this data is recorded from a camera configured to monitor motion, and there is no motion activity, the data will not be stored on 
the hard disk drive. 

On the playback control, click Instant Playback. The timeline is zoomed to the last two to three minutes of data. 
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PLAYING BACK VIDEO BY EVENT
Users with Standard User access and higher can search video by events, such as motion detection or alarm activation. A sensor event is identical 
to an alarm event.

To play back video recorded during an alarm or motion event:

1. On the DX8000 toolbar, click . 

2. From the DX8000 menu bar, choose View > Index View. The Event Type drop-down box is displayed. 

Figure 40.  Event Type Drop-down Box

3. Select a camera by clicking it in the Site tree.

4. In the Event Type drop-down box, select the day that you want playback to begin.

5. In the Event Type drop-down box, select the event type you want to view. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

6. Select an event from the listing.

7. On the playback control, click  to begin viewing. 
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OPERATING PLAYBACK DIGITAL ZOOM
Video playback can be zoomed using a control keypad or the mouse when the DX8000 is in the Playback or Search mode. In Playback mode, the 
on-screen PTZ feature is replaced with the mouse-activated digital zoom. Playback digital zoom is also available in Search mode. For information 
on the Playback mode, refer to Working in Playback Mode on page 61. For information on the Search mode, refer to Working in Search Mode on 
page 70.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

This section describes how to operate playback digital zoom, and includes the following topics:

• Zoom Using the Digital Zoom Control on page 67 

• Zoom Using the Mouse on page 68

• Panning a Zoomed Image on page 69

• Working in Playback Mode on page 61

• Working in Search Mode on page 70

ZOOM USING THE DIGITAL ZOOM CONTROL

The digital zoom feature is accessible when the DX8000 is in the Playback or Search mode. For information on the Playback mode, refer to 
Working in Playback Mode on page 61. For information on the Search mode, refer to Working in Search Mode on page 70.

To zoom using the digital zoom control: 

1. To place the DX8000 in the Playback or Search mode, do one of the following:

• On the DX8000 toolbar, click Live. 
• On the DX8000 toolbar, click Search.

2. Click  to start video playback.

3. Use the Digital Zoom control to zoom and pan video playback.

Figure 41.  Playback Digital Zoom Control

From the DX8000 menu bar, choose View > Extended View.
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The following table describes the parts of the Digital Zoom control.
 

ZOOM USING THE MOUSE

The DX8000 allows you to use the mouse to drag a selection region (rectangle) around a specific area of a pane to zoom in and out. A small 
rectangle about 0.25 inches (6.4 mm) square provides a x6 zoom factor. As the selection area increases in size, the zoom in/out factor decreases: 
x5, x4, x3, x2, and x1.

• If you use the mouse to select an area about 0.25 inches (6.4 mm) in size, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x6. In this case, the selected viewing area is zoomed to the largest size.
– If zooming out, the zoom factor is at x6. In this case, the selected viewing area is zoomed to the original size.

• If you use the mouse to select the entire pane, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x1. In this case, the selected viewing area is slightly enlarged. You would have to perform many 

zoom in operations to arrive at the largest zoom size.
– If zooming out, the zoom factor is at x1. In this case, the selected viewing area is slightly reduced. You would have to perform many 

zoom out operations to arrive at the original size.

• You can also use the hand tool and the mouse scroll wheel to zoom in and out.

The zoom factor is displayed in the upper-right corner of the pane. The effective zoom in factor is displayed after the zoom operation is 
performed. The effective zoom out factor is not displayed.

To zoom using the mouse:

1. To place the DX8000 in the Playback or Search mode, do one of the following:

• On the DX8000 toolbar, click Live. 
• On the DX8000 toolbar, click Search.

2. Click  to start video playback.

3. Do the following:

a. To zoom in, click and drag the mouse diagonally in a downward direction to your right.

Table W.  Parts of the Digital Zoom Control  

Item Part Description

Zoom In Allows you to magnify the entire pane. Click the Zoom In button to magnify to the next preset magnification 
level (x1–6). 

Zoom Out Allows you to reduce to the previous preset magnification. Click the Zoom Out button to reduce to the 
previous magnification level.

Pan Left Allows you to move the magnified playback image to the left.

Pan Right Allows you to move the magnified playback image to the right.

Pan Up Allows you to move the magnified playback image up.

Pan Down Allows you to move the magnified playback image down.

Zoom Restore Allows you to return the zoomed image to the original size.
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.

Figure 42.  Zoom In Using Mouse

b. To zoom out, click and drag the mouse diagonally in an upward direction to your left. 

Figure 43.  Zoom Out Using Mouse

PANNING A ZOOMED IMAGE

This section describes how to use the hand tool and mouse wheel to zoom in and out.

To pan a zoomed portion of video within the view panel: 

1. To place the DX8000 in the Playback or Search mode, do one of the following:

• On the DX8000 toolbar, click Live. 
• On the DX8000 toolbar, click Search.

2. Right-click within the view panel. The mouse pointer now resembles a hand.

3. Click and drag the mouse using the left mouse button in the direction you want to move the video image. 

4. Right-click again to return to zoom mode.
 

Figure 44.  Panning Zoomed Video with the Mouse
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Working in Search Mode
The DX8000 Series DVR supports four video search methods: index, thumbnail, POS, and pixel. For information about the user access level 
required to search video data, refer to Definition of User Access Levels on page 173.

To enter the Search mode:

This section describes how to use the Search mode and includes the following topics:

• Search Window on page 71 

• Displaying a Deinterlaced Image in the Search Mode on page 73 

• Index Video Search on page 73 

• Thumbnail Video Search on page 74 

• POS Search on page 76

• Pixel Video Search on page 87 

• Working with Special View and Search Methods on page 90

On the DX8000 toolbar, click Search.
70 C624M-C (5/06)



SEARCH WINDOW
The search window facilitates access to the search capabilities of the DX8000. Available search methods include index, thumbnail, and pixel. 
Each search method allows users with Standard User access and higher to locate video data instantly using criteria such as time of day or 
changes in window pixels.

As in Playback mode, digital zoom, export, and print features are available in Search mode. For more information, refer to Operating Playback 
Digital Zoom on page 67, Exporting Video on page 91, and Printing Images on page 101. 

The following figure shows the parts of the DX8000 window in the Search mode.

Figure 45.  DX8000 DVR Search Mode Window
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The following table describes the parts of the DX8000 window in the Search mode.

Table X.  Parts of the DX8000 Window in Search Mode 

Item Part Description

Index Search Allows users to search motion and alarm events listed in the event index panel. 

Thumbnail Search Allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a 
series of thumbnail images. Each thumbnail represents the first image recorded during a specified period of 
time. Thumbnails can be expanded and collapsed to represent hourly, 10-minute, and 1-minute intervals.

POS Search Allows users to search ATM/POS transaction text data. 

Pixel Search Allows users to search any 24-hour period of recorded video automatically for changes in screen pixels. 

View Window Displays search video, image thumbnails, and pixel grid.

Site tree Facilitates top-down, hierarchical management of DX8000 resources, such as servers, cameras, alarms, and 
relays.

Event Index Panel Lists motion and alarm events over the 24-hour time period specified in the playback timeline. 

Select All Check Box Enables playback for all visible view panels when selected. If this check box is deselected, only the selected 
channel will play. This control is only available while using Index Search.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows user to select a date and time for 
playback. 

Playback Control Panel Provides buttons to control video playback. Includes forward and reverse playback and still image. Also 
provides controls for playback speed and volume.

Playback Zoom Control Provides access to digital zoom features during playback.

Search Control Provides access to the index, thumbnail, POS, and pixel search controls.
72 C624M-C (5/06)



DISPLAYING A DEINTERLACED IMAGE IN THE SEARCH MODE
If you are searching for an image that is recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s 
Deinterlaced Image option is used to enhance the image during a search activity. 

To search video using the deinterlaced option:

1. On the menu bar, click View > Display deinterlaced image.

2. On the DX8000 toolbar, click . The DX8000 is placed in the Search mode.

INDEX VIDEO SEARCH
Index search allows a user to search video by events, such as motion detection or alarm activation. Events are listed chronologically and by type. 
To ensure that the proper camera channel is selected, check the camera information box above the playback timeline or verify that the desired 
view panel is framed with a thin red outline.

To search video by motion or alarm events:

1. On the DX8000 toolbar, click .

2. On the DX8000 Search control, click .

3. On the DX8000 toolbar, click a view panel division button. 

4. From the Site tree, drag the camera channel you want to search onto one of the view panels. 

5. Click the view panel of the channel you want to search. 

6. From the drop-down box on the playback timeline, select the day you want playback to begin.

7. Select the event type you want to view from the event type drop-down box. 

Only events recorded for the selected camera are listed in the index. A sensor event is identical to an alarm event. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

8. Select an event from the index.

9. Verify that the “Select all” check box is selected. Deselecting the “Select all” check box will disable playback for all view panels except the 
channel being searched.

The DX8000 allows you to view playback on multiple cameras in addition to the camera being searched. This feature is valuable if you want 
to examine a variety of views recorded at the time a certain event was detected.

10. Click  to begin viewing. 
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Figure 46.  DX8000 DVR Index Search Screen

THUMBNAIL VIDEO SEARCH
Thumbnail search allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a series of thumbnail 
images. Each thumbnail represents the first image recorded during a specified period of time. Thumbnails can be expanded and collapsed to 
represent hourly, 10-minute, and 1-minute intervals.

To search video visually using thumbnail images:

1. On the DX8000 toolbar, click . 

2. On the DX8000 Search control, click .

3. Select a camera from the Site tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Click the thumbnail for the hour you want to begin searching.

6. Click  to change the thumbnail time range to shorter intervals, or click  to change the thumbnail time range to longer intervals.

• Click  to change from 1-hour intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-minute intervals.

• Click  once to change from 1-minute intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-hour intervals.

7. Click the thumbnail of the interval you want to search.

8. Click  to view video.

�
�

�

	

�


 �
74 C624M-C (5/06)



Double-clicking a thumbnail image will enlarge the image and begin playback.

9. Click  to return to thumbnail images.

Figure 47.  DX8000 DVR Thumbnail Search Screen
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POS SEARCH
The DX8000 allows a user to search any 24-hour period of recorded POS video and data. To record ATM/POS video and data, the ATM/POS 
devices and DX8000 must first be connected and configured as follows:

• Physically connect the ATM/POS devices to the DX8000.

• Set up camera-to-ATM/POS device linking. 

• Configure the DX8000 ATM/POS settings for each attached ATM/POS device.

• Start an ATM/POS transmittal and verify that the DX8000 is receiving the ATM/POS video and data.

For information about setting up the DX8000 for ATM/POS applications, refer to the following sections:

• Linking Relay Outputs to ATM/POS Events on page 114

• Linking Cameras to Record in Response to ATM/POS Events on page 117

• Linking Presets and Patterns to ATM/POS Events on page 120

• Setting Up ATM/POS Device Communication Ports on page 149

• Setting UP ATM/POS Device Properties on page 150

This section describes how to use the POS search feature and includes the following topics:

• Understanding the POS Search View on page 77

• Searching and Displaying POS Data by Device Name on page 80 

• Searching by POS Transaction Number on page 82 

• Searching for All Transactions with Exceptions on page 83

• Searching for Transactions that Satisfy Specific Exceptions on page 84 

• Searching for Transactions by Line Item on page 85 

• Searching for Transactions by Action Code on page 86
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UNDERSTANDING THE POS SEARCH VIEW

To enter the POS Search mode:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

The following figure shows the parts of the POS search view. 

Figure 48.  POS Search View
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The following table describes the parts of the POS search view.

Table Y.  Parts of the POS Search View 

Item Part Description

Date Date range for which to search the video and data. 

Time Time range based on a 24-hour time period for searching POS events.

Transaction 
Information

Allows POS search by transaction information options as follows:

• Device Name: The ATM/POS device linked to a specific camera. In this case, selecting a 
camera linked to an ATM/POS device automatically inserts the name of the ATM/POS device in 
the Device Name box. 

• Transaction Number: A number assigned by the ATM/POS device that is printed on the sales 
are transaction receipt.

Data Information Allows POS search by data information options as follows:

• Transaction with Exception Only: Finds all transactions for which an exception is defined.

• Line Item: Allows you to search POS data by a specific transaction line item, based on the 
following guidelines: 

– Line item entries are not case sensitive. Enter lower or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Enter the first few characters of the first word appearing in the transaction and the 

wildcard. As an example, for a line item containing the entry “small orange juice,” enter 
sma*. The search returns all transactions that contain the word “small.”

– Enter the first few characters of the second word in a transaction and the wildcard. As an 
example, for a line item containing the entry “small orange juice,” enter: ora*. The search 
returns all transactions that contain the word “orange.”

– Search by abbreviation. An example, for a line item containing the entry “Soda 6-pk,” enter 
6-pk. The search returns all transactions that contain the abbreviation “6-pk.”

• Action Code: A two-letter abbreviation designating a specific action code. For information 
about action codes, refer to Setting UP ATM/POS Device Properties on page 150.

• Exception Code: A predefined transaction filter used to detect a specific data structure within 
the ATM/POS transaction data. For information about exceptions, refer to Setting Up ATM/POS 
Exceptions on page 155.

Start and Stop Start: Initiates a search event.

Stop: Ends a search event.
78 C624M-C (5/06)



POS Search Table Lists the data discovered in response to the POS options selected for the transaction and data 
information.

• Channel Number: From 1–16.

• Device Name: By default, ATM/POS01 to ATM/POS16. The device name can be changed.

• Transaction Number: Number assigned by the ATM/POS device to the transaction data.

• Date/Time: Date and time transaction is recorded.

• Exception: Yes if an exception filter is active for the transaction data has an exception. No if 
the transaction does not have an exception filter.

The transaction and data information are based on the ATM/POS configuration settings derived from 
the following:

• Data format 

• ATM/POS exceptions 

• Exception action codes

For information about setting up ATM/POS transaction and data options, refer to Setting UP ATM/
POS Device Properties on page 150.

Data Window Area where recorded transaction data is displayed.

Data Overlay Box The function is not supported at this time.

Video Window Area where live and playback (recorded) video is viewed. Playback video is started at the date and 
time specified for the respective transaction data as shown in the POS Search table. The DX8000 
playback controls are used to view playback video.

Table Y.  Parts of the POS Search View (Continued)

Item Part Description
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SEARCHING AND DISPLAYING POS DATA BY DEVICE NAME

You can perform a general search for POS transaction data record for a particular ATM/POS device and its associated camera. Use the date and 
time, and ATM/POS device name as the search criteria. The search results contain all POS transactions recorded for that device according to the 
specified date and time.

Searching POS Data by Device Name

To search POS transaction data by ATM/POS device name:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed. 

3. To select a channel, in the DX8000 Site tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this case, 
the Device Name text box is deselected.

4. Select the date and time for the POS search event as follows:

a. Select the Start date.

b. Select the End date.

c. Select the End time.

d. Select the Start time.

5. In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

6. Verify that the ATM/POS device name displayed in the Device Name text box is the correct device for the search.

7. Click Start Search. The POS Search Table is populated with POS transaction data.

Figure 49.  POS Transaction Search by Device Name
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Displaying POS Data Discovered by Device Name

To display a POS transaction and its associated video:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. Perform a POS search by device name. For information about performing a search by ATM/POS device name, refer to Searching POS Data 
by Device Name on page 80. 

4. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

5. On the playback control, click Play. The video recorded for the selected POS transaction is played back and is displayed in the Video 
window.

6. Use the playback control to stop or pause playback, reverse playback, and so forth.

Figure 50.  Display a POS Transaction Search by Device Name

�

��
C624M-C (5/06) 81



SEARCHING BY POS TRANSACTION NUMBER

The DX8000 allows you to search for a POS event by transaction number. In this case, you must specify the channel, date, and a time window in 
which the transaction is recorded. 

To search for an POS event by transaction number:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a device name, do one of the following:

• In the DX8000 Site tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Select the date and time that you want to search for the transaction number.

5. In the Transaction Information section, click the check box to select Transaction Number. The Transaction Number text box is available.

6. In the Transaction Number text box, type the transaction number.

7. Click Start Search. If the channel, date, time, and transaction number are valid, the POS transaction is displayed in the POS Search Table.

8. In the POS Search Table, click a transaction entry. The transaction data is displayed in the Data window.

9. On the playback controls, click Forward Playback. The video recorded for the transaction is displayed in the Video window.

Figure 51.  Searching an POS Event by Transaction Number
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SEARCHING FOR ALL TRANSACTIONS WITH EXCEPTIONS

The DX8000 allows you to search for transactions that meet conditions defined by one or more exceptions. In this case, you must configure your 
search criteria based on the following: 

• Channel: Camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: Date and time window within which the transactions were recorded.

To use an exception to search transaction data, the exception must be created first, before recording the transaction data. If the transaction data 
is recorded before the exception filter is defined, the exception filter will not find the data structure within the transaction data.

To search for only POS events by transaction with exception:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8000 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, click check box to select Transaction with Exception Only. The Exception Code check box is available. 

6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

8. On the playback controls, click Forward Playback. The video recorded for the transaction is displayed in the Video window.

Figure 52.  Searching for Transaction with Exception Only Events
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SEARCHING FOR TRANSACTIONS THAT SATISFY SPECIFIC EXCEPTIONS

The DX8000 allows you to search for and display ATM/POS transactions that meet conditions as defined by one or more exceptions. You can use 
specific exception codes to define the search criteria. To use an exception to search transaction data, the exception must be created first, before 
recording the transaction data. If the transaction data is recorded before the exception filter is defined, the exception filter will not find the data 
structure within the transaction data.

The search criteria is based on the following: 

• Channel: Camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: Date and time window within which the transactions were recorded.

• Exception code: Predefined transaction filter used to detect a specific data structure within the ATM/POS transaction data.

To search for transactions that meet specific exceptions:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8000 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Transaction with Exception Only. The Exception Code check box is available. 

b. Click the check box to select Exception Code. The Exception Code text box is available.

c. Type the exception code in the text box.

6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

Figure 53.  Transactions that Satisfy Specific Exception Filters
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SEARCHING FOR TRANSACTIONS BY LINE ITEM

The DX8000 allows you to search for and display ATM/POS transactions that contain a unique line item. Use the asterisk (*) as a wildcard 
character to substitute for zero or more characters. 

The search criteria is based on the following: 

• Channel: Camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: Date and time window within which the transaction(s) were recorded.

• Line item: The line item has the following guidelines:
– Line item entries are not case sensitive. Enter lower or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Enter the first few characters of the first word appearing in the transaction and the wildcard. As an example, for a line item containing 

the entry “small orange juice,” enter sma*. The search returns all transactions that contain the word “small.”
– Enter the first few characters of the second word in a transaction and the wildcard. As an example, for a line item containing the entry 

“small orange juice,” enter: ora*. The search returns all transactions that contain the word “orange.”
– Search by abbreviation. An an example, for a line item containing the entry “Soda 6-pk,” enter 6-pk. The search returns all transactions 

that contain the abbreviation “6-pk.”

To search for transactions that contain a unique line item:

1. On the DX8000 toolbar, click .

2. On the Search control, click .The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8000 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Line Item. The Line Item text box is available. 

b. Type the name of the line item in the text box.

6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
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Figure 54.  Transactions that Contain a Unique Line Item

SEARCHING FOR TRANSACTIONS BY ACTION CODE

The DX8000 allows you to search for and display ATM/POS transactions by action code. To use an action code to search transaction data, the 
action code must be created first, before recording the transaction data. If the transaction data is recorded before the action code is defined, the 
action code will not find the data structure within the transaction data.

The search criteria is based on the following: 

• Channel: Camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: Date and time window within which the transaction(s) were recorded.

• Action code: Special two-character filter that defines a specific transaction event.

To search for transactions by action code:

1. On the DX8000 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

a. In the DX8000 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

or

b. Do the following:

(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Action Code. The Action Code drop-down box is available. 

b. In the Action Code drop-down box, select an action code. For information about action codes, refer to Using Action Codes on 
page 155.
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6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
 

Figure 55.  Searching Transactions by Action Code

PIXEL VIDEO SEARCH
The DX8000 allows a user to search any 24-hour period of recorded video automatically for changes in screen pixels. This feature can be 
configured to identify motion events even when motion detection has not been enabled on a camera.

This section describes how to search video by changes in screen pixels and includes the following topics:

• Searching Video Based on Changes in Screen Pixels on page 87

• Viewing a Video Thumbnail on page 89

SEARCHING VIDEO BASED ON CHANGES IN SCREEN PIXELS

DX8000 pixel video search is accomplished in two steps:

• Searching recorded video for changes in screen pixels. 

After the search has been completed, the DX8000 displays a series of thumbnails below the search grid. Each thumbnail contains the first 
image of recorded video for the specified date and time range period. 

NOTE:  A pixel search might not detect obvious movement. 

• Viewing the thumbnails. 

For information on how to view the video thumbnail, refer to Viewing a Video Thumbnail on page 89.

To search video by analyzing changes in screen pixels:

1. On the DX8000 toolbar, click .

2. On the Search control, click .

3. Select a camera from the Site tree.

4. From the drop-down box, select the date on which you want to begin your search.
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5. Select the start and end times to define your search range.

6. Using your mouse, highlight areas on the grid that you want to search for pixel changes.

• Hold down the left mouse button and drag to select areas.
• Hold down the right mouse button and drag to clear areas.

7. Adjust the pixel sensitivity threshold. Moving the slider to the left decreases sensitivity and moving it to the right increases sensitivity.)

8. Click Start and then wait for the progress line on the status bar to return to Ready.

9. Use the  icon to show and hide the pixel grid for a clearer view in the search screen.

Figure 56.  Pixel Search Screen
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VIEWING A VIDEO THUMBNAIL

After the search has been completed, a series of thumbnails appear on the screen below the search grid. Each thumbnail contains the first image 
of recorded video for the listed time period.

• Double-clicking a thumbnail will cause it to begin playing.

• Click  and  to move backwards and forwards through thumbnails. 

To view a video thumbnail:

1. Click a thumbnail. The thumbnail’s search parameters (date and time) are displayed below the search grid. The thumbnail’s search start 
time is a few seconds ahead of the search start time you entered.

Figure 57.  Thumbnail Images Marking Pixel Changes

2. To locate playback at the start of the first image, click . The video scene is played back and displayed in reverse. 

3. Click  to pause the video play back when the beginning of the first recorded is reached.

4. Click . Playback starts and the video scene is displayed.

5. Click  to remove the thumbnail results.

�
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WORKING WITH SPECIAL VIEW AND SEARCH METHODS
The DX8000 allows you to do the following:

• View video in the deinterlaced mode.

• View live and playback video simultaneously.

• View and search backed-up video. You must use the DX8000 Client application to view and search backed-up video. For more information, 
refer to the DX8000 Client Application Manual.

This section describes how to use special view and search methods and includes the following topics:

• Viewing Video in the Deinterlaced Mode on page 90 

• Viewing Live and Playback Video Simultaneously on page 90 

VIEWING VIDEO IN THE DEINTERLACED MODE

Images recorded at 4CIF at a low frame rate per second might move or tear. In this case, you can use the View menu’s Deinterlaced Image option 
to enhance the displayed image. In the deinterlaced mode, the DX8000 converts the recorded image and displays it at 2CIF resolution. The 
process removes one of the 4CIF interlaced fields (even or odd) from the 4CIF recorded image to arrive at 2CIF resolution for the displayed image. 
The original image is retained at the recorded 4CIF resolution. 

For exported images, the DX8000 provides a global option for enabling a deinterlacing filter. In this case, the selected channel’s image is 
exported at 2CIF resolution. This setting is effective for all channels and cannot be set for individual channels. For more information about 
enabling the denaturalizing filter, refer to Enabling the Deinterlacing Filter on page 94.

To view video using the deinterlaced option:

1. Click  to start video playback.

2. On the menu bar, click View > Display deinterlaced image.

VIEWING LIVE AND PLAYBACK VIDEO SIMULTANEOUSLY

The DX8000 allows simultaneous viewing of live and playback video from a single camera source.

To view live and playback video from the same camera:

1. On the DX8000 toolbar, click . 

2. Drag a camera from the Site tree to a view panel.

3. Click  to begin playback.

4. Drag the same camera from the Site tree onto a different view panel while video is playing.
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Exporting Video
Power Users and Administrators can export sections of prerecorded video to magnetic or optical media. The DX8000 must be in the Playback or 
Search mode to export video. You cannot access Export in Live mode. To export video or still images to a CD-R/RW or DVD-R/RW, you must have 
Nero® Express CD burning software version 6.3.1.25 installed on the DX8000 DVR.

This section describes how to export video and includes the following topics:

• Exporting Bookmarked Video Regions on page 91 

• Inserting and Removing a USB Flash Drive on page 93

• Enabling the Deinterlacing Filter on page 94

• Mapping and Disconnecting a Network Drive on page 94 

• Performing the Export on page 95

• Stopping an Export While in Process on page 100 

EXPORTING BOOKMARKED VIDEO REGIONS
You can bookmark multiple regions of video along the timeline for export. Bookmarked regions are designated with start point and end point 
bookmarks. Multiple regions can be bookmarked along a single 24-hour timeline, but only a single channel can be exported at a time. 
Bookmarked regions are listed in the Export Video dialog box at the time of export. 

The following figure shows the DX8000 bookmark controls.

Figure 58.  Bookmark Controls

The following table describes the bookmark controls.

Table Z.  Bookmark Controls

Button Command Description

Add Bookmark Does the following:

• Adds a red bookmark flag to mark the beginning of a start point.

• Adds a gray bar to indicate the range between the start point and end point.

Remove Bookmark Removes the selected bookmark.

Remove All  
Bookmarks

Removes all bookmarks.
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CREATING BOOKMARKS

To select a region to export:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Select a camera from the Site tree.

4. Locate the timeline slider at the beginning of the range you want to bookmark. 

You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

5. Click . A red bookmark flag appears on the timeline.
 

Figure 59.  Setting a Starting Bookmark

6. Locate the timeline slider at the end of the range you want to bookmark.

7. Click . The bookmark flag and the region between bookmarks turn gray.

Exporting a bookmarked region of video requires start and end bookmarks. If only one bookmark is set, video will not be marked for export.

8. Repeat steps 4 through 7 for each additional region you want to bookmark for that camera.

9. Click  if you are in Live mode, or proceed to step 8 if you are in Search mode.

10. Click  and follow the directions in Performing the Export on page 95.

CLEARING BOOKMARKS

This section describes how to clear bookmarks and includes the following topics:

• Clearing a Single Bookmark on page 92

• Clearing All Bookmarks on page 93

Clearing a Single Bookmark

To clear a single bookmark:

1. Select a bookmark flag from the timeline. The bookmark flag should change to a light green color.

2. Click  to remove the selected bookmark.

Figure 60.  Removing a Single Bookmark
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Clearing All Bookmarks

To clear all bookmarks:

INSERTING AND REMOVING A USB FLASH DRIVE
The DX8000 supports both USB 1.1 and USB 2.0 flash drives. To ensure data is not lost or corrupted when exporting data to a USB flash drive, 
follow the steps listed in Removing a USB Flash Drive on page 93.

This section describes how to insert and remove a USB device and includes the following topics:

• Installing a USB Flash Drive on page 93

• Removing a USB Flash Drive on page 93

INSTALLING A USB FLASH DRIVE

This section describes how to install a USB flash drive. To install a USB flash drive into the DX8000:

1. Insert the USB drive into the USB 2.0 port on the DVR’s front panel.

Figure 61.  Installing a USB flash drive

2. Wait five seconds while the DX8000 recognizes and automatically installs the device.

REMOVING A USB FLASH DRIVE

You can remove a USB device within the DX8000 environment. In this case, you do not have to exit to the Windows environment.

To remove the USB flash drive from the DX8000:

1. Click > File Unplug/Eject Hardware. The Unplug or Eject Hardware dialog box opens. 

2. Select the USB flash drive in the Hardware devices list.

3. Click Stop. The Stop a Hardware device dialog box opens.

4. Select the USB device.

5. Click OK.

6. Wait for the DX8000 to respond with a message stating that it is safe to remove the USB device from the DX8000. Removing a USB flash 
drive before the DX8000 acknowledges that it is safe to remove the USB device might result in lost or corrupted data.

7. Remove the USB flash drive. 

Click Remove All Bookmarks.

WARNING: Improperly removing a USB drive can cause data to be lost or corrupted.

�
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ENABLING THE DEINTERLACING FILTER
Images recorded at 4CIF at a low frame rate per second might move or tear. The DX8000 provides a global option for enabling deinterlacing 
filtering to enhance the exported image for 4CIF recorded channels. In this case, the exported image is converted to 2CIF resolution. This setting 
is effective for all channels, and cannot be set for enabling individual channels. For more information about the viewing video in the deinterlaced 
mode, refer to Viewing Video in the Deinterlaced Mode on page 90.

To enable the deinterlacing filter:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. From the Export Format area, select the “Enable deinterlacing filter” check box.
. 

Figure 62.  Enabling the Deinterfacing Filter from the Export Video Dialog Box

MAPPING AND DISCONNECTING A NETWORK DRIVE
You can export sections of prerecorded video to a network drive. The DX8000 allows you to map to or disconnect from a network drive. In this 
case, you must use the IP address of the target drive. The DX8000 allows you to use the host name of the target device. To do so, you must 
enable NetBIOS option in the Windows environment. You need to know what letters are already assigned to drives and the path to the folder you 
want to map.

This section describes how to map to and disconnect a network drive and includes the following topics:

• Mapping a Network Drive on page 94

• Disconnecting a Network Drive on page 95 

MAPPING A NETWORK DRIVE

To map a network drive: 

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode. Click . The Export Video dialog box opens.

3. Click Map NetDrv. The Map Network Drive dialog box opens asking for a drive letter and path.

4. In the Drive drop-down box, select a drive letter that is not being used.

5. Type the path in the Folder drop-down box; \\IP_address_of_server\folder_name is an example.

6. (Optional) Click the “Reconnect at logon” box if you do not want the mapped drive to remain connected each time you logon. 

7. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area. The mapped drive can now be 
accessed just like a local drive.
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Figure 63.  Export Video Dialog Box

DISCONNECTING A NETWORK DRIVE

To disconnect a network drive:

1. On the DX8000 toolbar, click . The DX8000 is in the Search mode.

2. Click . The Export Video dialog box opens.

3. Click Disconnect NetDrv. The Disconnect Network Drive dialog box opens.

4. Select the network drive that you want to disconnect.

5. Click OK. The drive is disconnected and removed from the Export Video dialog box Device area.

PERFORMING THE EXPORT
This section describes how to export data and includes the following topics:

• Starting an Export Process on page 95

• Changing a Bookmarked Time Range on page 97

• Assigning a Custom Export Video File Name on page 97

• Selecting the Export Format on page 98

• Exporting a Sequence of Still Images on page 99

• Finalizing an Export Process on page 99

• Stopping an Export While in Process on page 100

• Working with DX8000 Backed-Up Video on page 100

STARTING AN EXPORT PROCESS

To start the export process:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. Click the plus (+) sign next to a drive in the Device list. Available devices are indicated by a check box to the left of the device name.
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5. Select the check box of the desired device. If you choose a remote device, select the drive and folder path where you would like to store the 
exported file. You can also click the Browse button to access the file system for the appropriate folder. 

If your DX8000 is connected to a network that supports shared folders and drives, you can map a network drive from within the Export Video 
dialog box. For more information, refer to Mapping and Disconnecting a Network Drive on page 94.

The following table shows a listing of available devices.

6. Select the check box of the video time range you want to export. You can export multiple time ranges simultaneously. For more information, 
refer to Changing a Bookmarked Time Range on page 97.

7. Click in the File Name box, and then type the file name for each selected video time range. You can accept the default file name assigned to 
the time range. For more information, refer to Assigning a Custom Export Video File Name on page 97.

8. Select the export format. For more information, refer to Selecting the Export Format on page 98.

9. Click Export. 

Figure 64.  Exporting Selected Video

Table AA.  Available Backup Space

Type Description

Optical drives The DX8000 supports the following drives:

• CD-R

• DVD-R

Hard disk drives The hard disk drive can be any of the following:

• Local drives

• Remote drives

Removable drives USB flash drives

10.0.1.14
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CHANGING A BOOKMARKED TIME RANGE

To change a bookmarked time range or create a new time range to be exported:

1. Select the desired row in the Time Range table.

2. Double-click the Start Day field, and then use the spinner buttons to set the start date for the export.

The start days and times cannot be set later than end days and times.

3. Double-click the Start Time field, and then use the spinner buttons to set the start time for the export.

4. Double-click the End Day field, and then use the spinner buttons to set the end date for the export.

5. Double-click the End Time field, and then use the spinner buttons to set the end time for the export.

6. Select the check box next to each time range you would like to export.

Figure 65.  Export Time Range

ASSIGNING A CUSTOM EXPORT VIDEO FILE NAME

By default, the DX8000 assigns a file name to each time range. When the video channel selected is exported, the file is assigned the name 
appearing in the Name column.

 

Figure 66.  Default File Names

The default filename is constructed from the information displayed in the Start Day, Start Time, End Day, and End Time columns. 

To assign a custom file name for a time range:

1. Verify that the check box of the row you want to rename is selected.

2. Enter a file name for the file you want to export. (Export file names follow standard Windows file-naming conventions.)

3. Click Apply. The Apply button updates the Name field.

�� � � �
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Figure 67.  Renaming Export Time Ranges

SELECTING THE EXPORT FORMAT

The DX8000 allows you to select the export format. The following table shows the available export formats.

• Native format: When exporting video in the native format, the DX8000 embeds a digital watermark in the video stream for the purpose of 
authentication. Watermarking ensures that an image has not been edited or damaged after it has been recorded. The watermark is an 
encrypted, digital signature embedded in the video stream during the compression stage, protecting the video from the moment of creation. 
The DX8000 Viewer software is capable of reading a DX8000 watermark and verifying the originality of the video.

• AVI or ASF format: Video exported in AVI or ASF format can be viewed using standard viewer software such as Windows Media Player. 
When exporting video in the native format to a CD or DVD device, the DX8000 will automatically include the DX8000 Viewer application 
along with the video. This viewer is designed to play a variety of still image, video, and audio media formats, including the native DX8000 
format. The DX8000 Viewer application will automatically run each time a CD or DVD created by the DX8000’s export feature is inserted 
into a Windows-based PC. To ensure that the viewer software runs automatically after the disk has been inserted, verify that the auto-run 
feature of your PC’s optical drive has not been disabled.

To select the export format:

Table AB.  Export Formats

Format Description

AVI Saves video sequence as a standard Windows video format.

ASF Saves video sequence as a standard Windows media file.

Native Saves video sequence using DX8000’s proprietary compression format. Native format provides increased compression 
and smaller file sizes.

BMP Saves a still image file in standard Windows bitmap format. Only the first frame of the video sequence is saved.

JPEG Saves a still image file in JPEG format. Only the first frame of the video sequence is saved.

TIFF Saves a still image file in TIF format. Only the first frame of the video sequence is saved

From the Export Video dialog box, select the radio button of the file format you want to export. 

10.0.1.14
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EXPORTING A SEQUENCE OF STILL IMAGES

Still image formats export the first frame of a bookmarked region and then a single frame for each time interval until the number of images 
specified has been exported. For example, consider exporting a six-hour bookmarked region of video with an image count of 100 and a time 
interval of 3 seconds. The resulting export will include the first frame of the bookmarked region followed by 99 additional images taken at 
3-second intervals. The first exported image will be the first frame of the bookmarked region and the last image will be the frame taken at 
300 seconds into the bookmarked region.

To export a sequence of still images:

1. Select a still image format. Options are BMP, JPEG, and TIF.

2. Select the number of images (1 to 999) you want to save in the sequence.

3. Select the time interval between each saved image in the sequence. Options are as follows:

• Continuous
• 0.5 seconds
• 1 second
• 2 second
• 3 second
• 4 seconds
• 5 seconds

Figure 68.  Still Image Export Formats

FINALIZING AN EXPORT PROCESS

This section describes how to finalize an export process. The following guidelines are applicable:

• Audio export is available only with DX8000 native, AVI, and ASF video formats.

• Real Time setting applies only to DX8000 native, AVI, and ASF video formats.

• When the Real Time check box is selected, the DX8000 will export video so it can be played back in real time (30 fps) for the same length of 
time as the original recording. For example, if video was recorded at 1 fps, this means the DX8000 will insert 29 null frames for every 
1 frame of actual video. Thus, one minute of video recorded at 1 fps (60 frames total) will play back for one minute at 30 frames per second 
(60 frames of actual video interspersed with 1,740 null frames). If the Real Time check box is not selected, one minute of video recorded at 
1 fps will play back in two seconds in real time. Figure 69 illustrates the two video streams: 1) one padded with null frames to match the 
actual time duration and 2) another stream without null frames.
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Figure 69.  Real Time Versus Non-Real Time Export

To finalize the export process:

1. Make sure that the export media selected is inserted in the drive unit and that the drive is ready. 

2. In the Time Range table, click selection box for each backed-up video time range you want to export.

3. In the Export Format section, do the following:

a. Click the Audio Record check box to include recorded audio.

b. Click the Real Time check box to export video using standard clock time. 

4. Click Export to export video data.

STOPPING AN EXPORT WHILE IN PROCESS

Once an export operation has begun, a user can easily stop it by interrupting or canceling the operation from the Export menu on the main or 
search screens. Interrupting an export simply stops the progress of the export while keeping all video information stored up to that point intact. 
Canceling an export will delete any video data exported during the operation as well as ending the export itself.

This section describes how to stop an export process and includes the following topics:

• Retaining Video When Stopping an Export Process on page 100

• Deleting Video Data When Stopping an Export Process on page 100

Retaining Video When Stopping an Export Process

To halt an export that is in process while retaining video data stored to that point:

Deleting Video Data When Stopping an Export Process

To halt an export that is in process and delete any video data stored to that point:

WORKING WITH DX8000 BACKED-UP VIDEO

The DX8000 allows you to view and search backed-up video. Use the DX8000 server to back up video. You must use the DX8000 Client 
application to view backed-up video.

For more information about viewing backed-up video, refer to the section titled Viewing and Searching Backed-Up Video in the Client 
Applications Help or the Client Applications manual and Viewing Backed-Up Video on page 170.

From the DX8000 menu bar, choose Export > Interrupt Export.

From the DX8000 menu bar, choose Export > Cancel Export.
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Printing Images
The printing feature of the DX8000 produces a hard copy of the current on-screen image. A Windows-compatible printer must be installed to take 
advantage of the DX8000’s print feature. For information on installing a printer, refer to the installation manual that came with your unit.

The DVR must be placed in Playback or Search mode to use the print feature. Playback is paused once the print button is pressed. 

To print an image displayed in a pane:

1. Click  or .

2. Locate the video image you want to print. For more information on locating video, refer to Working in Playback Mode on page 61 and 
Working in Search Mode on page 70.

3. Click .

4. Click  to freeze the image for printing.

5. Click .

6. Click OK.

PRINTING IMAGES IN THE DEINTERLACED MODE
If you are printing images recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s Deinterlaced 
Image option is used to enhance the image for printing. 

To print an image using the deinterlaced option:

1. Click  or .

2. Locate the video image you want to print. Refer to Working in Playback Mode on page 61 and Working in Search Mode on page 70 for 
information on locating video.

3. Click .

4. Click  to freeze the image for printing.

5. Click  to print the image to a designated printer.
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Setting Up the DX8000
Only a single user with Administrator or Power User access is allowed to access a DX8000’s Setup mode box at one time. When connected to a 
network supporting multiple DVRs and/or clients, users with Administrator access override and block Power Users. If two users with the same 
access level attempt to enter Setup mode simultaneously, the DX8000 will allow access to setup features on a first-come, first-served basis. 
Unavailable setup options will be grayed-out.

This section describes the Setup Mode and includes the following topics:

• Accessing the Setup Mode on page 102

• Understanding the Setup Dialog Box on page 103

• Camera Setup on page 105

• Link Setup on page 111 

• Schedule Setup on page 122 

• Setting Up Network Properties on page 143 

• Data Backup Setup on page 164

• User Setup on page 171 

• Site Setup on page 177 

• System Setup on page 182 

• External Monitor Setup on page 191 

• Emergency Notification Setup on page 198 

• Emergency E-Mail Notification Setup on page 201 

ACCESSING THE SETUP MODE
The Setup Mode is accessed from the DX8000 toolbar by clicking the Setup icon. When clicked, the Setup icon opens the Setup dialog box in the 
DX8000 view panel. The major configuration categories are displayed on individual tabbed pages. Each configuration page contains all of the 
options and parameters for the respective function, that allow you to customize how the DX8000 operates for your particular application. Access 
a setup page by clicking its icon that is displayed on the right side of the view panel.

The Setup dialog box allows Administrators and Power Users access to the DX8000’s setup functions. However, only Administrators can define 
user names and passwords for new users.

To access the Setup Mode:

On the DX8000 toolbar, click Setup.

The Setup dialog box opens to the default Camera page.
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UNDERSTANDING THE SETUP DIALOG BOX
The Setup dialog box opens in the DX8000 view panel to the default Camera page. Excluding the video visible through the Camera page Motion 
Zone window, you do not see video from any of the other setup pages. You must exit the Setup dialog box to access the DX8000 functions in the 
main window.

The following figure shows the parts of the Setup dialog box.

Figure 70.  Parts of the DX8000 Setup Dialog Box
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The following table describes the parts of the Setup dialog box.

Table AC.  Parts of the DX8000 Setup Dialog Box 

Item Button Part Description

Camera Click the Camera icon to configure cameras. Available options are PTZ functions, motion detection, picture 
adjustment, audio, and video loss detection settings.

 

Linking Click the Linking icon to configure relays and alarms, associate relays and alarms with cameras, link 
relays to alarms, and link cameras to other cameras.

Schedule Click the Schedule icon to build custom recording schedules, set image resolution, frame rate, and image 
quality, and configure relay settings. 

Network Click the Network icon to set up the network configuration and communication port settings.

Backup Click the Backup icon to configure and perform backups.

User Click the User icon to add, delete, or change user accounts.

Site Click the Site Setup icon to add, delete, and configure additional DX8000 Series DVRs.

System Click the System icon to set up additional system options.

Ext. Monitor Click the Ext. Monitor icon to configure an additional display monitor. (This icon appears only if the 
optional display card has been installed.)

Notification Click the Notification icon to configure emergency agent and e-mail notification options.
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CAMERA SETUP
Depending on your system’s current configuration, up to 16 video cameras can be connected to a single DX8000. The following section illustrates 
basic camera configuration. You must be logged in as an Administrator or Power User to configure cameras.

This section describes how to setup the camera and includes the following topics: 

• Basic Camera Setup on page 105 

• Motion Detection Setup on page 107 

• Audio Setup on page 108 

• Applying Settings to all Cameras on page 111 

BASIC CAMERA SETUP

To set up camera picture and pan, tilt, and zoom (PTZ) options:

1. Do one of the following:

• On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

• If the Setup dialog box is already open, click . The Camera page is displayed.

2. In the Camera Properties section, do the following:

a. Select a camera from the drop-down box. (You can also select a camera from the Site tree by clicking on it.)

b. Select the Disable check box if you want to disable the camera.

c. Enter an optional new name for the camera. Camera names can be up to 32 characters long and can include spaces and special 
characters.

d. Set camera security level. Available security levels are as follows:

• None: Camera can be viewed by all users.
• Low: Camera can be viewed by all users except the Guest account.
• Medium: Camera can be viewed by users with Standard User access and higher.
• High: Camera can be viewed by users with Power User access and higher.

e. In the Protocol drop-down box, select the appropriate PTZ protocol for the camera, or select No PTZ if the selected camera does not 
support PTZ functions. Some of the supported protocol options are as follows:

• NO PTZ: Disables all PTZ functions for the current camera 
• PELCO-C: Coaxitron
• PELCO-D: Pelco proprietary
• PELCO-P: Pelco proprietary
• SAMSUNG (V2.0)
• PANASONIC
• VICON
• KALATEL

You must configure one of the RS-422/RS-485 PTZ ports for Spectra for Coaxitron to function. For more information, refer to Setting 
Up RS-422/RS-485 Communication Port Properties on page 150.

f. In the PTZ Locking Auto-timeout drop-down box, select an appropriate timeout value. Time out values can be set between 5 and 60 
seconds. The default value is 10 seconds.

Because the DX8000 Series DVR is designed to operate in a networked environment, it is possible that multiple users may attempt to 
simultaneously control the PTZ features of a single camera. To minimize potential conflicts, only one user at a time is allowed to 
control the PTZ features of a camera. PTZ control is made available on a first-come, first-served basis. Once a user gains control of a 
camera’s PTZ features, all other users are locked out and must wait until the controls for that device have been left idle for the amount 
of time configured for that camera as specified in the PTZ Locking Auto-timeout drop-down box.
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g. Set the selected camera address as follows:

(1) In the Dip Switch Address drop-down box, select an address from the available addresses. If the selected camera’s protocol is 
set to NO PTZ or PELCO-C, then the DIP Switch Address drop-down box is unavailable. In this case, the camera’s dip switch 
setting cannot be set using software. 

This option is available for cameras and protocols that support software-configurable addresses. Only one address can be 
assigned to any one camera. The DX8000 displays an error message if you attempt to assign the same address to different 
cameras. 

(2) To view the camera DIP switch address setting for all attached local cameras, click View. The DIP Switch Address View dialog 
box opens. The assigned DIP switch setting for all attached cameras is displayed.

3. In the Picture Adjustment section, adjust picture properties by moving sliders for Brightness, Contrast, Hue, and Saturation.

As you adjust the picture properties of a camera on the local DVR, changes will be reflected immediately in the view area near the top of 
the screen. Changes made to cameras at a remote site will not appear in the view area until you click Apply.

4. Click Default to return all picture property settings to the normal state.

You can click the Hide/Show button to clear the view area to get a better look at your picture property changes. Refer to step 2 in Motion 
Detection Setup on page 107.

5. Click Apply. 

Figure 71.  Camera Page
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MOTION DETECTION SETUP

Up to five motion detection profiles can be defined for each camera. When the DX8000 is scheduled to record motion detection, motion sensed 
in the selected zone will result in video data being recorded for that channel. Motion detection can also be used to trigger relays, PTZ presets, 
and recording on multiple cameras. Refer to Schedule Setup on page 122 and Link Setup on page 111 for more information. 

To define motion detection profiles for the selected camera:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. To set up the motion grid, do the following:

a. Select the motion zone (1-5) from the drop-down box.

b. Click the Hide/Show button to either hide or display the motion grid. 

c. Move the Number of Blocks slider to change the grid size of the motion overlay.

3. Define the area for motion detection as follows:

a. Click Clear All to remove the currently defined motion detection area.

b. Click Select All to enable motion detection for the entire viewable area.

c. Hold down the left mouse button and drag to select areas.

d. Hold down the right mouse button and drag to deselect areas.

4. In the Motion Detection section, move the Sensitivity slider to adjust motion sensitivity. Moving the slider to the left decreases motion 
sensitivity; moving the slider to the right increases sensitivity.

5. Click Apply.

Figure 72.  Camera Motion Detection Setup
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AUDIO SETUP

The DX8000 audio feature allows you to configure individual camera channels to listen to and record live audio. You can monitor live audio at a 
local server or listen to live audio from a remote DX8000 server or client system. You can play back audio recorded by a camera channel. 

To use the DX8000’s audio features, the optional DX8000-AUD audio card must be installed. You can determine if the audio card is installed by 
checking the Audio option status in the Channel Information section of the Camera page. The Audio status is one of the following:

• Not installed

• Installed (enabled)

The DX8000 compresses audio data to save space. In this case, recorded audio may not be of the same quality as live audio. Consult your Pelco 
sales representative for more information regarding the DX8000-AUD option.

To set up audio for a camera:

1. Do the following:

a. Install the optional DX8000-AUD audio card if necessary. For information about installing the optional DX8000-AUD audio card, refer 
to the DX8000 Installation manual.

b. Connect an audio input device (microphone) to the numbered DX8000-AUD audio card input for the camera channel being configured 
for live audio recording.

c. To hear live audio at the local server, connect head phones to the DX8000 audio output connector.

2. On the DX8000 toolbar, click Setup. The Setup dialog box opens to the Camera page. 

3. Check the Channel Information section to verify that the audio option is installed and available. 

4. In the Camera Properties section, select the camera channel you want to configure for live audio recording. 

5. In the Audio Settings section, verify that the Audio Disable check box is not selected.

6. Click Apply.

7. Verify that you can hear sound from the DX8000 audio output.
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LISTENING TO LIVE AUDIO 

The DX8000 audio feature allows you to listen to live audio at a local server or listen to live audio from a remote DX8000 server or client system. 
For information about setting up the DX8000 server to record and listen to live audio, refer to Audio Setup on page 108.

This section describes how to listen to live audio and includes the following topics: 

• Listening to Live Audio at a Local Server on page 109

• Listening to Live Audio from a Remote DX8000 System on page 109

Listening to Live Audio at a Local Server

To listen to live audio at the local server:

1. Connect head phones to the DX8000 audio output connector. For information about setting up the DX8000 server to record and listen to live 
audio, refer to Audio Setup on page 108

2. On the DX8000 toolbar, click Setup. The Setup dialog box opens to the Camera page. 

3. Check the Channel Information section to verify that the audio option is installed and available. 

4. In the Camera Properties section, select the camera channel that is configured for live audio recording. 

5. In the Audio Settings section, verify that the Audio Disable check box is not selected.

6. Click Apply.

7. Verify that you can hear sound from the DX8000 audio output.

8. On the DX8000 toolbar, click .

9. Drag a camera configured to record live audio from the Site tree onto a view pane. 

10. Verify that you can hear live audio.

Listening to Live Audio from a Remote DX8000 System

To listen to live audio at a remote DX8000 server or client system:

1. On the DX8000 toolbar, click Setup. The Setup dialog box opens to the Camera page. 

2. Check the Channel Information section to verify that the audio option is installed and available. For information about setting up the 
DX8000 server to record and listen to live audio, refer to Audio Setup on page 108

3. In the Camera Properties section, select the camera channel that is configured for live audio recording. 

4. In the Audio Settings section, verify that the Audio Disable check box is not selected.

5. Click Apply.

6. Verify that you can hear live audio. 

7. On the DX8000 toolbar, click .

8. Drag a camera configured to record live audio from the Site tree onto a view pane. 

9. Verify that you can hear live audio.
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CONFIGURING VIDEO LOSS DETECTION

You can configure the DX8000 to monitor each camera for the following events:

• Loss of synchronization: This event occurs if the data cable between the camera and DX8000 is disconnected (cable is cut or unplugged) 
or the camera looses power.

• Low level of video: This event occurs if the DX8000 detects a low level of video signal from the camera:
– The available light source for the camera (indoor/outdoor lightly) is greatly diminished. 
– The DX8000 data cable is disconnected.

You can adjust the operation time from 0:00 to 23:59. For example, if the start time is 6:00 and the end time is 18:00, a low video level event 
from 18:01 to 5:59 will not be detected. The low video level detection time option is only available when the low level of video option is 
selected.

The DX8000 allows you to select the loss of synchronization and low level of video option independently. 

• The PTZ camera and multiple relay output can be mapped to a video loss event. 

• Multiple cameras can be configured to record in response to a video loss event.

• The DX8000 can be configured to use emergency agent notification. In this case, the last available video image when the event occurred is 
sent to the designated remote client. If no image exist, then the system attaches a red colored pane to the e-mail. The red pane contains 
the text “Video Loss.” For information about setting up emergency notification, refer to Emergency Notification Setup on page 198.

• The DX8000 can be configured to send an e-mail notification in response to a video loss event. In this case, the last available video image 
when the event occurred is attached to the e-mail. If no image exist, then the system attaches a red colored pane to the e-mail. The red 
pane contains the text “Video Loss.” For information about setting up emergency notification, refer to Emergency E-Mail Notification Setup 
on page 201.

• The record icon turns purple indicating a video loss recording, regardless of which schedule is setup. The video loss utility is constantly 
running in the background. If a schedule is not available, then it the record icon defaults to purple. If the DX8000 loses feed, video on that 
channel is recorded. 

To set up video loss detection:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. In the Video Loss Detection section, do one or both of the following:

• Click the “Loss of synchronization” check box to select loss of synchronization option.
• Click the “Low level of video” check box to select low level of video option and do the following:

(1) In the Low Level of Video Detection Operation Time section, set the start time.

(2) In the Low Level of Video Detection Operation Time section, set the end time.

3. Click Apply.

Figure 73.  Video Loss Detection
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APPLYING SETTINGS TO ALL CAMERAS

If you want to keep the changes you made to options and parameters on the Camera page, you must click Apply. If you attempt to leave the 
Camera page, the system will display a message box, prompting you to apply, not apply, or cancel the changes.

To apply camera configuration options to all attached cameras:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. Perform the camera configuration.

3. In the Apply to All Cameras section, select the check boxes for Protocol, Camera Security, Picture Adjustment, Motion Detection, Audio 
Settings, and Video Loss that you want to apply to all cameras.

4. Click Apply to All Cameras.

5. Click Apply.

LINK SETUP
This section describes how to use the Link page to set up the following:

• Relay and alarm settings

• Event-relay link settings

• Event-recording link settings

• Event-PTZ link settings

This section includes the following topics:

• Configuring Basic Relay and Alarm Settings on page 111 

• Linking Relay Outputs to External Events on page 113 

• Linking PTZ Presets and Patterns to External Events on page 118 

• Linking Cameras to Record in Response to External Events on page 115 

CONFIGURING BASIC RELAY AND ALARM SETTINGS

The DX8000 can support up to 16 alarm inputs and relay outputs. Eight-channel DVRs include 8 alarm and 8 relay terminals while sixteen-channel 
DVRs include 16 of each. 

This section describes how to configure basic relay and alarm settings, and includes the following topics:

• Understanding How Relays and Alarms React to a Power Outage on page 111

• Configuring DX8000 Basic Relay and Alarm Settings on page 111 

• Configuring Basic Relay Operating Properties on page 112 

• Configuring Basic Alarm Input Operating Properties on page 112

Understanding How Relays and Alarms React to a Power Outage

The DX8000 server might experience an external AC power outage and impact how the DX8000 relay and alarm features function.

• Power outage: Relays configured as NO are closed if the DX8000 is server is shut down by a power outage or if the AC cord is unplugged. 

• Power button: Relays configured as NO are closed if the DX8000 power button is pressed and held down. 

In the scenarios above, a relay will remain closed as long as the DX8000 is powered down. In this case, alarms or sirens connected to the relays 
might produce a false alert. 

Configuring DX8000 Basic Relay and Alarm Settings

To access the Link page to program alarms and relays:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera setup page.

2. Click . The Link page is displayed. 
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Configuring Basic Relay Operating Properties

To configure basic relay operating properties:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. Click . to display the Link page. 

3. In the Relay Settings section, do the following:

a. In the Relay Channel drop-down box, select the relay you want to configure.

b. In the Relay Name text box, enter an optional new name for the relay. Relay names can be up to 32 characters long and can include 
spaces and special characters.

You can also rename sites, cameras, alarms, and relays from the Site tree by clicking twice slowly on each object’s name.

c. In the Relay Type section, click the NO/NC button to toggle the default output type for each relay (NO – normally open or NC – 
normally closed).

4. Click Apply.

Figure 74.  Relay and Alarm Settings Page: Relay Settings Section

Configuring Basic Alarm Input Operating Properties

Most applications will not require you to change relay and alarm settings from their default states.

To configure basic alarm input operating properties:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. Click  to display the Link page.

3. In the Alarm Settings section, do the following:

a. In the Alarm Channel drop-down box, select the Alarm you want to configure.

b. In the Alarm Name text box, enter an optional new name for alarm. Alarm names can be up to 32 characters long and can include 
spaces and special characters.

You can also rename sites, cameras, alarms, and relays from the Site tree by clicking twice slowly on each object’s name.

c. In the Alarm Type section, click the NO/NC button to toggle the default output type for each alarm (NO – normally open or NC – 
normally closed).

4. Click Apply.
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Figure 75.  Relay and Alarm Settings Page: Alarm Settings Section

LINKING RELAY OUTPUTS TO EXTERNAL EVENTS

This section describes how to link relay outputs to external events, such as motion, alarm, ATM/POS, and video loss events. This section includes 
the following topics:

• Linking Relay Outputs to Motion Events on page 113 

• Linking Relay Outputs to Alarm Events on page 114

• Linking Relay Outputs to ATM/POS Events on page 114

• Linking Relay Outputs to Video Loss Events on page 115

To access the Event-Relay Link Settings page:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page opens to the Relay and Alarm Settings page.

3. Click the Event-Relay Link Settings tab.

Linking Relay Outputs to Motion Events

To set relay outputs to activate in response to motion detection events:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera channel from the Camera Channel drop-down box.

b. Click the button of each relay you want to link to the selected camera.

You can also drag relays onto cameras in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 76.  Event-Relay Link Settings: Motion Detection Link Settings Section
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Linking Relay Outputs to Alarm Events

To set relay outputs to activate in response to an alarm event:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the Alarm Link Settings section, do the following:

a. Select an alarm channel from the Alarm Channel drop-down box.

b. Click the button for each relay you want to link to the selected alarm.

You can also drag relays onto alarms in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 77.  Event-Relay Link Settings: Alarm Link Settings Section

Linking Relay Outputs to ATM/POS Events

To set relay outputs to activate in response to an ATM/POS event:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. Click the button for each relay you want to link to the selected ATM/POS address.

You can also drag relays onto ATM/POS devices in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 78.  Event-Relay Link Settings: ATM/POS Link Settings Section

4b

4a

4b

4a
114 C624M-C (5/06)



Linking Relay Outputs to Video Loss Events

To set relay outputs to activate in response to a video loss event:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button for each relay you want to link to the selected Video-Loss Channel. 

5. Click Apply.

Figure 79.  Event-Relay Link Settings: Video-Loss Link Settings Section

LINKING CAMERAS TO RECORD IN RESPONSE TO EXTERNAL EVENTS

Multiple cameras can be configured to begin recording in response to detected motion, alarm, ATM/POS transaction, and video loss events. 
This section describes how to link cameras to record in response to these events and includes the following topics:

• Linking Cameras to Record in Response to Motion Events on page 116 

• Linking Cameras to Record in Response to Alarm Events on page 116

• Linking Cameras to Record in Response to ATM/POS Events on page 117

• Linking Cameras to Record in Response to Video Loss Events on page 117 
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Linking Cameras to Record in Response to Motion Events

To link multiple cameras to record in response to motion detection events:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Motion Record Link Settings section, do the following:

a. Select a camera from the Motion Source Camera drop-down box.

b. Click the button of each camera you want to begin recording when motion is detected by the source camera.

5. Click Apply.

Figure 80.  Event-Relay Link Settings: Video-Loss Link Settings Section

Linking Cameras to Record in Response to Alarm Events

To link multiple cameras to record in response to a single alarm input:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Alarm Record Link Settings section, do the following:

a. Select an Alarm channel from the Alarm Channel drop-down box.

b. Click the button of each camera you want to begin recording when the source alarm is triggered.

5. Click Apply.

Figure 81.  Event-Recording Link Settings: Alarm Record Link Settings Section
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Linking Cameras to Record in Response to ATM/POS Events

To link multiple cameras to record in response to an ATM/POS event:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the ATM/POS Record Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS address drop-down box.

b. Click the button of each camera you want to begin recording in response to an ATM/POS event. 

5. Click Apply.

Figure 82.  Event-Recording Link Settings: ATM/POS Record Link Settings Section

Linking Cameras to Record in Response to Video Loss Events

To link multiple cameras to record in response to a video loss event:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Video-Loss Record Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button of each camera you want to begin recording in response to a video loss event. 

5. Click Apply.

Figure 83.  Event-Recording Link Settings: Video-Loss Record Link Settings Section

4b

4a

4b

4a
C624M-C (5/06) 117



LINKING PTZ PRESETS AND PATTERNS TO EXTERNAL EVENTS

The DX8000 can be configured in such a way that motion, alarms, ATM/POS transactions, and video loss events detected by one camera will 
result in the repositioning of another. Similarly, alarm inputs can be set to trigger camera-positioning presets. Only a single preset or pattern can 
be linked to a camera.

This section describes how to link PTZ presets and patterns to motion and alarm events and includes the following topics:

• Linking PTZ Presets and Patterns to Motion Events on page 118

• Linking PTZ Presets and Patterns to Alarm Events on page 119 

• Linking Presets and Patterns to ATM/POS Events on page 120

• Linking Presets and Patterns to Video Loss Events on page 121 

Linking PTZ Presets and Patterns to Motion Events

To link two cameras so that motion detected on one results in the repositioning of another:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera from the Camera Channel drop-down box. (This camera will be the motion source.)

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to motion detected by the source camera.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to motion detected by the source camera:
(1) Click the Linked Camera Preset radio button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1–150) for the camera to move to.

• To force a PTZ pattern to be activated in response to motion detected by the source camera:
(1) Click the Linked Camera Pattern radio button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 84.  Event-PTZ Link Settings: Linking Presets and Patterns to Motion Events
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Linking PTZ Presets and Patterns to Alarm Events

To link an alarm input to a camera so that activation of the alarm results in a repositioning of that camera:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Alarm Record Link Settings section, do the following:

a. Select an alarm from the Alarm Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an alarm input detected by the source alarm.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to an alarm input detected by the source camera:
(1) Click the Linked Camera Preset radio button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1–150) for the camera to move to.

• To force a PTZ pattern to be activated in response to alarm input detected by the source camera:
(1) Click the Linked Camera Pattern radio button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 85.  Event-PTZ Link Settings: Linking Presets and Patterns to Alarm Events
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Linking Presets and Patterns to ATM/POS Events

To link an ATM/POS input to a camera so that the detected ATM/POS event results in a repositioning of that camera:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an ATM/POS input detected by the source ATM/POS device.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to an ATM/POS input detected by the source camera:
(1) Click the Linked Camera Preset radio button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1–150) for the camera to move to.

• To force a PTZ pattern to be activated in response to ATM/POS input detected by the source camera:
(1) Click the Linked Camera Pattern radio button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 86.  Event-PTZ Link Settings: Linking Presets and Patterns to ATM/POS Events
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Linking Presets and Patterns to Video Loss Events

To link a video loss event to a camera so that the detected video loss event results in a repositioning of that camera:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera channel from the Video-Loss Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to a video loss event detected by the source camera.

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to a video loss event detected by the source camera:
(1) Click the Linked Camera Preset radio button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1–150) for the camera to move to.

• To force a PTZ pattern to be activated in response to video loss input detected by the source camera:
(1) Click the Linked Camera Pattern radio button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 87.  Event-PTZ Link Settings: Linking Presets and Patterns to Video Loss Events
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SCHEDULE SETUP
The DX8000 provides extensive scheduling capabilities. Flexible recording schedules can be established for daily, weekday, weekend, or 
individual day recording. Recording time can be broken up into increments of one-half hour, and each increment can be scheduled to record 
continuously or in response to an alarm, motion, or ATM/POS event. Users with Power User access and higher can create recording schedules.

This section describes how to setup recording schedules and includes the following topics:

• Accessing the Schedule on page 122 

• Setting Up the Camera Recording Mode on page 124 

• Creating Yearly Recording Schedules on page 126 

• Creating Monthly or Multiple-Day Recording Schedules on page 128 

• Creating Single-Day Schedules on page 129

• Editing Schedules on page 131 

• Working with Custom Camera Settings on page 133 

• Configuring the Frame Rate on page 135 

• Setting Up Advanced Relay Output on page 138 

ACCESSING THE SCHEDULE

To access the scheduling features of the DX8000:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

The following figure shows the Schedule page.

Figure 88.  Schedule Page
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The following table describes the parts of the Schedule page.

Table AD.  Parts of the Schedule Page 

Item Part Description

Schedule Type  
Drop-down Box

Selects the type of schedule. Options are as follows:

• All days – Seven days a week

• Weekdays – Monday through Friday, with the exception of any day assigned in Custom mode

• Weekends – Saturday and Sunday, with the exception of any day assigned in Custom mode

• Custom Mode – Any day, such as a holiday

Recording Schedule 
Profile 

Allows you to do the following:

• Select and apply an existing schedule profile.

• Create and save a new profile.

• Change an existing profile.

• Delete an existing profile. 

Calendar Displays current schedule profile in accordance with the schedule type selected (All Days, Weekdays, 
Weekends, or Custom Mode).

Start and End Date 
Markers

Sets the start and end dates for a custom schedule.

Record Mode Selects a recording mode to be applied to a camera. Options are as follows:

• Normal

• Motion 

• Alarm

• ATM/POS

Channel Scheduling 
Panel 

Allows the assignment of recording modes across individual camera channels over a 24-hour period.

Camera Settings 
Panel

Allows custom settings to be applied to individual cameras for each recording mode.

Apply Saves current schedule.

Frame Rate  
Configuration 

Allows configuration of channel resolution and frame rates.

Configure Relays Allows configuration of relays that have been linked to cameras and alarms. 

Instant Recording Enables or disables selection of instant recording from the View menu.
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SETTING UP THE CAMERA RECORDING MODE

The DX8000 allows you to schedule each camera to record in a single or multiple modes across a 24-hour timeline. Users with Power User access 
or higher can schedule video recording for one or more cameras. Use the Record Mode section near the bottom of the Schedule page to configure 
the recording mode for each camera.

This section describes how to schedule a recording mode and includes the following topics:

• Scheduling a Record Mode on page 124

• Clearing a Scheduled Recording on page 125

Scheduling a Record Mode

To schedule a record mode for one or more channels:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the check box for the record mode you want to apply to a channel.

• Normal 
• Motion
• Alarm
• ATM/POS

The following table describes the record modes.

4. Click and drag to highlight the time periods and channels where you want the recording mode to apply.

Drag the mouse diagonally to highlight periods across multiple camera channels simultaneously.

5. Click Apply.

Figure 89.  Filling In Recording Blocks in Schedule Grid

Table AE.  Record Modes 

Mode Color Description

Normal Green Continuous recording. 

Motion Blue Recording is triggered during the selected time block if a motion event is detected in the camera’s predefined 
motion field. For information on motion detection, refer to Motion Detection Setup on page 107.

Alarm Red Recording is triggered during the selected time block when an alarm is activated. At least one alarm must be 
linked to the camera for this option to work. For information on alarms, refer to Linking Alarm Inputs to a Camera 
on page 33.

ATM/POS Yellow Recording is triggered during the selected time block if an ATM or POS event is detected in the camera’s 
predefined ATM/POS field. For information on ATM/POS detection, refer to Linking Cameras to Record in 
Response to ATM/POS Events on page 117.
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Clearing a Scheduled Recording

The DX8000 Schedule feature allows you to do the following:

• For one or multiple channels, clear scheduled recording times for a specific record mode at the same time. You can select one channel or 
you can drag and select a group of channels. For example, you can drag and select the recording times for channel 1, 2, 3, 4...16. However, 
the system does not allow you to select random channels from the list. For example, you are not allowed to select channel 1, 2, and 4. 
Notice that in this list, camera 3 is not selected.

• For one or multiple channels, you can clear the scheduled recording times for all record modes simultaneously. 

• You can select and clear recording times periods in increments of 30 minutes to 24 hours.

This section describes how to clear a scheduled recording and includes the following sections:

• Clearing Recording Times for a Specific Record Mode on page 125

• Clearing Recording Times for All Record Modes on page 126

Clearing Recording Times for a Specific Record Mode

To clear the scheduled recording times for a specific record mode for one or more channels:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click a record mode check box to select the specific record mode.

4. Right-click and drag to highlight the time periods and channels that you want to clear recording times.

5. Release the right mouse button.

The highlighted recording times are cleared.

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 90.  Clearing Recording Times for a Specific Record Mode
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Clearing Recording Times for All Record Modes

To clear the scheduled recording times for all record modes:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click a record mode check box to deselect the record mode. No record mode is selected.

4. Right-click and drag to highlight the time periods and channels that you want to clear recording times.

5. Release the right mouse button.

The highlighted recording times are cleared.

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 91.  Clearing Recording Times for All Record Modes

CREATING YEARLY RECORDING SCHEDULES

The DX8000 allows you create and save various recording schedules. This section describes how to create yearly recording schedules and 
includes the following sections:

• Creating a Yearly Recording Schedule on page 126 

• Scheduling Individual Days Using the Year View on page 127 

• Copying Schedule Attributes to a Different Day on page 127

Creating a Yearly Recording Schedule

Year View allows a user to customize recording schedules for individual days. Year View displays daily recording schedules in a calendar format. 
The calendar displays one year’s worth of daily recording schedules. The scheduling period begins in the current month.

• Days circled in red have been assigned weekday, weekend, or everyday recording schedules.

• Days circled in blue have been assigned a custom recording schedule.

• Days without circles denote that no recording has been scheduled for that day.
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Scheduling Individual Days Using the Year View

To schedule individual days using the Year View:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Year View tab. The Year View page is displayed.

4. Click the day you want to schedule.

Figure 92.  Calendar Date Selection

5. Using your mouse, select the recording modes and times for each channel you want to schedule. For information on selecting a recording 
mode, refer to Setting Up the Camera Recording Mode on page 124.

6. Repeat steps 2 and 3 for each additional day you want to schedule.

7. Click Apply.

Copying Schedule Attributes to a Different Day

To copy the schedule attributes of one day and apply them to a different day:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Right-click the calendar day you want to copy.

4. Select Copy from the quick-menu.

Figure 93.  Year View Calendar Quick-Menu

5. Right-click the day on the calendar you want to apply the copied schedule attributes.

6. Select Paste from the quick-menu.

7. Click Apply.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the quick-menu.
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CREATING MONTHLY OR MULTIPLE-DAY RECORDING SCHEDULES

Unlike schedules set in the Year View, Month View schedules are recurrent. Schedules can be set for subsequent weekdays, weekends, every 
day, or a single day. 

This section describes how to create a monthly or multiple-day schedule and includes the following topics:

• Creating Multiple-Day Schedules on page 128

• Creating Single-Day Schedules on page 129

Creating Multiple-Day Schedules

To create a recording schedule to recur indefinitely:

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. Select All days, Weekday, or Weekends from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. In the New File Name text box, enter a new filename for the profile. 

The profile file name follows the standard Windows file-naming conventions.

7. Click OK.

8. Using your mouse, select the recording modes and times for each camera you want to schedule. For information on camera scheduling, 
refer to Setting Up the Camera Recording Mode on page 124.

9. Click Save.

10. Click Apply.

11. Click the Apply button at the bottom of the Schedule page.

Figure 94.  Month View Page: Multi-Day Schedule
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Creating Single-Day Schedules

This section describes how to create a single-day schedule and includes the following topics:

• Working with Single-Day Schedules on page 129 

• Copying and Applying Schedule Attributes on page 130

Working with Single-Day Schedules

Custom Mode schedules are defined for single days only. A custom-scheduled day can be set to recur on the same day of every month or the 
same day every year.

To set the DVR to record on a specific day: 

1. From the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. Select Custom Mode from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. Enter a new file name for the profile.

The profile file names follow the standard Windows file-naming conventions.

7. Click OK.

8. Select Once Per Month or Once Per Year.

9. Select the date range for the custom schedule.

a.  Set the start date with the Start spinner buttons.

The start date cannot be set later than the end date.

b. If you want the schedule to recur indefinitely, deselect the Finish on End Date check box.

c. Set the end date with the End spinner buttons.

10. Click the date on the calendar you want to schedule.

11. Select the recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera Recording Mode on page 124 
for instructions.

12. Click Save.

13. Click Apply.

14. Click the Apply button at the bottom of the screen.
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Figure 95.  Month View Page: Single-Day Schedule

Copying and Applying Schedule Attributes

To copy the schedule attributes of one day and apply them to a different day:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Right-click the calendar day you want to copy.

4. Select Copy from the quick-menu.

Figure 96.  Month View Calendar Quick-Menu

5. Right-click on the calendar day to which you want to apply the copied schedule attributes.

6. Select Paste from the quick-menu.

7. Click the Apply button at the bottom of the screen.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the quick-menu.
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EDITING SCHEDULES

This section describes how to edit a schedule to change its profile or delete a schedule and includes the following topics:

• Changing an Existing Schedule Profile on page 131 

• Deleting an Existing Schedule Profile on page 132

Changing an Existing Schedule Profile

To change a profile:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All Days
• Weekdays
• Weekends
• Custom Mode

5. Select the schedule profile from the drop-down box.

6. Using your mouse, assign new recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera 
Recording Mode on page 124 for instructions.

7. Click Save.

8. Click Apply.

9. Click the Apply button at the bottom of the screen.

Figure 97.  Month View Page

�

�

�

�
	

�




C624M-C (5/06) 131



Deleting an Existing Schedule Profile

To delete a schedule profile:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All days 
• Weekdays
• Weekends
• Custom Mode

5. In the drop-down box, select a profile that is different from the one you want to delete. (This step is necessary because you cannot delete a 
schedule profile that is currently active.)

6. Click Apply.

7. In the drop-down box, select the profile that you want to delete.

8. Click Delete.

9. Click Apply.

Figure 98.  Month View Page
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WORKING WITH CUSTOM CAMERA SETTINGS

This section describes how to configure customized camera settings and includes the following topics:

• Configuring Custom Camera Settings on page 133 

• Examples of Custom Camera Settings on page 134 

Configuring Custom Camera Settings

Each camera can be configured with custom recording settings.

To customize camera settings for normal, motion, alarm, or ATM/POS recording:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the plus (+) sign next to a camera in the Site tree.

4. Select a recording mode from one of the following options:

• Normal
• Motion
• Alarm
• ATM/POS

5. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

6. Adjust the parameters in the camera settings section.

7. Click OK.

8. Click Apply.

Figure 99.  Custom Camera Settings Panel
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Examples of Custom Camera Settings

The DX8000 allows you configure customized camera settings for following recording modes:

• Normal

• Motion

• Alarm

• ATM/POS

The following figure shows camera settings for the supported modes.

Figure 100.  Examples of Custom Camera Settings

The following table describes the settings for the supported modes.

Table AF.  Camera Settings for the Supported Recording Modes 

Normal Motion Alarm ATM/POS

Image Resolution* Image Resolution* Image Resolution* Image Resolution*

Frame Rate* Frame Rate During Motion* Frame Rate During Alarm* Frame Rate During ATM/POS*

Image Quality**  
(Best, High, Normal,  
Low, Lowest)

Pre-Motion Frame Rate Pre-Alarm Frame Rate Pre-ATM/POS Frame Rate

Pre-Motion Image  
Quality** (Best, High,  
Normal, Low, Lowest)

Pre-Alarm Image  
Quality** (Best, High,  
Normal, Low, Lowest)

Pre-ATM/POS Image  
Quality** (Best, High,  
Normal, Low, Lowest)

Motion Image Quality**  
(Best, High, Normal,  
Low,  
Lowest)

Alarm Image Quality**  
(Best, High, Normal, Low,  
Lowest)

ATM/POS Image Quality**  
(Best, High, Normal,  
Low, Lowest)

Pre-Motion (1-60 sec) Pre-Alarm (1-60 sec) Pre-Event (1-60 sec)

Post-Motion (1-180 sec) Post-Alarm (1-180 sec) Post-Event (1-180 sec)

   *This field appears for information purposes only. To change this setting, refer to Configuring the Frame Rate on page 135.
**Image quality is a function of video compression. Higher quality video images require larger file sizes.

Normal Motion Alarm ATM/POS
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CONFIGURING THE FRAME RATE

The DX8000 can record at frame rates up to 480 images per second (ips) by National Television System Committee (NTSC) standards and 400 ips 
by Phase Alternating Line (PAL) standards. 

This total frame rate capacity is distributed among eight or sixteen cameras, depending on the configuration of your unit. Resolution and frame 
rate values can be assigned evenly among all cameras or can be configured independently for individual cameras. Frame rate values can also be 
customized according to recording mode type (normal, alarm, or motion). 

Two setup modes are provided to allow Power Users and Administrators to configure recording frame rates on the DX8000. All cameras are 
optimized to provide 30 ips frame rates at 320 x 240 resolution for NTSC (352 x 288 resolution for PAL). Basic mode allows changes to be made in 
the frame rates available to each camera, while resolution values must remain constant. Advanced mode allows users to change both frame rate 
and resolution settings. 

This section describes how to configure the frame rate and includes the following topics:

• Accessing the Frame Rate Configuration Dialog Box on page 135 

• Setting the Basic Frame Rate on page 135 

• Setting the Advanced Frame Rate on page 136

• Understanding the DX8000 Frame Rate Calculations on page 138

Accessing the Frame Rate Configuration Dialog Box

To access the Frame Rate Configuration dialog box:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

Setting the Basic Frame Rate

The DX8000 Series DVR is optimized to provide sixteen cameras of continuous video recording with a frame rate of 30 ips at a resolution of 
320 x 240 (NTSC). Basic mode allows only frame rate adjustments to be made. Access the Frame Rate Configuration dialog box to set the basic 
frame rate. For information on accessing the Frame Rate Configuration dialog box, refer to Accessing the Frame Rate Configuration Dialog Box on 
page 135.

To set frame rate values for cameras in Basic mode: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

4. Select the radio button of the recording mode you want to configure. Options are as follows:

• Normal
• Motion
• Alarm
• ATM/POS

5. Using the slider, select a frame rate from 1 to 30 ips for the desired camera.

The eight-camera DVRs only have eight sliders.

6. Repeat steps 1 and 2 for each camera you want to configure.

7. Click OK.

8. Click Apply at the Schedule page.
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Figure 101.  Frame Rate Configuration Dialog Box

Setting the Advanced Frame Rate

Both resolution and frame rate settings can be adjusted using the Advanced Frame Rate dialog box. Access the Frame Rate Configuration dialog 
box to set the advance frame rate. For information on accessing the Frame Rate Configuration dialog box, refer to Accessing the Frame Rate 
Configuration Dialog Box on page 135.

To set recording resolution and frame rates for each channel: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Frame Rate Configuration dialog box, click Advanced. The advanced frame rate configuration controls are displayed.

4. Select the radio button of the recording mode you want to configure. Options are as follows:

• Normal
• Motion
• Alarm
• ATM/POS

5. Select resolution values for individual channels from the drop-down boxes. The following table describes the available resolution values.

Setting a resolution value for one recording mode sets the resolution value for all modes. For example, setting resolution to 640 x 480 in 
Motion recording mode will change the resolution to 640 x 480 in Normal and Alarm recording modes as well.

Table AG.  Resolution Values 

Video Format NTSC PAL

CIF 320 x 240 352 x 288

2CIF 640 x 240 704 x 288

4CIF 640 x 480 704 x 576

2CIF 720 x 240 720 x 288

4CIF 720 x 480 720 x 576
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6. Using the Maximum Frame Rate Settings sliders, set the maximum frame rate for each resolution.

Setting the maximum frame rate for a resolution will impose a limit on how high frame rates can be set on individual channels using that 
resolution. In certain cases, setting a lower maximum frame rate for a particular resolution may free up resources to be used by channels 
set at another resolution. In any case, frame rates cannot be set for any channel or resolution beyond the availability calculated by the 
DX8000.

7. To set a global frame rate for all channels of a particular resolution type, move the slider under Global Frame Rate Settings. Select a frame 
rate from 1 to 30 ips according to the available capacity for that resolution.

8. To set the frame rate for individual channels, use the sliders in the top portion of the screen. Select a frame rate from 1 to 30 ips according 
to the available capacity for that channel.

9. Click Default to set the Maximum Frame Rate Settings values back to their factory defaults.

10. Click OK.

11. Click Apply when you return to the Schedule Setup screen.

Figure 102.  Advanced Frame Rate Configuration Screen
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Understanding the DX8000 Frame Rate Calculations

The DX8000 uses a complex algorithm to calculate the amount of recording resources available for each channel. This calculation takes into 
account factors such the number of enabled cameras, whether uniform or mixed resolution values are used, recording type (continuous, alarm, or 
motion), and the frame rate settings of enabled channels. The resulting calculations provide the operator with a margin of available frame rate 
capacity to distribute among the recorder’s channels. This margin of frame rate capacity, or “headroom,” is presented to the user as color-filled 
sections of the frame rate sliders. White areas on the slider represent frame rate capacity that is not available to that channel. In certain cases, 
adjusting the available frame rates of one channel or resolution type may free up capacity for other channels. The following figure illustrates 
available and unavailable frame rate capacity.

Figure 103.  Example of Frame Rate Capacity

The following table describes available and unavailable frame rate capacity.

SETTING UP ADVANCED RELAY OUTPUT

Relays work much like switches. When triggered, relays can activate external devices, such as sirens, light fixtures, and door locks. The DX8000 
Series DVR allows Administrators and Power users to link relays to cameras and alarms. Up to 20 seconds of delay can be set from the moment 
an event is triggered to the time when a relay is activated.

Make sure you have linked relays to the appropriate cameras and alarm inputs before attempting to configure them. For instructions on linking 
alarms and relays, refer to Linking Alarm Inputs to a Camera on page 33 and Linking Relay Outputs to Alarm Inputs on page 33.

This section describes how to setup advanced alarm and motion relay output and includes the following topics:

• Configuring Advanced Motion-Activated Relay Output on page 139 

• Configuring Advanced Alarm-Activated Relay Output on page 140 

• Configuring Advanced ATM/POS-Activated Relay Output on page 141 

• Configuring Advanced Video Loss-Activated Relay Output on page 142

Table AH.  Frame Rate Capacity

Item Description

Available frame rate capacity

Unavailable frame rate capacity

� �
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Configuring Advanced Motion-Activated Relay Output

To configure a motion relay output:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Motion tab.

5. Configure each relay that is linked to a camera:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box. 

6. Click Save.

7. Click Exit.
 

Figure 104.  Linking Relays to Motion Detection

The following table describes the available options.

Table AI.  Motion-Activated Relay Settings

Option Result

Disable Relay will not activate when the motion is detected.

Follow Event Relay will activate at the exact same time motion is detected.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after motion has been detected.

� 5a5a

5b
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Configuring Advanced Alarm-Activated Relay Output

To configure an alarm relay output:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Alarm tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box. 

Figure 105.  Linking Relays to Alarms

The following table describes the available options.

Table AJ.  Alarm-Activated Relay Settings

Option Result

Disable Relay will not activate when the alarm is triggered.

Follow Event Relay will activate at the exact same time the alarm is triggered.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the alarm has been triggered.

� 5a
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Configuring Advanced ATM/POS-Activated Relay Output

To configure an ATM/POS-activated relay output:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the ATM/POS tab if it is not already selected.

5. Configure each relay that is linked to an ATM/POS:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box.

Figure 106.  Linking Relays to ATM/POS

The following table describes the available options.

Table AK.  ATM/POS-Activated Relay Settings

Option Result

Disable Relay will not activate when the ATM/POS event occurs.

Follow Event Relay will activate at the exact same time the ATM/POS event occurs.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the ATM/POS event occurs.

� 5a5a
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Configuring Advanced Video Loss-Activated Relay Output
To configure an advanced video loss-activated relay output:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Video Loss tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box.

Figure 107.  Linking Relays to Video Loss

The following table describes the available options.

Table AL.  Video Loss-Activated Relay Settings

Option Result

Disable Relay will not activate when a video loss event occurs.

Follow Event Relay will activate at the exact same time the video loss event happens.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the video loss event occurs.
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SETTING UP NETWORK PROPERTIES
The DX8000 networking capability allows you to network up to five DX8000 together. You can configure such networking options as follows:

• Configuring the DX8000 for Network Access

• Setting Up DHCP

• Setting Up a Static IP Address

• Setting Up TCP/IP and Bandwidth Throttle

• Setting Up DNS/WINS

• Setting Up COM1 and COM2 Port Properties

This section describes how to set up DX8000 network communication and includes the following topics:

• Configuring the DX8000 for Network Access on page 143

• Setting Up TCP/IP and Bandwidth Throttle on page 145 

• Accessing Network Information on page 146 

• Setting Up DNS/WINS on page 146

CONFIGURING THE DX8000 FOR NETWORK ACCESS

Using the TCP/IP protocol, up to five DX8000 Series DVRs can be networked together for remote viewing and management. In addition, up to five 
simultaneous PC, web, and mobile clients can connect to each DVR. The DX8000 Series DVR supports both static IP addressing and dynamic 
addressing through Dynamic Host Configuration Protocol (DHCP). Consult your network administrator for more information on IP address 
configuration.

The system must be turned on and connected to a secured, private network, and you must be logged in with either Power User or Administrator 
access to configure network software settings. You must reboot the DVR for any network configuration changes to take effect.

This section describes how to setup network access and includes the following topics:

• Setting Up DX8000 Network Access on page 143 

• Setting Up DHCP on page 144 

• Setting Up a Static IP Address on page 144

Setting Up DX8000 Network Access

To begin the network setup process:

1. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click . The Network page is displayed.

3. Click the Network tab if it is not already visible.

4. Enter a new name for your DVR in the Site Name field. (Site names can be up to 30 characters in length. The default site name is DX8000.)

5. Enter a unique System ID for your DVR in the System ID field. (System IDs must start with a letter, must be 15 characters or less, and cannot 
include spaces or special characters.)

Your DVR’s site name is used to identify your system to clients and other DX8000 servers. Your DVR’s system ID is used to uniquely identify 
your system on a local area network (LAN). System IDs are required to prevent possible conflicts with other network devices.

6. Set up the Dynamic Host Configuration Protocol (DHCP) or static IP options. For information on setting up DHCP or static IP addressing, refer 
to Setting Up DHCP on page 144 or Setting Up a Static IP Address on page 144.
C624M-C (5/06) 143



 

Figure 108.  Network Setup Page

Setting Up DHCP

Your network must support DHCP and an active DCHP server must be present for dynamic addressing to work. If you select DHCP and your 
network does not include an active DHCP server, the IP address settings will default to addresses in the 169.254.x.x range. Consult your network 
administrator for more information. 

Access the Network page to set up the DHCP options. For information on accessing the Network page, refer to Setting Up DX8000 Network 
Access on page 143.

To configure the DVR to acquire a dynamic IP address through DHCP:

1. In the Network page, click the check box labeled Obtain An IP Address Automatically (DHCP).

2. Click Apply.

Setting Up a Static IP Address

The DX8000 allows you to set up a static IP address. This information can be obtained from your network administrator.

Access the Network page to set up the static IP address. For information on accessing the Network page, refer to Setting Up DX8000 Network 
Access on page 143.

To set up a static IP address:

1. In the Network page, verify that the Obtain An IP Address Automatically (DHCP) check box is not selected. 

2. In the IP Address box, enter a unique IP address (for example, 10.10.0.170). The last three digits must be different for each recorder (for 
example, 171, 172, 173, and so forth).

3. In the Subnet Mask box, enter the subnet mask (for example, 255.0.0.0 is the default).

4. In the Default Gateway box, enter the gateway address (the IP address of the default router on your immediate network segment).

5. Click Apply.

� ��
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SETTING UP TCP/IP AND BANDWIDTH THROTTLE

The DX8000 uses the TCP/IP networking protocol to communicate over LAN and WAN networks. TCP/IP uses logical network ports to organize 
data transmissions and to ensure that data packets are delivered to the proper application. For example, e-mail is traditionally delivered through  
TCP/IP port 25 and web pages through port 80. 

The following table describes the ports assigned to direct video and control information into and out of the DX8000. You should keep port 
numbers set at their default values unless there is a known conflict with your existing network infrastructure. Consult your network administrator 
before changing any port information on the DX8000.

Access the Network page to set up the TCP/IP DHCP and bandwidth throttle options. For information on accessing the Network page, refer to 
Setting Up DX8000 Network Access on page 143. Consult your network administrator before assigning or changing port numbers. Make sure that 
the ports are not blocked internally but are protected from external threats by a firewall. Client and server ports must be identical.

To configure the base port and software upgrade port:

1. If necessary, in the DX8000 Base Port box, enter a new base port number (9002 is the default). 

2. If necessary, in the Software Upgrade Port box, enter a new software upgrade port (9003 is the default).

3. If necessary, in the Information Port box, enter a new information port (9005 is the default).

4. To set the network bandwidth throttle to limit the amount of network resources allocated to client connections, drag the network bandwidth 
throttle slider to the desired value. (Client bandwidth can be adjusted from a minimum of 256 Kbps to a maximum of 10 Mbps in increments 
of 256 Kbps.)

5. Click Apply.

Table AM.  TCP/IP Ports Used by the DX8000

Port Number User Changeable Description

9002 Yes Base port for transmission of video, audio, and interface data

9003 Yes Software upgrades

9004 Yes Emergency agent notifications

9005 No Information port 

13900 No Ping port
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ACCESSING NETWORK INFORMATION

Access the Network page to view DX8000 network settings. For information on accessing the Network page, refer to Setting Up DX8000 
Network Access on page 143. 

To access network information, such as IP and default gateway addresses:

1. In the Network page, click Network Information. The IP Configuration information box appears.

2. Click OK to return to the Network page.

Figure 109.  IP Configuration Information Box

SETTING UP DNS/WINS

The DX8000 allows you to set up DNS or WINS services, if your network supports these services. Access the Network page to configure DX8000 
DNS/WINS services. For information on accessing the Network page, refer to Setting Up DX8000 Network Access on page 143.

To set up DNS/WINS: 

1. In the Network page, click the DNS/WINS tab. The DNS/WINS page is displayed.

2. Do one of the following:

• If you are using dynamic IP addressing through a DHCP server, click the “Obtain DNS/WINS info from DHCP” check box.
• If you are using static IP addressing, provide the following information in the appropriate fields. This information can be obtained from 

your network administrator.
(1) Primary DNS server IP address

(2) Secondary DNS server IP address

(3) Primary WINS server IP address

(4) Secondary WINS server IP address 

3. Click Apply to update the configuration.
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SETTING UP PORT AND DEVICE COMMUNICATION PROPERTIES
The system must be powered on and you must be logged in as a Power User or Administrator to configure communication port settings. Refer to 
the instructions that came with your peripheral device for correct settings. 

This section describes how to set up port and device communication properties and includes the following topics:

• Understanding the Port/Device Page on page 147 

• Setting Up ATM/POS Device Communication Ports on page 149 

• Setting Up RS-422/RS-485 Communication Port Properties on page 150

• Installing or Updating Device Protocols on page 163

UNDERSTANDING THE PORT/DEVICE PAGE

This section describes the Port/Device page. The following figure shows the Port/Device page.

Figure 110.  Port/Device Page
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The following table describes the parts of the DX8000 application window.

The following table lists the ports and the associated serial data communication standard they support.

• For COM1 and COM2: RS-232 is the default serial data standard.

• For Port 1 to 4: RS-422 and RS-485 are the available serial data standards.

Table AN.  Parts of the DX8000 Application Window 

Item Part Description

Port Communications port drop-down box, where you select the port for connecting a device to the DX8000. 
The available choices are as follows:

• COM1: Uses RS-232 serial data standard. 

• COM2: Uses RS-232 serial data standard. 

• Port 1 to 4: Uses either RS-422 or RS-485 serial data standard.

Device Attached device drop-down box, where the type of device is selected to be interfaced to the DX8000 through 
the communication port.

Configure Device configuration button that, when clicked, opens the Device Configuration dialog box. The Device 
Configuration dialog box performs two functions, depending on the type of device selected.

• For the KBD300A and dome devices, only displays device configuration information. 

• For ATM/POS devices, allows you to configure ATM/POS device options and parameters for the 
selected device. 

Install Protocol installation button that, when clicked, opens the Protocol Install dialog box. The Protocol Install 
dialog box allows you to do the following:

• View the current device protocols already installed.

• Update the device protocols.

Interface Mode Interface mode drop-down box that allows you to select the serial data standard for the selected device. 
The DX8000 supports COM1 and COM2 (RS-232) and Port 1 to Port 4 (RS-422/RS-485). 

Baud Rate Baud rate drop-down box that allows you to select the baud rate for each device. Available baud rates are as 
follows: 1200, 2400, 4800, 9600, 19200, 28800, 38400, 57600, or 115200.

Parity Parity drop-down box. You select the parity for none, odd, or even.

Data Bits Data bits drop-down box. Configure the number of data bits for 5, 6, 7, or 8.

Stop Bits Stop bits drop-down box. Select the number of stop bits for 1 or 2.

Table AO.  DX8000 Ports and Serial Data Communication Standards 

Port
Serial Data Standard Supported

RS-232 RS-422 RS-485

COM1

COM2

1

2
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SETTING UP ATM/POS DEVICE COMMUNICATION PORTS 

The DX8000 allows you to use both the COM1 and COM2 (RS-232) port and Port 1 to Port 4 (RS-422/RS-485) to connect ATM/POS devices. 
Typically, Port 1 to Port 4 are used to connect the KBD300A and dome devices.

This section describes how to select and configure the ATM/POS device communication port and includes the following topics:

• Setting Up COM1 and COM2 Port Properties on page 149 

• Selecting the ATM/POS Device Mode on page 150 

• Setting Up an ATM/POS Data Format on page 151 

• Assigning a Data Format to an ATM/POS Device on page 154 

• Setting Up ATM/POS Exceptions on page 155

• Verifying the ATM/POS Communication Connection on page 159

Setting Up COM1 and COM2 Port Properties

This topic describes how to set up COM1 and COM2 communication port properties. Access the Network page to configure the communication 
ports. For information on accessing the Network page, refer to Setting Up DX8000 Network Access on page 143. For information about the  
Port/Device page, refer to Setting Up Port and Device Communication Properties on page 147.

The following table describes the COM1 and COM2 port properties.

To set up COM1 or COM2 communication properties:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select COM1 or COM2. RS-232 is the serial data communication standard. 

3. In the device drop-down box, select a device.

4. Configure the following COM1/COM2 port settings using the drop-down boxes provided.

• Interface mode: RS-232 is the only allowed setting by default.
• Baud rate
• Parity
• Data bits
• Stop bits

3

4

Table AP.  COM1 and COM2 Port Properties 

Property Selection

Interface Mode RS-232 (default)

Baud Rate 1200, 2400, 4800, 9600, 19200, 28800, 38400, 57600, or 115200

Parity None, Odd, or Even

Data Bits 5, 6, 7, or 8

Stop Bits 1 or 2

Table AO.  DX8000 Ports and Serial Data Communication Standards (Continued)

Port
Serial Data Standard Supported

RS-232 RS-422 RS-485
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5. Click Apply.

Setting Up RS-422/RS-485 Communication Port Properties

The DX8000 interfaces with the KBD300A, ATM/POS, and third-party dome devices using Port 1 to Port 4. All ports are compatible with both 
RS-422 or RS-485 serial data communication standard. This topic describes how to connect a device to the DX8000 using Port 1 to Port 4. Access 
the Network page to configure Port 1 to Port 4 communication properties. For information on accessing the Network page, refer to Setting Up 
DX8000 Network Access on page 143. For information about the Port/Device page, refer to Setting Up Port and Device Communication Properties 
on page 147.

To configure Port 1 to Port 4 properties: 

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select the port number you want to configure. 

3. In the device drop-down box, select a device. 

ATM/POS devices can use COM1, COM2, and Port 1 to Port 4. The KBD300A and third-party dome devices use Port 1 to Port 4. 
For information on interfacing ATM/POS devices to the DX8000 using COM1 or COM2, refer to Setting Up COM1 and COM2 Port Properties 
on page 149.

4. Configure the following port settings using the drop-down boxes provided.

• Interface mode
• Baud rate
• Parity
• Data bits
• Stop bits

5. Click Apply.

SETTING UP ATM/POS DEVICE PROPERTIES

This section describes how to configure ATM/POS device properties and includes the following topics:

• Selecting the ATM/POS Device Mode on page 150 

• Setting Up an ATM/POS Data Format on page 151

• Assigning a Data Format to an ATM/POS Device on page 154

• Setting Up ATM/POS Exceptions on page 155

• Verifying the ATM/POS Communication Connection on page 159

• Recording ATM/POS Events on page 160

Selecting the ATM/POS Device Mode

The DX8000 supports two device modes: 

• Single Mode: Use the single mode to interface one ATM/POS device to the DX8000.

• Multimode: Use multimode to connect multiple ATM/POS devices to the DX8000 over one connection.

To select the device mode:

1. In the selected device drop-down box, select an ATM/POS device.

2. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

3. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1 or COM2.

4. In the Communication Port Configuration section, click Configure. The Device Configuration dialog box opens.

5. In the Device Mode drop-down box, select a mode. Single mode is the default mode.

6. Do one of the following:

• To accept the setting and remain in the Device Configuration page, click Apply.
• To accept the setting and return to the Port/Device page and then click OK.
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7. Set up the ATM/POS device data format. For information on setting up the ATM/POS device data format, refer to Setting Up an ATM/POS 
Data Format on page 151.

Setting Up an ATM/POS Data Format

The DX8000 allows you to create a data format for each ATM/POS device. You can assign a unique name to each data format. The data format 
values determine how data from ATMs or POS terminals is interpreted. This information is used to separate the data stream into individual 
transactions and separate the various fields within the transaction. Every field format must match that of the ATM or POS device, especially the 
month format.

Access the Network page to configure the data format. For information on accessing the Network page, refer to Setting Up DX8000 Network 
Access on page 143. For information about the Port/Device tab, refer to Setting Up Port and Device Communication Properties on page 147.

This section describes how to create a data format template and includes the following topics:

• Understanding the Data Format Page on page 151

• Creating a New Data Format on page 153

• Editing a Data Format on page 153 

• Deleting a Data Format on page 153 

Understanding the Data Format Page

The DX8000 allows you to create a device data format for each ATM/POS device. You can assign a unique name to each device data format 
template. 

The following figure shows the Data Format page. Access the Data Format page from the Port/Device page. For information on accessing the 
Data Format page, refer to Setting Up DX8000 Network Access on page 143. For information about the Port/Device tab, refer to Setting Up Port 
and Device Communication Properties on page 147.

Figure 111.  Data Format Page

The following table describes the parts of the Data Format page.
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The following table describes the transaction start and end parameters.

Table AQ.  Parts of the Data Format Page 

Item Command Description

Data Format Name Text box where a specific name for the data format template is created.

Transaction Format Includes the following options:

• Transaction Number: Allows a transaction symbol to be entered.

• Transaction Start: Selects the control character for indicating the start of a transmission.

• Transaction End: Selects the control character for indicating the end of a transmission.

• The end of text string (Decimal): Specifies the type of control character that marks the 
end of a transaction line. Decimal 13 represents the ASCII CR control character. 

• User String: Allows you to enter an end-of-line string.

Monetary Format Includes the following options:

• Monetary Unit: Text box for entering the monetary symbol.

• Thousand Separator: Symbol used in transaction data to separate number by thousands.

• Decimal Separator: Symbol used in transaction data to separate dollar and cents.

Time Format Allows you to set the following options to match those in the transaction data:

• Date: Selects the date format.

• Month Type: Selects the month format.

• Time: Selects the time format.

• Time Period: Selects the time period: 12 or 24 hour.

Character Format Allows you to specify a character filter:

• Special Device Character: No available at this time.

• Custom Device Filter: Contains the character filter.

• Add: Moves the character filter into the Custom Device Filter table.

• Delete: Deletes the selected filter in the Custom Device Filter table

• Control Code: Contains a selection of control codes for creating a desired filter

• Special Character: Contains a selection of characters for creating a desired filter

• Range: Not applicable.

Table AR.  Transaction Start and End Parameters 

Value Description

None First part of transaction field is not used.

CR Carriage return character (13 in ASCII).

LF Line feed character (10 in ASCII).

FF Form feed character (12 in ASCII).

DATE Date field.

TIME Time field.

TEXT Ten selected; another field appears to let you enter a text string up to 20 
characters that defines the start of the transaction.
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Using Custom Device Filters

The DX8000 allows you to use a custom device filter to remove unwanted characters from the data input port. These characters may be printer 
commands or some other type of device control/overhead. Each entered line of text in the Custom Device Filter table defines a separate 
character filter. A filter can be a combination of exact characters to match, character ranges to match, and character counts. Incoming characters 
matching any of the character filters will be discarded.

Use the Control Code drop-down box, Special Character drop-down box and Range text box to create the desired filter, and then transfer the 
created filter to the Custom Device Filter table by clicking the Add button. 

Creating a New Data Format

You create the data format based on information contained in the ATM/POS transaction. For example, a sales receipt provides detailed 
transaction information. The data format values determine how data from ATMs or POS terminals is interpreted. This information is used to 
separate the data stream into individual transactions and separate the various fields within the transaction. Every field format must match that of 
the ATM or POS device, especially the month format.

To create a data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

3. In the selected device drop-down box, select an ATM/POS device.

4. Click the Data Format tab.

5. In the Data Format page, click Add. The Data Format dialog box opens.

6. Using the information from the transaction record or other source, set the parameters for the following Data Format sections (as applicable):

• Transaction Format
• Monetary Format
• Time Format
• Character Format

7. Click OK. 

8. Verify that the new data format is listed in the Data Format List on the Data Format page. 

Editing a Data Format

The DX8000 allows you to edit a data format. Once you click OK to accept the changes, you cannot undo the changes. 

To edit an existing data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

3. In the Data Format List, highlight the name of a data format.

4. Click Edit. The Data Format dialog box opens.

5. Verify that the name of the data format you want to edit is displayed in the Data Format Name text box.

6. Perform the edits.

7. Do one of the following:

• To accept the changes, click OK.
• To not accept the changes, click Cancel.

Deleting a Data Format

To delete an existing data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.
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3. Click the Data Format tab. The Data Format List page is displayed.

4. In the Data Format List, highlight the name of a data format.

5. Click Delete. A DX8000 message box is displayed prompting to confirm deletion of the data format.

6. Do one of the following:

• To delete the data format, click Yes.
• To not accept the deletion, click No or Cancel.

Assigning a Data Format to an ATM/POS Device

After you have created a data format, you can assign it to a specific ATM/POS device. 

To assign an existing data format to a specific ATM/POS device:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the device drop-down box, select an ATM/POS device.

3. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

4. Click the Settings tab. The Available ATM/POS Device setup table is displayed.

5. In the Data Format column, do the following:

a. In the Device ID column, click the check box to select an ATM/POS device.

b. Double-click the Data Format cell for the selected ATM/POS device. The Data Format cell drop-down box is displayed.

c. Click in the Data Format cell to display the available data formats.

d. Select the data format you want to assign to the ATM/POS device.

e. Do one of the following:

• Click Apply to confirm selection and remain in the Device Configuration dialog box.
• Click OK to confirm selection and return to the Port/Device page.

Figure 112.  Assigning a Data Format to An ATM/POS Device
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Setting Up ATM/POS Exceptions

An exception is a predefined transaction filter used to detect a specific data structure within the ATM/POS transaction data. Exceptions are 
configured on the Advanced page. 

To use an exception to search transaction data, the exception must be create first, before recording the transaction data. If the transaction data 
is recorded before the exception filter is defined, the exception filter will not find the data structure within the transaction data.

The DX8000 allows you to configure unique exceptions for each ATM/POS device from the following:

• ATM/POS device selection drop-down box

• Exception table that contains the name and effect of each exception you create

• Action code drop-down box that contains exception action codes

• User mapping table where you create the string for the action code

Use the Advanced tab to configure exceptions. Entries are case sensitive. For each defined data device ATM device or POS terminal, you can 
specify up to 31 data exceptions. A field left blank is not used in the exception. Any fields containing values must all be found or satisfied before 
a data device exception is generated. Each data device can trigger the DX8000 to record at special rates and for a special length of time, as 
determined in the Record On Data Exceptions screen.

This section describes how to work with exceptions and includes the following topics:

• Using Action Codes on page 155

• Creating an ATM/POS Exception on page 157 

• Editing an ATM/POS Exception on page 158 

• Deleting an ATM/POS Exception on page 159 

• Assigning an Exception to An ATM/POS Device on page 159 

Using Action Codes

To use an action code to search transaction data, the action code must be create first, before recording the transaction data. If the transaction 
data is recorded before the action code is defined, the action code will not find the data structure within the transaction data.

The following table describes the ATM/POS action codes.

Table AS.  Action Codes 

Code Description Code Description

AL ALL CODES (item or merchandise sold normally) GR GAS REFUND (refund of unused portion of gasoline prepayment) 

AM AMOUNT TENDERED (cash amount tendered) IM INFORMATION MESSAGES (displays message fields, as is)

CC CREDIT CARD (amount tendered with credit card) IT ITEM SALE TRANSACTION (displays message fields) 

CD CASH DROP (safe drop) LO LOTTERY PAYMENT (lottery pay out) 

CG CHARGE ACCT (amount added to charge account balance) LS LOTTERY (lottery sale) 

CH CHANGE (change due to customer) MT Not included

CK CHECK (amount tendered with check) NS NO SALE (no sale) 

CL CLERK NAME (and/or number) or CLERK LOGIN NT NEG TAX (negative tax) 

CM MFR COUPON (manufacturer coupon redemption) OT Description not available 

CP COUPON (store coupon redemption) OV OVERRIDE (override programmed price-displays message fields) 

CR CRITICAL CODES (determined by Action Critical) PL PRICE LOOKUP (displays message fields) 

CX CANCEL (cancel entire sale before completion) PO PAID OUT (pay out cash from register) 
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DB DEBIT CARD (amount tendered with debit, ATM or credit) RA RCVD ON ACCT (customer payment toward charge account 
balance) 

DC DRAWER CLOSED (no display) RF REFUND (payment of refund to customer) 

DD DISCOUNT (discount entered as absolute amount) RT RETURN (merchandise returned) 

DO DRAWER OPEN (no display) ST SUBTOTAL (sale subtotal) 

DP DEPOSIT (deposit amount paid pending purchase) SX TAXABLE AMT (taxable subtotal) 

DR DEPOSIT RETURN (deposit return) TI CURRENT TIME (displays description field) 

DS PCT DISCOUNT (discount as percentage of cost or total) TK TRANSACTION RECEIPT NUMBER (displays description field) 

EI EMPLOYEE SIGN ON (to register) TN Tim Norris (publicly viewable) 

EO EMPLOYEE SIGN OFF (register) TR NEGATIVE TOTAL (negative amount as the total) 

FC COMPLIMENTARY (complimentary or on-the-house charge) TT TOTAL (total amount due) 

FS FOODSTAMPS (amount tendered in food stamps, WIC, and 
so forth) TX TAX (tax amount) 

GA PREPAID GAS (gasoline prepayment after pumping) VD ERROR CORRECT (void of last item entered) 

GP GAS PREPAID (gasoline prepayment) VX VOID (correction of entered item within current transaction) 

Table AS.  Action Codes (Continued)

Code Description Code Description
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Creating an ATM/POS Exception

To create an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the device drop-down box, select an ATM/POS device.

3. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

4. Click the Advanced tab. For information about the Advanced page, refer to Setting Up ATM/POS Exceptions on page 155.

5. In the ATM/POS Name drop-down box, select an ATM/POS device.

Figure 113.  Advanced Page

6. In the Exception Table section, click Add. The Exceptions dialog box opens.

Figure 114.  Exceptions Dialog Box 
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7. In the Exceptions dialog box, do the following:

a. In the Exception Name text box, enter a name or description for the exception (up to 20 characters). 

b. In the Line Item text box, enter the name of the line item (up to 20 characters). The line item entry is case-sensitive. In this case, if the 
transaction is displayed as all capital letters, then the line item entry must be in all capital letters.

The DVR will search for this entry anywhere in the transaction. ATM transactions do not usually contain line items. The program may 
display a “No data found” error message if searching ATM transactions using line items. If the line item box is left blank, it is 
considered found or satisfied.

c. In the Modifier drop-down box, select a modifier that further defines the line item. 

A modifier must be selected before a value can be entered. If a modifier is not selected, the Value text box is unavailable.

d. In the Value box, enter the value.

The value (9999.99 maximum) is used with the modifier (above) to trigger an exception. You can use a period to separate dollars and 
cents, but do not use a comma between thousands and hundreds.

e. In the This Exception Effect section, do one of the following:

• Accept the default display effect setting.
• In the Display Effect drop-down box, select Don’t Show or Show.

8. Click OK.

9. At the Advanced page, do one of the following:

• Click Apply to confirm selection and remain in the Device Configuration dialog box.
• Click OK to confirm selection and return to the Port/Device page.

Editing an ATM/POS Exception

To edit an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration dialog box is displayed.

3. Click the Advanced tab. For information on the Advanced page, refer to Setting Up ATM/POS Exceptions on page 155.

4. In the Exception Table, select an exception.

5. Click Edit. The Exceptions dialog box opens.

6. Edit the exception content.

7. Do one of the following:

• Click OK to accept the changes and exit the Exceptions dialog box.
• Click Cancel to exit the Exception dialog box and not save changes.

Table AT.  ATM/POS Exception Modifiers 

Modifier Description

None Value to the right is not used and is disabled.

> Greater than: Trigger exception only if the value found on the line is greater than the value entered in the 
Value text box.

< Less than: Trigger exception only if the value found on the line is less than the value entered in the Value 
text box.

= Equal to: Trigger exception only if the value found on the line is equal to the value entered in the Value 
field.

!= Not equal to: Trigger exception only if the value found on the line is not equal to the value entered in the 
Value field.
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Deleting an ATM/POS Exception

To delete an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration dialog box is displayed.

3. Click the Advanced tab. For information on the Advanced page, refer to Setting Up ATM/POS Exceptions on page 155.

4. In the Exception Table, select an exception.

5. Click Delete. The DX8000 message box is displayed.

6. In response to the DX8000 message, do one of the following:

• Click Yes to delete the exception.
• Click No if you do not want to continue with the deletion of the exception.
• Click Cancel to discard the delete action.

Assigning an Exception to An ATM/POS Device

To assign an exception to an ATM/POS device:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

3. Click the Advanced tab.

4. In the ATM/POS Name drop-down box, select an ATM/POS device.

5. In the Exception Table, click the ID box of the exception you want to assign to the ATM/POS device selected in the ATM/POS Name drop-
down box.

6. Do one of the following:

• Click OK to accept the changes and exit the Exceptions dialog box.
• Click Cancel to exit the Exception dialog box and not save changes.

Figure 115.  Assigning an Exception to an ATM/POS Device

Verifying the ATM/POS Communication Connection

To verify that the ATM/POS connection is working correctly:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

3. Click the Diagnostics tab. 

4. In the ATM/POS Information section, select the ATM/POS device in the Device ID drop-down box.
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5. Do the following:

a. Verify that transaction data is displayed in the ATM/POS Raw Data View area. 

b. Verify that transaction data (as interpreted by the DX8000) is displayed in the Result Box.

Figure 116.  Verifying the ATM/POS Communication Connection

Recording ATM/POS Events

To record ATM/POS events:

1. Set up the ATM/POS device communication port. In summary, do the following:

a. Assign the ATM/POS device to a COM port and set up COM port properties. For information, refer to Setting Up ATM/POS Device 
Communication Ports on page 149.

b. Select the ATM/POS device mode. For information, refer to Selecting the ATM/POS Device Mode on page 150

c. Create a data format for the ATM/POS device. For information, refer to, Setting Up an ATM/POS Data Format on page 151. 

d. Assign the data format to the ATM/POS device. For information, refer to, Assigning a Data Format to an ATM/POS Device on 
page 154.

e. Set up ATM/POS exceptions. For information, refer to, Setting Up ATM/POS Exceptions on page 155.

f. Assign the exception to the ATM/POS device. For information, refer to, Assigning an Exception to An ATM/POS Device on page 159.

g. Verify the ATM/POS communication connection. For information, refer to, Verifying the ATM/POS Communication Connection on 
page 159.

2. Setup a camera to record the ATM/POS events:

a. Set up the designated ATM/POS camera for scheduled ATM/POS recording. 

b. Configure the ATM/POS link settings.

c. Configure the ATM/POS record link settings.

d. (Optional) Configure the ATM/POS PTZ link settings.

�
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3. In the DX8000 application window, do the following:

a. Assign a camera to a view pane. 

b. Assign the ATM/POS device to the camera designated to record ATM/POS events.

4. Verify the following:

a. The POS record indicator is yellow and flashing.

b. The ATM/POS record symbol flashes blue during an ATM/POS event.

c. The ATM/POS events are displayed yellow in the timeline.

Figure 117.  Recording ATM/POS Transaction

SETTING UP THE KBD300A KEYBOARD

The KBD300A allows you to operate certain DX8000 live view display functions and control camera PTZ operations from a keyboard rather than a 
mouse. 

When connected to the DX8000 server, the KBD300A supports two modes: the standard and shift mode. The shift mode is entered by pressing 
the Shift button and is indicated by the lighting of the Shift button LED. For information about how to operate the KBD300A, refer to the KBD300A 
universal keyboard Installation/Operation manual. For information about using the KBD300A, refer to Using the KBD300A Keyboard on page 59.

In summary, the steps required to set up the KBD300A for operation are as follows:

• Connect the KBD300A to the DX8000: For information about connecting the KBD300A to the DX8000, refer to the DX8000 Installation 
manual.

• Configure the KBD300A communication settings: Refer to the instructions below.
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Configuring KBD300A Communication Settings

This section describes how to configure the KBD300A communication settings. The KBD300A is interfaced to the DX8000 using Port 1–4. These 
ports support connectivity to the DX8000 using the RS-422 data communication standard. A user-supplied RJ-45 cable is required. For 
information about using the KBD300A, refer to Using the KBD300A Keyboard on page 59.

To configure the KBD300A communication settings:

1. Connect the KBD300A to the DX8000 to a RS-422 RJ-45 port.

2. On the DX8000 toolbar, click . The Setup dialog opens to the Camera page.

3. In the Setup dialog box, click . The Network page is displayed.

4. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

5. In the device drop-down box, select KBD300A (Pelco).

6. In the Communication Port drop-down box, select the Port 1–4 to which the KBD300A is connected.

7. Configure the following port settings using the drop-down boxes provided.

• Interface mode: RS-422.
• Baud rate: 9600
• Parity: ODD
• Data bits: 8
• Stop bits: 1

8. Click Apply.

KBD300A Standard Mode Operational Features

The following table describes the KBD300A Standard Mode operational features.

Table AU.  KB300A Standard Operational Mode Features 

Control Action

Joystick Controls the camera’s PTZ operation.

Number + PRESET (short) Moves camera to the programmed preset position.

Number + PRESET (long) Programs the current camera position to the desired preset number.

Number + PATTERN (long) Starts the pattern record mode.

ACK Stops the pattern record mode.

Number + PATTERN Runs the desired pattern.

Number+ AUX ON/AUX OFF Turns the specified auxiliary output on or off.

Number + MON Assigns the selected camera to the desired view pane. The active view pane is highlighted.
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KBD300A Shift Mode Operational Features

The following table describes the KBD300A Shift Mode operational features.

INSTALLING OR UPDATING DEVICE PROTOCOLS

The DX8000 uses dynamic-link library (DLL) files to support the various ATM, dome, and keyboard device protocols. The DX8000 is shipped with a 
default set of protocols and devices for Pelco and other manufacturers. As new devices or updates are made available, the DX8000 allows you to 
install new or update existing device protocols to support the new or current ATM, dome, and keyboard devices. 

• DLL files for Pelco devices supported by the DX8000 are provided by Pelco. 

• DLL files for other manufacturer devices supported by the DX8000 are provided by the respective vendor.

To install or update a device (PTZ, POS, or keyboard) in the DX8000:

1. Insert the CD containing the Pelco DLL files in the DX8000 CD drive.

2. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

3. Click Install. The Protocol Install dialog box opens.

4. Click Browse and located the DLL files for the device.

5. Click Update.

6. Click Exit.

Table AV.  KBD300A Shift Mode Operational Features

Control Action

Joystick Activity within the DX8000 Site tree:

• Up/Down direction: Moves the cursor vertically through each element in the Site tree. 

An element is a DX8000 site, camera within each DX8000 site, or alam, ATM/POS, or relay within each 
DX8000 site.

If an element is expanded, the joystick moves the cursor vertically through the objects of that element.

• Left/Right direction: 

– Right: Expands an element to display objects contained under the element.
– Left: Collapses an element and hides its objects. Select a camera/ unit at the tree.

Number + CAM Expands the specified DX8000 Site tree. If there are two sites, 1 + CAM expands DX8000 site 1; 2 + CAM expands 
DX8000 site 2.

F2, F3, ON, OFF Cameras are assigned numerically 1–16 to the respectively number video. These controls display DX8000 video in 
the following divisions:

• F2/OFF: Single division view

• F3/MOM: 4-division view

• AUX ON: 9-division view 

• AUX OFF: 16-division view
C624M-C (5/06) 163



DATA BACKUP SETUP
Video data recorded on the DX8000 can be backed up to a variety of media. The backup process involves selecting a specific time range to be 
archived and the type of media to be used for the backup. The primary difference between backing up and exporting video is that backup archives 
all channels for a specific time period while export only archives selected channels. Following the directions below, Power User and 
Administrators can set up and perform backups. 

You must use the DX8000 Client application to view backed-up data. For more information about viewing backed-up data, refer to the Client 
Applications Manual.

This section describes how to back up data and includes the following topics:

• Accessing the Backup Configuration Page on page 165 

• Adding a Backup Schedule on page 166 

• Editing an Existing Backup Schedule on page 167 

• Deleting an Existing Backup Schedule on page 168

• Initiating an Instant Backup Schedule on page 168 

• Mapping a Network Device on page 169 

• Disconnecting from a Network Drive on page 169

• Selecting a Backup Media Device on page 170 

• Viewing Backed-Up Video on page 170

The following figure shows the Backup schedule page.

Figure 118.  Backup Configuration Screen
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The following table describes the parts of the Backup schedule page. 

ACCESSING THE BACKUP CONFIGURATION PAGE

For information on the Backup schedule page, refer to Data Backup Setup on page 164.

To access the Backup page:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

Table AW.  Parts of the Backup Schedule Page 

Item Part Description

Backup schedule 
table

Describes the configured backup schedule details.

• Name: Type of backup schedule: Daily or Weekly. Daily includes all days of the week, Monday through 
Sunday; Weekly (indicates a specific day of the week that the backup schedule is to occur. A selection 
check box allows you to select or deselect a backup schedule to run as scheduled. A deselected backup 
schedule does not run as scheduled. 

• Backup start time: Time backup schedule starts.

• Backup time: The time period entered for the backup schedule. 

• Filter: The channels selected to be backed up. 

• Target device: The selected backup media device.

Backup schedule  
buttons

Allows you to do the following:

• Add: Opens the Add Backup Schedule dialog box for configuring a backup schedule. For more 
information about the Add Backup Schedule dialog box, refer to Adding a Backup Schedule on 
page 166.

• Edit: Allows you to edit the details of the selected backup schedule.

• Delete: Allows you to delete a selected backup schedule.

• Instant Backup: Opens the Backup Now dialog box, where you enter options to start a backup 
schedule

Waiting backup  
information

Displays backup schedules waiting to be executed. 

• Backup time: The date and time a backup schedule is defined to run. 

• Filter: The selected channels to be backed up. 

• Target device: The selected backup media device. 

• Enqueue time: The system’s estimated time that the backup schedule will run. 

Waiting backup  
information control 
buttons

Allows you to do the following:

• Priority Up: Allows you to move the selected backup schedule to a higher place in the list. 

• Priority Down: Allows you to move the selected backup schedule to a lower place in the list. 

• Delete: Allows you to delete the selected backup schedule. 

Running backup  
information

Lists the backup schedules that are currently running.
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ADDING A BACKUP SCHEDULE

The DX8000 allows you to configure the start time and time range for backing up data. The backup schedule can be configured to run on a daily 
basis at a set time and for a specified time range that applies to every day. Or you can set up the backup schedule(s) to run at selected days of the 
week. In this case, selecting a weekly backup schedule allows you to customize the start time and time range for each selected day of the week. 
The start date and time cannot be set later than the end date and time.

To define the time range of data to be backed up:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. On the Backup schedule page, to add a backup schedule, click Add. The Add Backup Schedule dialog box opens.

Figure 119.  Add Backup Schedule Dialog Box

4. In the Time Setting section, to set up the time schedule, do one of the following: 

a. For daily recording, click Daily if it is not selected, and do the following;

(1) Click the Time drop-down boxes, and select the time you want the backup schedule to start. 

(2) Click the Backup Time Range drop-down boxes, and select the time you want the backup schedule to stop.

or 

b. For weekly recording, click Weekly if it is not selected and do the following:

(1) Under the Backup Start Time, click the Day drop-down-box. Select the day of the week. In this case, each day represents an 
individual backup schedule for that specific day and time constraints you configure. 

(2) Under the Backup Start Time, click the Time drop-down boxes, and select the time you want the backup schedule to start.

(3) Under the Backup Time Range, click the Day drop-down boxes. Select the day you want the backup schedule to start and the day 
you want the backup schedule to stop.

(4) Under the Backup Time Range, click the Time drop-down boxes. Select the time of day you want the backup schedule to start 
and the time you want the backup schedule to stop.

5. In the Channel Record Type” section, select the channel record type as follows:

(1) Click the All or Clear button to select or clear all of the channels at once, or click channel 1–16 individually to select or deselect 
a channel.

(2) Click the Categories drop-down box to select the type of recording. The backup schedule includes only the type of recording that 
you have specified.
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6. (Optional) In the Device Selection section, to map a network drive for backup, do one of the following:

a. Click the “Map a network drive” button to map a network drive. The Windows Map Network Drive dialog box opens. For more 
information about mapping a network drive, refer to Mapping a Network Device on page 169.

(1) Specify the drive letter for the connection and the folder that you want to connect to. 

(2) Click Finish. The mapped drive is displayed in the Device Selection area under “Remote drives.”

or 

b. Click Disconnect a mapped drive” to disconnect a mapped drive. 

7. In the Device Selection section, click the check box for the device you want the data to be backed up to.

8. Click OK. 

The “Backup schedule” table is displayed and the newly scheduled backup time range is listed in the table and the selection check box is 
marked. 

EDITING AN EXISTING BACKUP SCHEDULE

The DX8000 allows you to edit or delete an existing backup schedule.

To edit a backup schedule:

1. On the DX8000 toolbar, click . The DX8000 setup screen is displayed.

2. Click . The backup configuration screen is displayed.

3. In the “Backup schedule” table, do the following:

a. Click the backup schedule time range you want to edit.

b. Click Edit.

The Edit Backup Schedule dialog box opens, displaying the current settings for the selected backup schedule.

Figure 120.  Editing an Existing Backup Schedule

c. Edit the backup parameters. 

d. Click OK.

The Edit Backup Schedule dialog box closes, and the backup configuration screen is displayed. The updated schedule details are 
displayed in the “Backup schedule” table.

4. Click Apply. 

�
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DELETING AN EXISTING BACKUP SCHEDULE

To delete an existing schedule:

1. On the DX8000 toolbar, click . The DX8000 setup screen is displayed.

2. Click . The backup configuration screen is displayed.

3. In the “Backup schedule” table, click the backup schedule you want to delete.

4. Click Delete. 

5. Click Apply.

INITIATING AN INSTANT BACKUP SCHEDULE

The DX8000 allows you to perform an instant backup routine. The DX8000 displays different time setting options when you select instant backup. 
In this case, you are given quick access to select the backup device, day and time, channel record type, and recording category. Once you 
establish the backup schedule, you can view the estimated backup size before starting the actual backup process. 

The DX8000 provides initial default settings. You can save time by accepting the following defaults:

• Backup time range: The current day and time that you initiated the instant backup routine. 

• Channel Record Type: All channels.

• Categories: All Recording.

To perform an instant backup: 

1. On the DX8000 toolbar, click . The DX8000 setup screen is displayed.

2. Click . The backup configuration screen is displayed.

3. In the Backup page, do the following:

a. Click Instant Backup. The Backup Now dialog box opens.

b. Click the selection check box for the device you want to receive the instant backup data.

4. Do one of the following:

a. To accept backup schedule options:

(1) Click Estimated Backup Size. The Estimated Backup Size dialog box opens, displaying backup details. 

(2) Read the backup information and verify that the selected backup device provides adequate space to receive the backed up data.

(3) Click OK.

(4) Click OK to accept the defaults for the time setting, channel record type, and categories. The backup starts immediately. 

or

b. To customize the backup options:

(1) Change the backup time range, channel record type, and category.

(2) Click Estimated Backup Size. The Estimated Backup Size dialog box opens, displaying backup details. 

(3) Click OK.

(4) Read the backup information and verify that the selected backup device provides adequate space to receive the backed up data.

(5) Click OK. The backup starts immediately. 
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Figure 121.  Instant Record Backup Now Dialog Box

MAPPING A NETWORK DEVICE

You can back up video to a network drive. The DX8000 allows you to map to or disconnect from a network drive. You need to know what letters 
are already assigned to drives and the path to the folder you want to map to.

 To map a network drive: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The backup configuration screen opens.

3. Click the Add or Instant Backup button. The Add Backup Schedule or Backup Now dialog box opens.

4. Click “Map a network drive.” The Map Network Drive dialog box opens asking for a drive letter and path. 

5. In the Drive drop-down box, select a drive letter that is not being used.

6. Type the path in the Folder drop-down box; \\IP_address_of_server\folder_name is an example.

7. (Optional) Click the Reconnect at logon box if you do not want the mapped drive to remain connected each time you log on. 

8. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area of the Export Video dialog box. 
The mapped drive can now be accessed just like a local drive.

DISCONNECTING FROM A NETWORK DRIVE

To disconnect from a network drive:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The backup configuration screen opens.

3. Click “Disconnect mapped drive.” The Disconnect Network Drive dialog box opens. 

4. Select the network drive you want to disconnect

5. Click OK. The drive is disconnected and removed from the Export Video dialog box’s Device area.
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SELECTING A BACKUP MEDIA DEVICE

You can back up video to a local or remote networked device. Depending on your system configuration, backup devices may include an optical 
drive, such as a CD-R or a DVD-R; an external drive; or a network drive. The DX8000 does not support exporting or backing up to CD-RW and DVD-
RW disks, but it does support exporting or backing up to CD-R and DVD-R disks.

To select the type of backup device you want to use:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The backup configuration screen opens.

3. Click the plus (+) sign next to a backup device in the device list. 

4. Select the check box of the device you want to use.

5. Make sure that the backup media selected is inserted in the drive and that the drive is ready.

If your DX8000 is connected to a network that supports shared folders and drives, you can map a network drive by right-clicking the 
Network Drive icon in the device list. To map a network drive, select Add Network Drive from the quick-menu and follow the on-screen 
directions. To remove a drive mapping, right-click the Network Drive icon and select Remove Network Drive.

VIEWING BACKED-UP VIDEO

You must use the DX8000 Client application to view backed-up video. For more information about viewing backed-up video, refer to the section 
titled Viewing and Searching Backed-Up Video in the Client online Help or Client Applications manual. 
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USER SETUP
The User page allows an Administrator (Admin) to add, delete, and change the properties of users. The Admin has full permission of the DX8000. 
Users are subdivided into groups and each group is granted a particular level of access. The Admin is the only one who can change the 
permission for all lower-level users. A lower level user cannot have more permission than a higher level user. 

This section describes how to configure users and includes the following topics:

• Built-in User Accounts on page 173 

• Definition of User Access Levels on page 173 

• Definition of Camera Security Access on page 174 

• Adding New Users on page 174 

• Modifying User Properties on page 175 

• Changing User Passwords on page 175 

• Changing a User’s Group Affiliation on page 176 

• Deleting Existing Users on page 176

• Setting Login Timeout on page 176

• Assigning Automatic Login Permission to a User on page 177

ACCESSING THE USER PAGE

To access the User page:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

The following figure shows the User page.

Figure 122.  User Page
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The following table describes the parts of the User page.

Table AX.  Parts of the User Page 

Item Part Description

User name table Lists the authorized users.

User buttons Allows you to do the following:

• Add: Opens the Add New User dialog box, where you create a new user account. 

• Remove: Deletes the selected user.

• Properties: Opens the Properties dialog box, where you view and modify user details.

• Set Password: Opens the Set Password dialog box, where you specify or modify the user’s password.

User Groups Allows you to create user accounts for the following user groups:

• Administrator Group 

• Power User Group 

• Standard User 

• Restricted User Group

The DX8000 allows the Admin to configure access rights to any user group for the following functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access Export menu

For more information on the above user groups, refer to Definition of User Access Levels on page 173 and 
Definition of Camera Security Access on page 174.

User Timeout Allows you to configure the amount of time a user is allowed to remain logged on to the DX8000 system 
before the system automatically logs them out. The time period is from 5 to 60 minutes (in increments of 
5 minutes). The manual setting allows the user to stay logged on to the DX8000 until the user is manually 
logged off.

Auto Login User Allows you to configure the user to be automatically logged on to the DX8000.
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BUILT-IN USER ACCOUNTS

There are two built-in user accounts that come preconfigured on the DX8000, and they cannot be deleted or changed.

• Guest: The Guest account provides limited access to the system. The Guest user can view live video but cannot play back recorded video or 
access system configuration functions. The Guest account automatically becomes active when the system is first started and each time a 
user logs out. The Guest user is not a member of any group; however, Guest retains all of the rights and privileges of the Restricted Users 
group with the exception of the ability to view low security cameras.

• Admin: The Admin account has full access to the system. The Admin user can view live and play back video, access all configuration 
settings, add and modify users, and can perform searches and backups. The Admin user is a member of the Administrators group and 
cannot be removed.

DEFINITION OF USER ACCESS LEVELS

There are four predefined user access levels or groups. User access levels range from the Administrator group to the Restricted group. By default, 
the system starts up with a default Guest account. The Admin can assign automatic login for a specified user. For information about setting up 
auto login, refer to Assigning Automatic Login Permission to a User on page 177.

The Guest account has Restricted user access. The following table describes the user group’s access rights.

Table AY.  User Group Access Rights 

User Groups
View 
Live 

Video 

View 
Recorded 

Video

Operate 
PTZ

Search 
Video

Backup 
Video

System 
Setup

Shut 
Down Sys-

tem

Add/
Remove 

Users

Change 
User/Group 
Properties

Exit to 
Windows

Administrators

Power Users

Standard Users

Restricted Users

Guest Users
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DEFINITION OF CAMERA SECURITY ACCESS

Users are limited by the Admin to the cameras they are allowed to view. Access to a camera is determined by its security designation. The Admin 
can configure access rights to any user group for any of the following functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access Export menu

Only users with High Security access can view cameras designated as High Security. Medium Security cameras can be viewed by users with 
Medium Security access and higher. All users except Guest can view Low Security cameras. All users can view No Security cameras. 

The following table summarizes camera security levels and user access.

ADDING NEW USERS

Administrators can create new user accounts and modify existing users locally on the DX8000 server or remotely from the DX8000 Client 
Application. 

User names and passwords have the following requirements:

• User names can be between 4 and 20 alphanumeric characters in length. 

• User passwords can be between 4 and 10 alphanumeric characters in length. 

• User names cannot contain spaces and special characters.

• User names and passwords are case sensitive.

To add a new user:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click Add. The Add New User dialog box opens.

4. Do the following:

a. Enter a login name for the user. 

b. Enter the user’s full name.

c. Enter a brief description for the user. For example, enter Building 6 Security Guard.

d. Enter a password for the user. (Passwords must be between 4 and 10 characters in length and cannot contain spaces and special 
characters.)

e. Re-enter the same password to confirm its validity.

Table AZ.  Camera Security Levels 

Groups No Security 
Cameras

Low Security 
Cameras

Medium Security 
Cameras

High Security 
Cameras

Administrators

Power Users

Standard Users

Restricted Users

Guest Users
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5. Click Next. The user access level options for the New User dialog box are displayed.

6. Select the user’s access level: Restricted, Standard, or Power.

7. Click Finish.

8. Click Apply.

Figure 123.  Add New User Dialog Box

MODIFYING USER PROPERTIES

Follow the steps below to change user attributes, such as user name and group affiliation. Users with Administrator or Power User access can 
change name and description properties of lower-level users. Only Administrator level users, however, can change a user’s group affiliation. 

To modify a user’s properties:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Do one of the following:

• In the main user list:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

• In one of the group lists:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

4. Edit the following user properties:

• User name
• Full name
• Description
• Group

5. Click Apply in the Property dialog box.

6. Click Apply in the User Setup screen.

An Administrator level user can also change the group affiliation of users by dragging user names among different groups.

CHANGING USER PASSWORDS

Administrators and Power Users can change or reset an existing user’s password.
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To change a user’s password:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click a user name in the main user list.

4. Click Set Password. The Set Password dialog box opens.

5. Enter a new password in the “New password” field.

6. Retype the password again in the “Confirm new password” field.

7. Click Apply in the Set Password dialog box. 

8. Click Apply in the User Setup screen. 

CHANGING A USER’S GROUP AFFILIATION

An Administrator level user can also change the group affiliation of users by dragging user names among different groups.

To change a user's group affiliation:

DELETING EXISTING USERS

Administrators can delete existing users.

To delete a user’s account:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click the user name of the user you want to delete from the main user list.

4. Click Remove. The Remove User dialog box opens.

5. Click Yes to confirm the deletion or No to cancel and return to the User Setup screen.

6. Click the Apply button at the bottom of the screen.

SETTING LOGIN TIMEOUT

Administrators can define the amount of time a user’s account can remain idle before having to log in again. This setting applies to all users, 
regardless of access level. 

 To set login timeout:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Select a time limit from the User Timeout drop-down box.

• Time limits range from five minutes to one hour, in five-minute increments.
• Selecting Manual from the drop-down box will suspend the automatic logout feature. (A user will remain logged in until the user logs 

out or another user logs in.)

4. Click Apply.

In the User name column of the User page, click the user's name and drag it in a group.
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ASSIGNING AUTOMATIC LOGIN PERMISSION TO A USER

The DX8000 allows one user to be able to automatically log in to the DX8000 application. The administrator must assign automatic login 
permission to the user. Once automatic login permission is assigned to the user, the user will be automatically logged in to the DX8000 
application. In this case, the assigned user does not have to enter the user name and password. 

NOTE: Automatic login user permission makes the DX8000 more vulnerable because a higher level of user is logged in every time. 

To assign automatic login permission:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. In the Auto Login User drop-down selection box, select a user.

4. Click Apply. 

The next time the DX8000 application is started, the assigned user is logged in automatically.

SITE SETUP
This section describes how to connect to a remote site and includes the following topics:

• Adding a Remote Site on page 177

• Finding Active Remote Cameras on page 180 

• Activating Remote Sites on page 181 

• Editing a Remote Site on page 181 

• Deleting a Remote Site on page 181 

ADDING A REMOTE SITE 

Up to 100 DX8000 DVR server sites can be added to the local server’s site list. Up to four remote DVR sites can be accessed from a single DX8000 
(a total of five sites, including the local DVR, can be active on a single network segment). Up to 16 cameras can be viewed and managed for each 
remote site (32 of which can be simultaneously assigned to view panels). Once a site has been added to the site list, it can be managed and 
viewed just as the local DVR. The following steps allow a user with Power User access and higher to configure access to remote DVRs.

Once a remote site has been added, all viewing, searching and setup functions of that site can be accessed from the local DX8000. To access the 
features of a remote site, users must possess a valid user account with the appropriate access rights for that site.

This section describes how to add a site with a static IP or dynamic IP address and includes the following topics:

• Adding a Site with a Static IP Address on page 177 

• Adding a Site with a Dynamic IP Address on page 179

Adding a Site with a Static IP Address

To add a remote DVR site to the site when you know the IP address of the site:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. Select the Manual radio button if it is not already selected.

4. Enter a site name for the remote DVR. (Site names can be up to 32 characters long and can contain spaces and special characters. 
For example: Building 1 DVR.)

5. Enter the IP address of the remote site.
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6. If necessary, do the following:

a. Enter a new base port number (9002 is the default). 

Unless there is a conflict on your network, you should not change port numbers from their default values. Make sure any changes to 
port numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports must be identical.

b. Enter a new upgrade port number (9003 is the default).

c. Enter a new information port number (9003 is the default).

d. Click Add. The site appears in the “Site IP list” on the right.

7. Repeat steps 4 through 6 for each additional site you want to add. Up to 50 remote sites can be added to the site list.

8. Click Apply. 

Once a remote site has been set up, its name appears in the Site tree. It may take up to five minutes to initially connect to the site. Once a 
connection has been established, cameras from the remote site can be dragged onto the main screen view panels.

Figure 124.  Adding a Site with a Static IP Address
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Adding a Site with a Dynamic IP Address

An Administrator level user can connect DX8000s together even when the exact IP address of a remote DVR is not known. To add a site 
successfully, the following must be established:

• Each DVR must be attached to the same TCP/IP subnet or LAN.

• The first three octets of the IP address of the DVR host or subnet must be known.

• The range of addresses used in the last octet of the DVR host or subnet must be known.

To add a remote DVR site to the site when you do not know the IP address of the site:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. Select the Search DX8000 radio button if it is not already selected.

4. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you want to search; as an example, 10.10.1.

b. Enter the beginning value for the search range in the fourth octet; as an example, 001.

c. Enter the final value for the search range in the text box provided; as an example, 254. 

Each octet of the IP address must be an integer number between 1 and 255.

5. Click Find and then wait while the DX8000 searches the network for remote DVR sites.

6. Select the DVR site(s) you want to add to the site list.

7. Click Add.

8. Click Apply.

Figure 125.  Adding a Site with a Dynamic IP Address
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FINDING ACTIVE REMOTE CAMERAS

After connecting to a remote site, you should query the server to see which cameras are active. Some DVRs have eight channels, while others 
have 16. 

To refresh the screen and see which cameras are active:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. Select the Manual radio button if it is not already selected.

4. Enter a remote site IP address.

5. Click Refresh. 

6. Click Apply.

Figure 126.  Finalizing Site Setup
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ACTIVATING REMOTE SITES

The DX8000 only supports up to five remote connections.

To activate up to five remote sites:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. In the “Site IP list,” select up to five DVR sites you want to activate.

4. Click Apply. The new DX8000 server site(s) should now be listed in the Site tree.

MODIFYING A REMOTE SITE

This section describes how to modify a remote site and includes the following topics:

• Editing a Remote Site on page 181

• Deleting a Remote Site on page 181

Editing a Remote Site 
To change the attributes of a remote site:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click .

3. Select the site name you want to edit from the “Site IP list” by clicking its site name.

4. Click Edit. The Server Information dialog box opens.

5. Enter a new site name for the remote DVR.

6. Enter the new IP address of the remote site.

7. If necessary, enter a base port number (9002 is the default). 

Unless there is a conflict on your network, you should not change port numbers from their default values. Make sure any changes to port 
numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports must be identical.

8. If necessary, enter an upgrade port number (9003 is the default).

9. Click OK.

10. Click Apply.

Deleting a Remote Site 
To delete an existing site from the site list:

1. Select the site name you want to delete from the “Site IP list” by clicking its site name.

2. Click Delete.

3. Click OK to confirm or Cancel to abort the deletion.

4. Click Apply.
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SYSTEM SETUP
Users with Power User access and higher can save configuration settings for the DX8000 using the system export feature. Previously saved 
settings can be loaded into the DVR using system import.

This section describes how to configure system options and parameters and includes the following topics:

• Accessing the System Page on page 182 

• Working with the Export Feature on page 182

• Working with the Import Feature on page 184

• Using System Logs on page 185

• Selecting the Language on page 187 

• Setting the System Time on page 187 

• Selecting the Video Format on page 189

• Working with Ctrl+Alt+Del Function on page 189

• Setting Up Auto Reboot on page 190

• Working with Online Help on page 190

ACCESSING THE SYSTEM PAGE

To access the System page:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

WORKING WITH THE EXPORT FEATURE

The DX8000 provides an import and export feature that allows you to save and reload DX8000 configuration settings. You can save your DX8000 
DVR configuration settings by exporting them to a specific storage media and location. You can reload a specific configurations profile by 
importing its configuration file. 

This sections describes how to use the import and export feature and includes the following topics:

• Exporting Current DVR Settings on page 182 

• Using the Edit Menu to Perform an Export on page 183 

Exporting Current DVR Settings

To save current DVR configuration settings:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. Select the Export radio button.

4. Select the check boxes of each configuration item you want to back up.
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5. Do one of the following:

a. To specify the file name to export to, enter drive, path and file name information into the text box. Settings file names follow standard 
Windows file-naming conventions. For example, enter C:\ DX8000 \ Jan_2004_config.bak.

or

b. To browse for a location:

(1) Click Browse.

The DX8000 Setup File Export Dialog box opens.

(2) Enter a file name in the “File name” text box.

(3) Navigate to the drive and folder where you want to save the settings file.

(4) Click the Up button to move up a level in the folder hierarchy.

(5) Click Save.

6. Click Export Now.

Figure 127.  Exporting DVR Settings

Using the Edit Menu to Perform an Export 

To save current DVR settings:

1. From the DX8000 menu bar, choose Edit > Export Setup.

The DX8000 Setup File Export Dialog box opens.

2. Select the folder where you want to save the settings file.

3. Click the Up button to move up a level in the folder hierarchy.

4. Enter a file name in the space provided.

5. Click Save.
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WORKING WITH THE IMPORT FEATURE

This sections describes how to import DX8000 DVR settings and includes the following topics:

• Importing DVR Settings on page 184 

• Using the Edit Menu to Perform an Import on page 184

Importing DVR Settings

To import a saved settings file:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. Select the Import radio button.

4. Do one of the following:

a. To specify the file name to import, enter the drive, path, and file name information in the text box. Settings file names follow standard 
Windows file-naming conventions. For example, enter C:\System Settings Backup.bak. 

or

b. To browse for a location:

(1) Click Browse. The DX8000 Setup File Export Dialog box opens.

(2) Navigate to the drive and folder where the settings file is located.

(3) Click the Up button to move up a level in the folder hierarchy.

(4) Select the settings file you want to open.

(5) Click Open.

5. Click Import Now.

6. Click Apply.

Figure 128.  Import DX8000 Server Configuration

Using the Edit Menu to Perform an Import 

To import a settings file from a specific drive or folder:

1. From the DX8000 menu bar, choose Edit > Import Setup.

The DX8000 Setup File Import Dialog box opens.

2. Select the folder where the file resides that you want to import.

3. Click the Up button to move up a level in the folder hierarchy.

4. Click the settings file you want to open.

5. Click Open.
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USING SYSTEM LOGS

The DX8000 automatically stores system information in a number of log files. Users with Power User access and higher can use these files to 
track system statistics and monitor security. The DX8000 allows you to view DX8000 activity log and Windows OS log files.

This section describes how to use the system logs and includes the following topics:

• Viewing a Log File on page 185 

• Exporting Log Information on page 187

The following table list the DX8000 and Windows OS log views.

Viewing a Log File

To view a log file:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Log Information section, select a log file from the Choose drop-down box. 

4. Do one of the following: 

a. To view DX8000 logs, click View. The Log View dialog box opens.

Figure 129.  Viewing a Log File

The following figure shows the Log View dialog box.

Table BA.  DX8000 Activities Windows OS Log Files 

DX8000 Log View Windows OS Log View

System On/Off Success

System Failure Error

Export Warning

Backup Information

Network Connection Audit_Sucess

Login ID List with Time Audit_Failure

Video Loss Audit_Failure

� 4a
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Figure 130.  Log View Dialog Box

or

b. To view OS log information, do the following:

(1) Click OS Log View. The Windows Log Viewer opens.

(2) Click a radial button to select a category

Figure 131.  Window Log Viewer Dialog Box

5. Do one of the following:

• Click OK to close the log dialog box. 
• Click Clear to erase the log.
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Exporting Log Information

To export a system log file:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Choose drop-down box, select a log file. 

4. Click Save As.

5. Select the drive and folder where you want to store the log file.

6. Enter a filename for the log information in the space provided.

Log filenames follow standard Windows file-naming conventions. Alternatively, you can view log files by clicking View > Log and then 
selecting the desired log file. Log files can be opened and printed using a text editing program, such as Windows Notepad.

7. Click Save.

Figure 132.  Exporting a Log File

SELECTING THE LANGUAGE

The DX8000 interface comes from the factory configured for the English language. The system supports multiple languages in addition to English. 
Language changes must be configured from both the DVR’s operating system and within the DX8000 application.

To select the appropriate language for your location:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. Make sure that the regional and language settings of the DVR’s operating system have been properly set up. Refer to the installation 
manual for information on regional setup.

4. In the Language section, select the appropriate language from the Select Language drop-down box. Options are as follows:

• English
• French
• German
• Italian
• Polish
• Portuguese
• Russian
• Spanish

5. Click Apply.

SETTING THE SYSTEM TIME

Time should be set on the DX8000 before it is put into use. Setting the internal clock for each DVR on the network ensures that each accurately 
reflects the local time.

This section describes how to set the DX8000 system time and includes the following topics:

• Setting System Time on page 188 

• Working with Standard and Daylight Saving Time on page 188 

�
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Setting System Time

Pelco recommends that the system time be configured only at the DX8000 server System page. In this case, if a subsequent attempt is made to 
set the system clock to a time earlier than the current time, the DX8000 server will display the Confirm dialog box, alerting the user that the 
system clock is being set to a time earlier than the current system time, and prompt the user to do one of the following:

• Accept the new system time and delete data recorded between the current time and the newly set time. If this option is accepted, the data 
is deleted and the DX8000 automatically restarts.

• Accept the new system time, with the following conditions:
– Previously recorded data will not be deleted.
– The DX8000 will not record new data until the system time becomes greater than the time that data was previously recorded. In this 

case, the time data was last recorded before the system time was reset to an earlier value. For example, if data was recorded at 
3:00 p.m. and at 3:00 p.m. the system time was reset to 2:30 p.m., the DX8000 will not commence recording again until the system 
time advances past 3:00 p.m.

However, if the user changes the system time from the Windows Control Panel, the data recording protection feature described above is 
defeated, the DX8000 recording timeline is impaired, and without notice, previously recorded data can over written by new data. 

To set the system time:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Date/Time Setup section, do the following:

a. In the Date/Time drop-down box, select the current month, day, and year.

b. Select the current time.

c. Click Update.

d. In the Time zone drop-down box, select the correct time zone.

e. Click Update.

4. Click the Apply.

Figure 133.  System Setup Time 

Working with Standard and Daylight Saving Time

The DX8000 ensures that no data is lost when the system clock is changed to reflect Daylight Saving Time or Standard Time. The DX8000 follows 
the Windows operating system clock changes. Windows is configured by default to recognize Daylight Saving and Standard Time changes 
automatically. When the DX8000 encounters a time change from Daylight to Standard time, it will record data for the transition time period 
twice. For example, when the system clock is set back one hour (from 2:00 AM to 1:00 AM), there will appear two periods on the playback 
timeline that represent the transition hour.

WARNING: Attempting to set the system clock to a time that is earlier than the current system time will require that you either delete all 
data recorded between the current time and the new time or that you do not delete previously recorded data but commence recording only 
after the system time has exceeded the recorded time. One exception to this rule involves Daylight Saving Time. For more information, 
refer to the Working with Standard and Daylight Saving Time on page 188.
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SELECTING THE VIDEO FORMAT

To select the appropriate video signal format for your location:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Video Format section, click NTSC or PAL to select the format.

4. Click Apply.

WORKING WITH CTRL+ALT+DEL FUNCTION

This section describes how to use the DX8000 Ctrl+Alt+Del key combination and includes the following topics:

• Enabling Ctrl+Alt+Del on page 189 

• Using Ctrl+Alt+Del on page 189

Enabling Ctrl+Alt+Del

Enabling the Ctrl+Alt+Del key combination allows you to open the Windows Task Manager dialog box to perform Windows system               
administration tasks. To complete the procedure, you must be logged on to the DX8000 as an administrator or a member of the administrators 
group on a computer that is part of a network domain.

The DX8000 keyboard is remapped. To see which keys replace the Ctrl and Alt keys, refer to the Important Security Information for System 
Administrators guide.

To enable the Ctrl+Alt+Del key combination:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the “Setup Ctrl + Alt + Del key combination” section, click the Enable Ctrl+Alt+Del key combination selection check box.

4. Click Apply.

5. Reboot the DX8000. 

Using Ctrl+Alt+Del

You must enable the Ctrl+Alt+Del key combination and verify your actual keyboard mapping. In some cases, the DX8000 keyboard is remapped 
and the actual Ctrl, Alt, and Delete key function is assigned to other keys.

Ctrl+Alt+Del allows you to access the Windows Task Manager dialog box from within the DX8000 shell. When you exit the Windows 
environment, you are returned to the DX8000 shell. In this case, you do not have to log back into the DX8000.

To access the Windows Task Manager dialog box:

1. Press the assigned keyboard keys that implement the Ctrl+Alt+Del function. The Windows Security dialog box opens.

2. In the Windows Security dialog box, click Task Manager. The Windows Task Manager window opens.

To return to the DX8000 shell without rebooting the DX8000, exit the Windows Task Manager dialog box.
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SETTING UP AUTO REBOOT

The DX8000 allows you to select the day and time for the DX8000 server to perform an automatic reboot. If there are mapped network drives, the 
Windows feature requires that the password be entered at the Enter Network Password dialog box. In this case, the DX8000 application will not 
start until the password is manually entered. NOTE: The DX8000 will not automatically reboot if there are mapped network drives. 

To enable the Auto Reboot feature:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Auto Reboot section, click the Enable check box.

4. In the Auto Reboot section, do the following to specify the day and time to automatically reboot the system:

a. Select the day of the week in the drop-down box.

b. In the Hour drop-down box, select the hour. Time is displayed in 24-hour clock format.

c. In the Minute drop-down box, select the minutes.

5. Click Apply.

WORKING WITH ONLINE HELP

The DX8000 server includes an online Help system. By default, the Help system is disabled and not available for viewing. The Admin user has 
authority to configure the DX8000 to display or not display online Help. When Help is enabled, all user groups can open view the Help system.

To enable/disable Help for viewing:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the “DX8000 Help” section, do one of the following:

• Click the Enable DX8000 Help to select Help for viewing,
• Click the Enable DX8000 Help to deselect Help for viewing,

4. Click Apply.
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EXTERNAL MONITOR SETUP
The DX8000 supports an optional multiplexing (MUX) display card that provides two additional analog monitor outputs. The first one, nearest to 
the top of the unit, mirrors the output of the main (VGA) video output. The second one, nearest to the bottom of the unit, is user definable. If your 
DX8000 Series DVR includes the optional MUX display card, the External Monitor button will appear on the screen in Setup mode. Users with 
Power User access or higher can assign cameras to and configure the display card. 

NOTE: The optional MUX display card must be installed in your DVR and an external monitor(s) must be connected in order to make use of the 
additional analog monitor outputs. Refer to the installation manual for instructions on how to connect analog monitors to the MUX display card.

This section describes how to setup an external monitor and includes the following topics:

• Accessing the External Monitor Setup on page 191 

• Setting Up Camera Mapping on page 191 

• Configuring Display Override on page 197 

• Using the External Monitor Option on page 197

ACCESSING THE EXTERNAL MONITOR SETUP

If the optional DX8000MUX8 or DX8000MUX16 display card is not installed in your DX8000 DVR, options on the external monitor configuration 
screen will be grayed-out.

To access the monitor configuration screen:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card has been installed.) The External Output page is displayed.

The Ext. Monitor page is displayed.

SETTING UP CAMERA MAPPING

The DX8000 allows you to set up automatic or manual camera mapping. This sections describes how to set up camera mapping and includes the 
following topics:

• Setting Up Automatic Camera Mapping on page 191 

• Setting Up Manual Camera Mapping on page 192

Setting Up Automatic Camera Mapping

Automatic camera mapping offers a simplified method for configuring the second (bottom) output on the optional MUX display card. Video from 
each camera source will be automatically cycled across the monitor’s view panels. In automatic mode all cameras will be displayed sequentially 
starting with Camera 1 and continuing through Camera 16 (depending on your system’s configuration).

The automatic camera mapping feature includes the following stipulations:

• The automated sequence will be interrupted each time a motion or alarm event is detected. 

• When the DVR detects an event (either motion or alarm), it will switch the monitor output to display the camera source that detected the 
event. The amount of time the event channel overrides the automated sequence can be set between 1 and 60 seconds.

• Eight-channel DVRs offer only the 1x1, 2x2, and 3x3 view panel options. If you select more than one screen division, each camera channel 
will cycle through each screen before the next panel division is presented.
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To configure the second (bottom) output on the display card for automatic camera mapping:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card has been installed.) The External Output page is displayed.

3. In the Auto Camera Mapping Mode section, do the following:

a. Select the Auto Camera Mapping Mode radio button.

b. Select of the screen division options. 

c. Select dwell time (1 to 60 seconds) from the drop-down box. This is the amount of time each window will remain on the monitor.

d. Select the type of event that will be allowed to override the monitor output:

• Alarm input
• Motion detection

e. Set the dwell time an event will be allowed to override the screen (1-60 seconds).

4. Click the Apply button at the bottom of the page.

Figure 134.  External Monitor – Automatic Mapping

Setting Up Manual Camera Mapping

Manual camera mapping allows a user to customize the MUX display card output. Individual cameras can be assigned to view panels in any 
combination. Each customized screen can be added to a sequence list and assigned a specific amount of dwell time. These combinations of 
customized screens and corresponding dwell times make up sequence instances. Multiple sequence instances can be combined into a sequence 
list. The resulting list will sequentially display each instance on an external monitor in a continuous loop. The sequence will continue 
uninterrupted until an alarm or motion event overrides the cycle.

The manual camera mapping feature has the following stipulations:

• Eight-channel DVRs offer only the 1x1, 2x2 and 3x3 view panel options.

• If you select more than one screen division, each camera channel will cycle through each screen before the next panel division is presented.

This section describes how to set up manual camera mapping and includes the following topics:

• Creating Monitor Sequence Instances on page 193 

• Loading an Existing Sequence List on page 194 

• Modifying a Sequence Instance in the List on page 195

• Deleting a Sequence Instance from the List on page 196 

• Appending an Existing Sequence List on page 197 
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Creating Monitor Sequence Instances

To add a sequence instance to the sequence list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card is installed.) The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. Select the Manual Camera Mapping Mode radio button if it is not already selected.

b. Select one of the screen division options. 

c. Drag cameras from the Site tree onto each view panel until all panels have been assigned a camera.

d. From the Min and Sec drop-down boxes, select the amount of time the sequence instance will remain on the monitor.

e. Click Add. 

The instance is added to the Sequence Table.

4. Do one of the following:

• Repeat step 3 for each additional sequence instance you want to add to the sequence list.
• If you want to apply the custom setting without saving, click Apply and skip steps 5 through 9.

5. Click Save. The Save Profile dialog box opens.

6. Select an existing profile or enter a new profile name under which to save the sequence.

7. Click OK.

8. In the Sequence Table, click Apply.

9. Click Apply in the External Output page.

Figure 135.  External Monitor – Manual Mapping
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Loading an Existing Sequence List

To load an existing sequence list: 

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card has been installed.)

3. In the Manual Camera Mapping Mode section, do the following:

a. Click the radio button to select the Manual Camera Mapping mode.

b. Click Load to load or modify an existing sequence.

The “Load profile” dialog box opens.

c. Select a profile.

d. Click OK.

The DX8000 dialog box opens prompting you to append the sequence to the list.

e. Click No to the Append option.

Figure 136.  Loading a Mapping Sequence
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Modifying a Sequence Instance in the List

To modify a sequence instance in the list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card is installed.) The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. Click the radio button (if it is not selected) to select the Manual Camera Mapping mode.

b. Select one of the sequence instances from the list by clicking on its name.

c. Select a screen division. 

d. Drag cameras from the Site tree onto each view panel until all panels have been assigned a camera.

e. From the Min and Sec drop-down boxes, select the amount of time the sequence instance will remain on the monitor.

f. Click Modify.

g. Click Save.

The Save dialog box open.

4. Select an existing profile or enter a new profile name under which to save the sequence list.

5. Click OK.

6. Click Apply.

7. Click Apply in the External Monitor page.

Figure 137.  Modify a Mapping Sequence
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Deleting a Sequence Instance from the List

To delete a sequence instance from the list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card is installed.) The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. In the Sequence Table, click the check box next to the sequence instance you want to delete.

b. Click Delete.

c. Click Save.

The Save profile dialog box opens.

4. Select an existing profile or enter a new profile name under which to save the sequence list.

5. Click OK.

6. Click Apply.

7. Click Apply at the bottom of the External Monitor page.

Figure 138.  Delete a Mapping Sequence
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Appending an Existing Sequence List

To append an existing sequence list to the current list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card is installed.) The External Output page is displayed.

3. Click Load. The “Load profile” dialog box opens.

4. Select a profile.

5. Click OK. 

The “Append to list” dialog box opens.

6. Click Yes to add the new sequences to the existing list.

7. To add, delete, or modify sequence instances follow the directions in the sections above.

8. Click Save.

9. Select an existing profile or enter a new profile name to save the sequence list.

10. Click OK.

11. Click Apply in the Sequence Table section.

12. Click Apply.

CONFIGURING DISPLAY OVERRIDE

The MUX display card can be configured to interrupt normal output when a motion or alarm event is detected. Each event instance causes live 
video from the sensing camera to be displayed for up to sixty seconds after event detection.

To set up event monitor override options:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . (This icon appears only if the optional MUX display card has been installed.)

3. Select the type of event that will be allowed to override the monitor output:

• Alarm input 
• Motion detection

4. Set the dwell time an event will be allowed to override the screen (1-60 seconds).

5. Click Apply.

USING THE EXTERNAL MONITOR OPTION

To assign a sequence profile to an external analog monitor:

1. On the DX8000 toolbar, click . 

2. On the DX8000 toolbar, click . 

The External Monitor drop-down menu is displayed.

3. Select a profile from the External Monitor drop-down menu.
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EMERGENCY NOTIFICATION SETUP
The Emergency Agent Notification alerts selected clients of motion, alarm and video loss events detected by DX8000 server sites. When a 
motion, alarm or video loss event is triggered, a pop-up window opens on the monitor of the remote site client. The window displays one or more 
still images taken during the event. 

Users with Power User access and higher can configure the emergency agent notification system. The first step in the setup process requires 
that clients be added to the emergency agent notification list. To complete this step, you must provide a valid name and the IP address of each 
client PC. After clients have been added they can be linked to one or more cameras. Finally, the amount of time a server sends images after an 
event occurs and the interval between sending each image must be set. 

NOTE: Before configuring the Emergency Agent Notification, make sure the Emergency Agent Client utility is installed on one or more client 
PCs. For information on installing the Emergency Agent Client utility, refer to Installing the Client Emergency Agent Application in the DX8000 
Client Application manual. 

This section describes how to setup emergency notification and includes the following topics:

• Accessing the Emergency Agent Notification Setup on page 198 

• Adding Client Emergency Agents to be Notified on page 198

• Changing Client Emergency Agent Properties on page 199

• Deleting Clients from the Notification List on page 199

• Linking Cameras to Client Emergency Agents on page 199 

• Setting Server Event Transmission Time on page 200

ACCESSING THE EMERGENCY AGENT NOTIFICATION SETUP

To access the Emergency Agent Notification setup:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

ADDING CLIENT EMERGENCY AGENTS TO BE NOTIFIED

After clients have been added, cameras must be configured to notify individual clients of an event. A single camera can be linked to one or more 
client emergency agents. For information on linking cameras to client emergency agents, refer to Linking Cameras to Client Emergency Agents on 
page 199.

To add clients to the Emergency Agent Notification list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click Add. The Agent Setup dialog box opens.

4. Do the following:

a. Enter a name for the client. (Client names can be up to 63 characters and can include spaces, but not special characters.

b. Enter the client’s IP address.

c. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports 
must be identical.

5. Click OK.

6. Click the Apply button at the bottom of the screen.
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CHANGING CLIENT EMERGENCY AGENT PROPERTIES

To change an existing client’s information in the emergency notification list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Edit. The Agent Setup dialog box opens.

c. Enter a new name for the client. (Client names can be up to 63 characters long and can include spaces, but not special characters.)

d. Enter a new IP address for the client.

e. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports 
must be identical.

4. Click OK.

5. Click the Apply button at the bottom of the screen.

DELETING CLIENTS FROM THE NOTIFICATION LIST

To delete a client from the emergency notification list:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Delete. The selected client is deleted.

4. Click Apply.

LINKING CAMERAS TO CLIENT EMERGENCY AGENTS

After clients have been added, cameras must be configured to notify individual clients of an event. A single camera can be linked to one or more 
client emergency agents.

Up to 32 IP addresses can be assigned to each camera. The DX8000 can transmit images up to 10 IP addresses simultaneously. 

To link a camera to one or more clients:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. In the Camera Setup section, click a camera button (Camera 1 to Camera 16). The Emergency Agent Selection dialog box opens.

4. Click the check box to select the name of the client site you want to notify when a motion, alarm, or video loss event is detected by this 
camera.

5. Repeat steps 1 and 2 for up to sixteen cameras on the current site.

6. Click the Apply button at the bottom of the screen.

7. Configure the server event transmission time. For information on setting the duration and transmission interval, refer to Setting Server 
Event Transmission Time on page 200.
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SETTING SERVER EVENT TRANSMISSION TIME

After clients have been added and linked to cameras, you must set the amount of time a server sends images after an event occurs and the 
interval between sending each image. Set the duration for sending images and the transmission interval after clients have been added and 
cameras are linked to one or more clients. For information on adding clients, refer to Adding Client Emergency Agents to be Notified on page 198. 
For information on linking cameras, refer to Linking Cameras to Client Emergency Agents on page 199.

To set the duration for sending images and the transmission interval:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. In the Option section of the Emergency Agent page, enter the amount of time in seconds that you want the DX8000 to continue sending still 
images after an alarm, motion, or video loss event has been detected.

4. Enter the time interval in seconds that you want the DX8000 to wait between sending each still image.

5. Click Apply.
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EMERGENCY E-MAIL NOTIFICATION SETUP
The DX8000 can be configured to send e-mail notifications alerting users of motion, alarm, and video loss events. Users with Power User access 
and higher can configure e-mail notification. Notifications can be sent to a single e-mail address or a group of addresses either immediately after 
an event occurs or periodically according to a predefined schedule. You can configure up to 32 e-mail groups. Up to 32 members can be assigned 
to each e-mail group. 

Before sending notifications, you must provide information about your e-mail server and establish what events—motion, alarm, and video loss 
that you want to include in the e-mail message. Timing and frequency of the e-mail notifications must also be set. You should test the e-mail 
notification function immediately after configuration to ensure your system is set up correctly.

NOTES: 

• To use emergency e-mail notification, the DX8000 Series DVR must be connected to a local area network (LAN) that maintains an SMTP 
mail server. The network must also be connected to either an intranet or the Internet depending on the location of the e-mail accounts to 
which you want to send notifications. Consult your network administrator for information on configuring e-mail notification on your local 
network.

• DX8000 version 2.0 does not support Google Gmail. 

This section describes how to set up emergency e-mail notification and includes the following topics:

• Accessing the Emergency Agent Notification Setup on page 198

• Configuring Emergency E-Mail Notification on page 201 

• Setting Up the Time Period on page 204

• Sending E-Mail Notifications on page 210 

ACCESSING THE EMERGENCY E-MAIL NOTIFICATION SETUP

To access the emergency e-mail notification setup:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

CONFIGURING EMERGENCY E-MAIL NOTIFICATION

This section describes how to set up emergency e-mail notification and includes the following topics:

• Enabling or Disabling E-Mail Notification on page 201

• Setting Up the E-Mail Server on page 202 

• Testing E-Mail Notification on page 203

Enabling or Disabling E-Mail Notification

To enable or disable emergency e-mail notification:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. In the Emergency E-mail Notification page, do one of the following:

• Click the Enable Notification radio button to enable e-mail notification.
• Click the Disable Notification radio button to disable e-mail notification.
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Setting Up the E-Mail Server

Set up the e-mail server in the Emergency E-Mail Notification page. For information on accessing the Emergency E-Mail Notification page, refer 
Accessing the Emergency E-Mail Notification Setup on page 201.

To set up the e-mail server:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Enter a name in the Full Name text box. You should enter a name that reflects the DX8000 server sending the notification; for example, 
DX8000 First Floor Lobby. Names can be up to 31 characters long and can include spaces but not special characters.

5. Enter your e-mail address in the E-mail Address text box.

6. Enter the address of your local SMTP mail server. Obtain this information from your network administrator.

7. If your e-mail server requires you to log in, do the following:

a. Select the check box labeled My E-mail Server Requires Authentication.

b. Enter your e-mail server address.

c. Enter your user name. (User names can be up to 31 characters in length and cannot include spaces or special characters.)

d. Enter your password. (Passwords can be up to 19 characters in length and cannot include spaces or special characters.)

8. Click Apply. 

Figure 139.  Basic E-Mail Notification Setup
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Testing E-Mail Notification

You test the e-mail notification configuration in the Emergency E-Mail Notification page. For information on accessing the Emergency E-Mail 
Notification page, refer Accessing the Emergency E-Mail Notification Setup on page 201.

To test e-mail notification:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Select the My E-mail Server Requires Authentication check box if it is not already selected.

5. Enter your personal e-mail address or the address of someone who can verify the receipt of the test e-mail in the To text box.

6. Enter DX8000 E-mail Notification Test in the Subject text box.

7. Enter the following server settings if necessary: 

• Server address (This address should be the same as the SMTP server address you entered above.)
• User name
• Password

8. Click Test E-mail Notification.

Figure 140.  E-Mail Test
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SETTING UP THE TIME PERIOD

The DX8000 can be configured to send e-mail notifications on a periodic basis, such as once every ten minutes. This sections describes how to 
set up the time period and includes the following topics:

• Configuring E-Mail Notification Frequency on page 204 

• Setting the Time of Day on page 204 

• Sending E-Mail Notifications In Response to Motion Events on page 205 

• Sending E-Mail Notifications In Response to Alarm Events on page 205 

• Sending E-Mail Notifications In Response to Video Loss Events on page 206

Configuring E-Mail Notification Frequency

Depending on the volume of motion, alarm, or video loss events that are detected by the DX8000, the number of e-mail notifications can be far 
too many to manage effectively. To keep the number of e-mails sent by the DX8000 at a manageable level, the e-mail notification frequency can 
be adjusted. When events have been detected, e-mail notifications can be sent out in intervals from once per minute up to once every six hours. 
If no events have been detected during the specified frequency interval, no notification will be sent. Each e-mail notification will include 
information about the first event detected during the interval, the last event detected during the interval, and a still image (in JPEG format) of the 
last event.

To configure notification frequency:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Frequency section, select the frequency interval from the drop-down box. Options are sending an e-mail notification once every

• 1 minute
• 10 minutes
• 30 minutes
• 1 hour
• 3 hours
• 6 hours

Setting the Time of Day

To set the time of day during which e-mail notifications will be sent:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Frequency section, do the following:

a. Click the Start check box to use the spinner buttons or type the earliest time of day you want e-mail notifications to be sent (for 
example, 7:30 AM). 

b. Click the End check box to use the spinner buttons or type the latest time of day you want e-mail notifications to be sent (for example, 
6:00 PM). 

5. Click Apply.
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Sending E-Mail Notifications In Response to Motion Events

E-mail notifications can be sent whenever a camera attached to a DX8000 detects motion.

To cause e-mail notifications to be sent in response to motion events:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Motion check box.

b. Click once in the Selected Channels field to the right of the word Motion. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box of each channel you want to monitor for motion detection events.
• Click Select All to monitor all channels for motion detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

Sending E-Mail Notifications In Response to Alarm Events

E-mail notifications can be sent whenever an alarm input is activated. 

To cause e-mail notifications to be sent in response to whenever an alarm input is activated:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Alarm check box.

b. Click once in the Selected Channels field to the right of the word Alarm. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box of each channel you want to monitor for alarm detection events.
• Click Select All to monitor all channels for alarm detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.
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Sending E-Mail Notifications In Response to Video Loss Events

E-mail notifications can be sent whenever a camera attached to a DX8000 experiences a video loss event.

To cause e-mail notifications to be sent in response to video loss events:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Video Loss check box.

b. Click once in the Selected Channels field to the right of the words Video Loss. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box of each channel you want to monitor for video loss detection events.
• Click Select All to monitor all channels for video loss detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

SETTING UP E-MAIL NOTIFICATION GROUPS

The DX8000 allows you to set up groups, to send an emergency notification to multiple users. The DX8000 supports the following:

• You can create up to 32 e-mail notification groups. 

• Up to 32 members can be assigned to each e-mail group. 

• A group can be notified in response to an alarm or motion detection event.

This section describes how to set up e-mail notification groups and includes the following topics:

• Adding an E-Mail Notification Group on page 206 

• Modifying an E-Mail Group Name on page 207 

• Deleting an E-Mail Group on page 207 

• Adding Members to an E-Mail Group on page 207 

• Deleting Members from an E-Mail Group on page 208

• Modifying E-Mail Group Member Attributes on page 209 

Adding an E-Mail Notification Group

To add an e-mail notification group:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. Click Add Group. The Manage Groups dialog box opens.

c. Enter the name of the group. (Group names can be up to 32 characters in length and can include spaces but not special characters.)

5. Click OK.

6. Click Close.

7. Click Apply.
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Modifying an E-Mail Group Name

To modify a group name:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Edit Group. The Manage Groups dialog box opens.

d. Edit the existing name or enter a new name for the group.

5. Click OK.

6. Click Close.

7. Click Apply.

Deleting an E-Mail Group

To delete a group:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Delete. 

5. Click Close.

6. Click Apply.

Adding Members to an E-Mail Group

Up to 32 members can be assigned to each e-mail group. 

To add e-mail addresses to a group:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Ensure that the group check boxes under To and CC are unchecked.

c. Enter an e-mail address in the To or CC text boxes.

d. Click Add to Group.

5. Click Apply.
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Figure 141.  Add User to E-Mail Group

Deleting Members from an E-Mail Group

To delete a user from a group:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Select the user you want to delete from the list.

c. Click Delete.

5. Click Apply.

Figure 142.  Remove User from E-mail Group
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Modifying E-Mail Group Member Attributes

To modify a user’s e-mail address or group affiliation:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Click the e-mail address of the user you want to edit. 

c. Click Edit. The E-mail Settings dialog box opens.

d. In the Group drop-down box, select a different group for the user.

e. If necessary, enter a new e-mail address for the user in the E-mail Address text box.

5. Click OK.

6. Click Apply.

Figure 143.  Modify Member Attributes
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SENDING E-MAIL NOTIFICATIONS

This section describes how to send e-mail notifications and includes the following topics:

• Sending E-Mail Notifications to Individuals on page 210 

• Sending E-Mail Notifications to Groups on page 211 

Sending E-Mail Notifications to Individuals

To configure e-mail notification to send alerts to an individual:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. Enter the e-mail address of the individual to whom you would like to send e-mail notifications in the To text box.

b. Enter an optional e-mail address of a second person you would like to send a copy of the notification to in the CC text box.

c. Enter text for the subject line that will appear in the e-mail notification in the Subject text box. (The default subject line is DX8000 
Emergency Email Notification).

5. Click Apply.

Figure 144.  Sending E-Mails to Individuals
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Sending E-Mail Notifications to Groups

To configure e-mail notification to send e-mail alerts to a group of individuals:

1. On the DX8000 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. Click the To check box under To.

b. In the drop-down box, select the group to which you want to send event notifications. 

c. (Optional) If you want to e-mail a copy of the event notification to another group of users, click the CC: check box under CC.

d. In the drop-down box, select the group you want to copy. 

5. Click Apply.

Figure 145.  Sending E-Mails to Groups

�

4a

4b

4c

4d
C624M-C (5/06) 211



Administering the DX8000
This section describes how to perform DX8000 system administration and includes the following topics:

• Updating the DX8000 Server and Client Applications on page 212 

• Recovering a Password on page 215

UPDATING THE DX8000 SERVER AND CLIENT APPLICATIONS
From time to time, software updates may be made available for both the DX8000 server and client applications. These updates will be free and 
will be made available on compact disc from Pelco. When an update is issued, it must be loaded onto a single DX8000 Series DVR server. Once 
installed on a server, the updates will be automatically distributed to clients on the same network when the client applications are started. 
Remote DX8000 severs can be updated from a local DVR using the Software Upgrade utility. 

To start the update process:

1. From the DX8000 menu bar, choose File > Software Upgrade.

Figure 146.  Software Upgrade Server Console

2. The Select Upgrade Package dialog box opens.

Figure 147.  Select Upgrade Package

3. Click Browse. The Open dialog box opens.
212 C624M-C (5/06)



Figure 148.  Open Dialog Box

4. Navigate to and select the update file.

5. Click Open. The Select Upgrade Package dialog box becomes active.

Figure 149.  Upgrade Package Information

6. Click Next. The Select Server dialog box opens.

The Select Server dialog box displays a list of all connected DX8000s including the local DVR. Updates can be made to the local server and 
all connected remote servers from this dialog box.

7. Select the DVR server you want to update:

• To update the local DVR, select site name of your system from the Select Server list. Refer to Figure 150 and Figure 151.
• To update a remote DVR, select its site name from the Select Server list and then click Connect. Refer to the following figure.
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8. Click Next and wait for the upgrade utility to copy the necessary files to the selected DVR.

9. At the completion of the update process, a dialog box will appear prompting you to update another server if desired. 

The options are as follows:

• Click Yes to select another server to update.
• Click No to finish the update process and reboot.

The local or remote server will reboot 30 seconds after the upgrade process has been completed. 

Figure 152.  Upgrade Confirmation Dialog Box

Figure 150.  Selecting the Local DVR to Update Figure 151.  Selecting a Remote DVR to Update
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RECOVERING A PASSWORD
Upon request, Pelco can issue a password recovery code that is valid for 24 hours on the machine for which it was issued only. The original buyer 
of the system (typically the dealer) must contact Pelco Technical Support with the serial number and order number (or invoice number) on which 
the unit was originally purchased, as well as the MAC address and exact date/time listed on the password recovery screen on the DX8000 
needing a reset. This must be done in writing (or fax) and the request must be accompanied by a letter from the current owner of the system 
stating the following information under penalty of perjury:

• He or she is the legal owner of the system.

• The password for the system was lost.

• That he or she is requesting a password reset.

Pelco will then issue a reset code that can be used for 24 hours on the DX8000 with the provided MAC address only.

Please fax in all the information (the exact time, the mac address, and so forth) on the “password recovery” screen on your local DX8000 unit on 
company letterhead if possible, with the above information.

Fax to 888-294-3885, attention: DX8000 password recovery.

To recover a lost or forgotten Admin password:

1. From the DX8000 menu, choose File > Password Recovery. The Password Recovery dialog box appears.

Figure 153.  Password Recovery Dialog Box

2.  Contact Pelco Product Support with the following information:

a. MAC address as it appears in the Password Recovery dialog box.

b. Current date for your location as it appears in the Password Recovery dialog box.

c. Any additional information requested by Pelco Product Support.

3.  Enter the new password you obtained from Pelco Product Support in the field provided.

4.  Click OK.
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motion event, linking multiple cameras to record116
video loss event, linking multiple cameras to record117

lens, adjusting43
mapping191
motion detection zones107
PC keyboard, using shortcuts to operate PTZ and lens 

functions45
PTZ protocols105

Coaxitron, DX8000PELCO-C
D protocol, DX8000PELCO-D
disable protocol, DX8000NO PTZ
P protocol, DX8000PELCO-P

recording modes123
relay, linking to camera33
remote setup using preset 9546
remote, accessing programming features51
scheduled recording mode, setting up124
security levels105

high
low
medium
none

settings
custom settings, examples of134
customizing123,133
support for recording modes134
supported for recording modes133

settings, customizing133
setup

applying settings to all cameras111
audio108
communications protocol105
enabling/disabling camera105
motion detection zones107
name, customizing105
pan, tilt, and zoom105
picture105
picture properties106
PTZ locking auto-timeout105
PTZ protocol105
security level105
security level, selecting105
video loss detection110

single, assigning to view pane32
zoom, adjusting44

camera designator38

camera event detection and repositioning

overview118

camera mapping191

camera, removing a linked alarm input34

channel resolution123

Coaxitron protocol46

COM1 or COM2 communications properties149

commands
auxiliary, sending54

compression, video134

connecting DX8000 DVRs102

D
D protocol46

data bits150

data communications
dome devices, setting up150

data packets145

data transmissions145

designators
camera38
site38

digital zoom control21

disk space21

disk status indicator21

display mode
Live video26
playback video26
See pane/panel

DNS or WINS services, setting up146

documentation
printed15

Dome communications ports
setting up150

down loading from Web14

dwell time23

DX8000
command descriptions22
exiting application22
overview of application window19

DX8000 application
logging in to16

DX8000 application window
panels26
panes26

DX8000, setting up102

Dynamic Host Configuration Protocol (DHCP)143

dynamic IP address
remote site177
selecting143
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dynamic-link library (DLL) files
installing163

dynamic-link library (DLL) files, updating163

E
e-mail notification

overview210
sending to groups211
sending to individuals210
video loss event, sending in response to110

e-mail server201

emergency agent notification110
accessing Emergency Agent Setup page198
camera, linking to client emergency agents199
clients

adding198
changing emergency agent properties199
deleting from notification list199

Emergency Agent Client utility, required198
overview198
port145
server event transmission time, setting200

emergency e-mail notification
accessing Emergency E-mail Notification page201
alarm201
alarm events, sent in response to205
e-mail groups201
e-mail server, configuring202
enabling/disabling201
group

adding206
adding members207
deleting207
deleting members from group208
modifying207
modifying member attributes209
overview206

local area network (LAN),201
motion events, sent in response to205
overview201
setting up201
testing configuration203
time period

notification frequency, setting up204
overview204
setting the time of day204

video loss events, sent in response to206

events
alarm111
ATM/POS113
motion detection107
recording modes124
video loss detection110

exception155

export setup22

Ext. monitor
accessing the Ext. Monitor page191
camera mapping

automatic camera mapping, setting up191
manual camera mapping, setting up192
overview191

external monitor option197
MUX display card, configuring interrupt override197
overview191
sequence instance

appending to an existing sequence list197
creating193
deleting196
loading an existing list194
modifying in the list195

extended view mode43

external events113

F
file size

video image134

frame rate
about calculating138
advanced, configuring136
basic, configuring135
maximum, setting137
overview123,135
range of135
resolution value136

G
getting started

exiting the DX800017
first-time login16
powering on the DX800015
shutting down the DX800015
starting the DX800015
user security levels15

H
hard disk14

hardware
DX8000-AUD audio card108
external equipment54
MUX display card192
upgradeing14

Help
enabling/disabling190
online, viewing190
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I
import setup22

index view panel21

indicators
audio38
camera38
instant recording38
on-screen PTZ control38
pan, tilt, and zoom38
record38
site38

information port145

instant recording indicator38

instant recording mode39

interface mode150

K
keypad43

L
language

selecting14,15

linking
alarm input, removing from camera34
alarm inputs, linking to cameras33
link setup options111

event-PTZ link settings
event-recording link settings
event-relay link settings
relay and alarm settings

relays, linking to cameras33
removing34
setting up32

linking and event recording setup111

live audio23,38,108

Live View mode51

local area network (LAN)201

logical network ports145

logs
files23

Backup
Export
Login ID list with time
Network Connections
System Failure
System On/Off
Video Loss

M
mapping, camera191

menu bar20

menus
Edit22
Export24
Favorite24
File22
file21
Help24
View23

menus, shortcut
local site31
relay32
remote site32

mode
extended view mode

standard view43
instant record, starting41
instant record, starting and stopping40
instant record, stopping41
instant recording39
interface150
live recording41
Live View mode, working in51
live view, working in35
normal recording39
recording modes, scheduled123

See recording mode

monitor, external191

motion
detection of113,124

See also relays
detection zones107
emergency e-mail notification201
emergency notification198
motion event recording mode, setting up124

multiple event recording124

MUX display card192

N
National Television System Committee (NTSC)135

network drive
disconnecting from169
mapping169

network ports, logical145

network requirements
connecting DX8000 DVRs17
DX8000 network properties14

normal recording mode39

notification
e-mail110
emergency agent110

Notification page198
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O
online Help190

on-screen display
add instant record icon to OSD40
customizing39
overview23,38
selections39

Audio Recording
Background Color
Camera Name
Instant Recording
POS
PTZ
Select All
Site Name
Video Recording

operating modes
function26

Display
Search
Setup

instant record, starting and stopping40
instant recording39
live recording41

operation and configuration
user access level16

overriding other users102

P
P protocol46

pan, tilt, and zoom (PTZ) control panel21

pan, tilt, and zoom control
enabling38
focus command, using46
operating41
preset, programming46
programming guidelines46
protocols, camera support41

pan, tilt, and zoom indicator38

pane/panel
background color23
channel/camera assignment to27
configuring27
division display format27
division, selection of27
hidden panels, automatically cycling through29
hidden panels, manually cycling through29
live/playback video, display of20
navigating between27
overview26
pane, expanding and collapsing29
site name displayed in23
video, viewing103

parity150

password
default15
recovery22
user15
Windows15

pattern
activating46,48,50
clearing46,50
overview48
programming46,49
programming, starting49
programming, stopping49
protocols, PTZ-enabled cameras48

Phase Alternating Line (PAL)135

ping port145

playback control panel21

playback timeline21

port and device communications properties
ATM/POS device

data format151
mode, selecting150

COM1 and COM2, setting up149
COM1/COM2 port148
overview147
RS-232148
RS-422/RS-485148

port numbers, changing145

preset
activating46,47
clearing46,48
guidelines46
Preset 9546
Preset 9946
programming46

preset tour
accessing a preset tour group55
adding presets to a tour55,56
configuring55
delete presets from a tour55
deleting presets from a tour57
programming55

printing14

protocols
D, P, Coaxitron46
device, installing/updating163

PTZ OSD menu control51

PTZ presets and patterns
alarm events, linking to119
ATM/POS events, linking to120
motion events, linking to118
video loss events, linking to121
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R
reboot, automatic

automatic reboot190

record indicator38

recording mode
alarm, camera settings supported

alarm image quality134
frame rate during alarm134
image resolution134
post-motion134
pre-alarm134
pre-alarm frame rate134
pre-alarm image quality134

ATM/POS, camera settings supported
ATM/POS image quality134
frame rate during ATM/POS134
image resolution134
post-ATM/POS134
pre-ATM/POS134
pre-ATM/POS frame rate134
pre-ATM/POS image quality134

instant39
instant, disabling40
instant, enabling40
motion, camera settings supported

frame rate during motion134
image resolution134
motion image quality134
post-motion134
pre-motion134
pre-motion frame rate134
pre-motion image quality134

normal39
normal, camera settings supported

frame rate134
image quality134
image resolution134

recording schedule profile123
scheduled modes123,124

alarm
ATM/POS
motion
normal

recording modes124

recording schedule122

relays
Event-Relay Link Settings page, accessing113
linked relay output

removing from a camera34
removing from an alarm input34

manually turning On and Off32
multiple relays, linking to one camera33
relay output

alarm event, linking to33,114
ATM/POS event, linking to114

motion event, linking to113
number supported111
video loss event, linking to115

setting up
advanced relay output138
basic operating properties112
creating custom name for112
relay output type, selecting112
relay, selecting112

single relay, linking to multiple cameras33

remote camera
menu system, navigating using

Keypad controls51,52
PC keyboard keys51,52
PTZ OSD menu control51
PTZ OSD menu controls51,52

programming features, accessing51
protocol support51

remote site
accessing features of17
activating181
active remote cameras, finding180
connecting to17
deleting181
DHCP IP addressed, adding179
disconnecting from17
editing181
logging into17
logging out of18
modifying181
overview177
static IP addressed, adding177

remote sites
overview177

resolution
resolution value, setting for recording136
screen23

RS-232148

RS-422/RS-485148,150

S
schedule

accessing122
all record modes, clearing schedule126
clearing a recording schedule125
copying attributes127,130
custom settings123
deleting a schedule132
editing a profile131
individual days, scheduling127
multi-day schedule, creating128
record mode122
setting up124
single day, creating129
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types of123
yearly recording schedule, creating126

screen resolution23

search mode26

server sites
connecting to DX8000 server sites177

server, e-mail201

Setup dialog box102

setup mode
accessing102
alarm properties, setting up112

See also alarm inputs
camera setup105,133

See also camera
commands, listing of104

Backup
Camera
Ext. Monitor
Linking
Network
Notification
Schedule
Site
System
User

data backup164
Ext. monitor setup191
how to open Setup dialog box26
multiple cameras

alarm events, linking cameras to record116
ATM/POS events, linking cameras to record117
motion events, linking cameras to record116
video loss events, linking cameras to record117

network properties
accessing DX8000 network configuration details146
base port, setting up145
DHCP, setting up143,144
DNS or WINS services, setting up146
overview143
port and device communications properties147
site name, assigning143
static IP address, entering143
TCP/IP and bandwidth throttle, setting up145

network setup
static IP address, entering144

overview102
PTZ presets and patterns

alarm events, linking to119
ATM/POS events, linking to120
linking to external events118
motion events, linking to118
video loss events, linking to121

relay output
advanced alarm-activated, configuring140
advanced ATM/POS-activated, configuring141

advanced motion-activated, configuring139
advanced video loss-activated, configuring142
alarm event (external), linking to114
ATM/POS event (external), linking to114
motion event (external), linking to113
See also relays
video loss event (external), linking to115

relay properties, setting up112
See also relays

schedule setup
frame rate, basic, configuring135
frame rate, configuring135
record mode122,124

system setup182
user access171

setup pages
Backup page164
Camera page103
Ext. Monitor page191
Linking page111
Network page

default, Network page143
DNS/WINS page146

Schedule page122
Site page177
System page182
User page171

shortcut keys
PC keyboard45

Home and End
Insert and Delete
Left and Right Arrow
Page Up and Page Down
Plus (+) and Minus (-)
Up and Down arrow

using to operate PTZ and lens functions44,45

shortcut menus
local site shortcut menu31
relay shortcut menu32
remote site shortcut menu32

site designator38

site name143

site tree
all cameras, assigning from32
how organized20
local, expanding and collapsing31
overview31
remote, expanding and collapsing32
single camera, assigning from32

software
DX8000 DVR server, using14
obtaining from Web14
upgrading14

software upgrade port145
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standard view mode43

static IP address
adding remote site with static IP address177
assigning143,144
remote site177

status bar21

stop bits150

synchronization, loss of110

system administration212

system administrator
obtaining user account16

system configuration
language15
language, setting14
printer, adding14
time, setting14

system ID143

system setup
accessing the System page182
Ctrl+Alt+Del key

enabling189
using189

DVR settings
exporting182
importing184

Edit menu
exporting from183
importing from184

export feature182
import feature184
language187

selecting187
supported languages187

log files
exporting187
overview185
viewing a log file185

overview182
system time

overview187
setting188
standard and daylight saving time188

video format
selecting189

system time14,188

T
TCP/IP ports (default),145

time, system, setting188

title bar20

toolbar20,25

tour, preset46,55

transaction
format152
parameters152

transaction filter, predefined78,84,155

U
upgrade policy

hardware14
software14

user security level171
accessing user setup page171
Administrator15,102,173
camera security access174
dwell time, changing29
DX8000, accessing102
Guest user account16
pan, tilt, and zoom control, operating41
Power User15,39,102,173
Restricted User23,29,172,173
Standard User account21,23,173
user access levels173
user accounts

adding new users174
existing users, deleting176
log-in timeout, setting176
modifying175
password, changing175
user’s group affiliation, changing176

user accounts, default173
user name and password16

V
video

images, printing14
live, viewing17,19
playback, viewing17

video compression134

video loss
detection of110
emergency notification198
relay output, linking to115
synchronization, loss of110
video level, low110

video, low level110

view
cycle view setup23
dwell time23
extended26
pane/panel. See pane/panel
standard26
viewing area. See pane/panel
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W
warranty period14

wildcard character85

wildcard, character85

wiper, operating54

Z
zones, motion detection107

zoom, adjusting camera44
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PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in material or 
workmanship for a period of one year after the date of shipment. 

Exceptions to this warranty are as noted below:

• Five years on FR/FT/FS Series fiber optic products and TW3000 Series unshielded twisted 
pair transmission products.

• Three years on Genex® Series products (multiplexers, server, and keyboard).

• Three years on Camclosure® and fixed camera models, except the CC3701H-2, 
CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and MC3651H-2X camera models, 
which have a five-year warranty.

• Three years on PMCL200/300/400 Series LCD monitors.

• Two years on standard motorized or fixed focal length lenses.

• Two years on Legacy®, CM6700/CM6800/CM9700 Series matrix, and DF5/DF8 Series 
fixed dome products.

• Two years on Spectra®, Esprit®, ExSite™, and PS20 scanners, including when used in 
continuous motion applications.

• Two years on Esprit® and WW5700 Series window wiper (excluding wiper blades).

• Two years (except lamp and color wheel) on Digital Light Processing (DLP®) displays. 
The lamp and color wheel will be covered for a period of 90 days. The air filter is not 
covered under warranty.

• Eighteen months on DX Series digital video recorders, NVR300 Series network video 
recorders, and Endura™ Series distributed network-based video products.

• One year (except video heads) on video cassette recorders (VCRs). Video heads will be 
covered for a period of six months.

• Six months on all pan and tilts, scanners or preset lenses used in continuous motion 
applications (that is, preset scan, tour and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of Pelco 
shipment. All goods requiring warranty repair shall be sent freight prepaid to Pelco, Clovis, 
California. Repairs made necessary by reason of misuse, alteration, normal wear, or accident 
are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss resulting from 
the specific use or application made of the Products. Pelco’s liability for any claim, whether 
based on breach of contract, negligence, infringement of any rights of any party or product lia-
bility, relating to the Products shall not exceed the price paid by the Dealer to Pelco for such 
Products. In no event will Pelco be liable for any special, incidental or consequential damages 
(including loss of use, loss of profit and claims of third parties) however caused, whether by 
the negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may also have 
additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800)þ289-9100 or 
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the following 
information:
1. Model and serial number
2. Date of shipment, P.O. number, Sales Order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product which does not fall under the 
warranty conditions stated above, please include a written explanation with the product when 
returned.

Method of return shipment shall be the same or equal to the method by which the item was 
received by Pelco.

RETURNS
In order to expedite parts returned to the factory for repair or credit, please call the factory at 
(800) 289-9100 or (559) 292-1981 to obtain an authorization number (CA number if returned for 
credit, and RA number if returned for repair).

All merchandise returned for credit may be subject to a 20% restocking and refurbishing 
charge.

Goods returned for repair or credit should be clearly identified with the assigned CA or RA 
number and freight should be prepaid. Ship to the appropriate address below.

If you are located within the continental U.S., Alaska, Hawaii or Puerto Rico, send goods to:
Service Department 
Pelco 
3500 Pelco Way 
Clovis, CA 93612-5699

If you are located outside the continental U.S., Alaska, Hawaii or Puerto Rico and are 
instructed to return goods to the USA, you may do one of the following:

If the goods are to be sent by a COURIER SERVICE, send the goods to:
Pelco 
3500 Pelco Way 
Clovis, CA 93612-5699 USA

If the goods are to be sent by a FREIGHT FORWARDER, send the goods to:
Pelco c/o Expeditors 
473 Eccles Avenue 
South San Francisco, CA 94080 USA 
Phone: 650-737-1700 
Fax: 650-737-0933

REVISION HISTORY

Manual # Date Comments
C624M  3/04 Original version.
C624M-A 12/04 Added information about instant recording, Ctrl+Alt+Del, multilanguage support, backup and export features.
C624M-B 3/05 Refers user to consult the Important Security Information for System Administrators guide for information on using Ctrl+Alt+Del, and the DX8000 default password.
C624M-C 5/06 Added new features: KBD300A keyboard support, third-party dome support, ATM/POS scheduled recording, 36-camera view, online Help, ATM/POS interface 

support,  making up to 100 simultaneous client-to-server connections, instant playback, quick menu to turn relays, on/off, live audio over the network, and video loss 
event linked to an alarm.

Pelco, the Pelco logo, Camclosure, Coaxitron, Esprit, Genex, Legacy, and Spectra are registered trademarks of Pelco. ©Copyright 2006, Pelco. All rights reserved.
Endura, ExSite, and Spectra III are trademarks of Pelco.
Adobe and Acrobat Reader are registered trademarks of Adobe Systems Incorporated.
Nero is a registered trademark of Nero AG.
DLP is a registered trademark of Texas Instruments, Inc.



United States  |  Canada  |  United Kingdom  |  The Netherlands  |  Singapore  |  Spain  |  Scandinavia  |  France  |  Middle East

Worldwide Headquarters
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